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Úvodem 
 
 
 
 
 
 

Jak používat tuto příručku 
 
 

Účel této 
příručky 

Tato příručka je určena vědeckým a ostatním laboratorním pracovníkům zodpovědným 
za instalaci a údržbu Real-Time PCR systémů Applied Biosystems 7300, 7500 a 7500 
Fast.  Tato příručka doplňuje: 
 

•   Příručku Real-Time PCR systémy Applied Biosystems 7300/7500/7500 Fast – 

příprava místa (Applied Biosystems 7300/7500/7500 Fast Real-Time PCR System 

Site Preparation Guide), 

•   Příručku Real-Time PCR systémy Applied Biosystems 7300/7500/7500 Fast – 

příprava počítače (Applied Biosystems 7300/7500/7500 Fast System Computer 

Setup Guide), 

•   Průvodce instalací - Real-Time System Setup wizard, který je k dispozici na 
instalačním CD nebo zvolením  > All Programs > Applied 
Biosystems > 7300/7500/7500 Fast System > Real-Time System Setup Wizard, 

•   Video CD Applied Biosystems 7300/7500/7500 Fast – Instalace a údržba, které se 
dodává spolu s přístrojem. 

 

 
Komu je určena Tato příručka je určena začátečníkům i zkušeným uživatelům Real-Time PCR systémů 

Applied Biosystems 7300, 7500 a 7500 Fast, kteří potřebují instalovat systém, provádět 
jeho údržbu nebo řešit s ním související problémy. 

 
  Předpoklady Tato příručka předpokládá, že máte následující znalosti: 

 

•   Jste obeznámeni s operačním systémem Microsoft® Windows® XP. 

•   Jste obeznámeni s technikami pro přípravu a manipulaci se vzorky DNA. 

•   Máte všeobecné znalosti týkající se pevných disků, ukládání dat, přenosů a 
kopírování souborů. 

 
Práce s textem Pro lepší pochopení pracuje tato příručka s textem následujícím způsobem: 

 

•   Tučně jsou vyznačeny aktivní zásahy uživatele. Například: 

Napiště 0, poté stiskněte Enter pro každé ze zbývajících polí. 

•   Kurzívou jsou vyznačena nová nebo důležitá slova a též zdůraznění. Například: 

Před spuštěním běhu musíte provést kalibrace přístroje – ROI kalibraci, kalibraci 
pozadí a kalibraci barev. 

•   Znaménko (>) odděluje po sobě následující příkazy, které volíte z rozbalovacích 
menu nebo nabídek. Například: 

Zvolte  > All Programs >  Applied Biosystems > 7300/7500/7500 Fast 
System > Real-Time System Setup Wizard. 
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Úvodem 
Kde získat více informací 

 
 

Upozornění 
pro uživatele 

V dokumentaci Applied Biosystems se používají dvě slova pro upozornění uživatele. 
Každé slovo vyžaduje určitou míru pozornosti nebo aktivity, jak je popsáno níže: 
 

Poznámka (Note) – Poskytuje informace, které mohou být zajímavé nebo nápomocné, 
ale které nejsou kritické z hlediska používání přístroje. 
 

DŮLEŽITÉ! (IMPORTANT!) – Poskytuje informace, které jsou nezbytné pro správné 
ovládání přístroje, používání reagencií nebo bezpečné používání chemikálií. 
 

Příklady upozornění uživatele: 
 
 

Poznámka:  Před kalibrací každého filtru nastavte dobu expozice na 2048. 
 
 

DŮLEŽITÉ!  Při manipulaci s halogenovou žárovkou používejte rukavice bez pudru. 
 

 
Výstražná 

upozornění 
Součástí uživatelské dokumentace jsou i výstražná upozornění. Podrobněji viz 
“Výstražná upozornění” na straně xvi. 

 
 

Kde získat více informací 
 

Související 
dokumentace 

Více informací o používání přístroje naleznete v příručkách: 
 

•   Applied Biosystems 7300/7500/7500 Fast Real-Time PCR System Site Preparation 
Guide (PN 4347823) – Příprava místa 

•   Applied Biosystems Real-Time PCR System Computer Setup Guide (PN 4365367) – 

Příprava počítače 

•   Applied Biosystems 7300/7500/7500 Fast Real-Time PCR System Getting Started 
Guides – Uživatelské příručky: 

–  Absolute Quantitation (PN 4347825) – Absolutní kvantifikace 

–  Allelic Discrimination (PN 4347822) – Alelická diskriminace 

–  Plus Minus (PN 4347821) – Eseje typu Plus Mínus 

–  Relative Quantitation (PN 4347824) – Relativní kvantifikace 

•   Applied Biosystems 7500/7500 Fast Real-Time PCR System: User Guide for the 
21 CFR Part 11 Module in SDS Software v1.4 (PN 4374432) – Uživatelská příručka 

pro modul programu SDS v 1.4 pro práci podle normy 21 CFR část 11 

•   Applied Biosystems Real-Time PCR System Chemistry Guide (PN 4343458) - 
Chemizmus 

•   Applied Biosystems 7500 Fast Real-Time PCR System Quick Reference Card 
(PN 4362285) – Stručný přehled 

 

PDF verzi této příručky a většiny shora zmíněných příruček naleznete na instalačním CD. 
 
 

Poznámka:  Další dokumentace viz “Kde získat pomoc” na straně xiii. 
 

 
Pošlete nám 
Vaše návrhy 

V Applied Biosystems vítáme Vaše komentáře a návrhy na zlepšení uživatelské 
dokumentace. Své připomínky můžete zaslat na adresu: 

techpubs@appliedbiosystems.com 
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Úvodem 
Kde získat pomoc 

 
 
 
Kde získat pomoc 

 
Nejaktuálnější služby a informace Technické podpory (Support) naleznete na adrese 
http://www.appliedbiosystems.com, kde klikněte na odkaz Support. 

Na stránkách technické podpory můžete: 

•   Získat telefonní a faxová čísla všech oddělení Technické podpory a prodejních 
poboček Applied Biosystems 

•   Prohledávat často kladené otázky - Frequently asked questions (FAQs) 

•   Přímo položit dotaz Technické podpoře 

•   Objednat uživatelské dokumenty Applied Biosystems, bezpečnostní listy (MSDS), 
certifikáty o analýze a další související dokumenty 

•   Stahovat dokumenty ve formátu PDF 

•   Získat informace o školení pro zákazníky 

•   Stahovat programové aktualizace a opravné balíčky 
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Bezpečnostní upozornění používaná v tomto dokumentu 
 
 
 
Bezpečnostní upozornění používaná v tomto dokumentu 

 
 

Výstražná 
upozornění 

V uživatelské dokumentaci Applied Biosystems jsou používána čtyři výstražná 
upozornění, a to na těch místech dokumentů, kde je zapotřebí upozornit na odpovídající 
rizika. Každé z těchto slov – DŮLEŽITÉ (IMPORTANT), VAROVÁNÍ (CAUTION), 
VÝSTRAHA (WARNING), NEBEZPEČÍ (DANGER) – vyžaduje potřebu určité 
úrovně pozornosti nebo aktivity, jak je popsáno níže: 
 
Definice 
 

DŮLEŽITÉ! (IMPORTANT!)  – Poskytuje informace, které jsou nezbytné pro správné 
ovládání přístroje, používání reagencií nebo bezpečné používání chemikálií. 
 

   – VAROVÁNÍ Indikuje potenciálně nebezpečnou situaci, která,  
pokud se jí nevyhnete, může vést k malému nebo středně těžkému zranění. Lze též  
použít jako varování před nebezpečnými činnostmi. 
 

   – VÝSTRAHA Indikuje potenciálně nebezpečnou situaci, která, 
pokud se jí nevyhnete, může způsobit smrt nebo těžké zranění. 
 

    – NEBEZPEČÍ Indikuje bezprostřední nebezpečnou situaci, 
která, pokud se jí nevyhnete, způsobí smrt nebo vážné zranění. Používání tohoto 
výstražného upozornění je omezeno jen na nejzávažnější situace. 
 

Vyjma DŮLEŽITÉ! (IMPORTANT) se každé výstražné upozornění v dokumentaci 
Applied Biosystems objevuje spolu s bezpečnostními symboly ve výstražném 
trojúhelníku. Tyto výstražné symboly jsou totožné se symboly na přístrojích Applied 

Biosystems (viz “Symboly na přístrojích” na straně xvii). 
 
Příklady 
 

Níže jsou uvedeny příklady použití výstražných upozornění: 
 
 

DŮLEŽITÉ!  Při manipulaci s halogenovou žárovkou používejte rukavice bez pudru. 
 
 
 

Žárovka je velmi horká. Nedotýkejte se žárovky, dokud 
nevychladne na  pokojovou teplotu. 

 
 
 

CHEMICKÉ RIZIKO. Formamid. Expozice vede k podráždění 
očí, kůže a dýchacího ústrojí. Možné riziko vývojových vad a poškození plodu. Přečtěte 
si bezpečnostní list a dodržujte pokyny při manipulaci. Používejte prostředky ochrany 
očí, ochranný oděv a rukavice. 

 
 
 

ELEKTRICKÉ RIZIKO. Nesprávně uzemněný přístroj může 
způsobit úraz elektrickým proudem. Uzemněte přístroj podle připojeného návodu.
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 Označuje polohu hlavního 
spínače Zapnuto. 

 Označuje polohu hlavního 
spínače Vypnuto. 

 Označuje spínač sloužící 
k přepnutí přístroje do 
pohotovostního režimu (Standby). 
V přístroji může stále být vysoké 
napětí. 

 Označuje polohu hlavního 
spínače Zapnuto/Vypnuto (týká 
se spínače, který se ovládá 
stlačením). 

 

Symbol Popis 

 Svorka uzemnění. Neslouží jako 
ochranná svorka. 

 Ochranná svorka - označuje 
chráněný uzemněný výstup, 
který musí být uzemněn 
předtím, než je provedeno 
jakékoliv jiné elektrické 
připojení přístroje (připojení 
hlavního ochranného vodiče). 

 Označuje výstup, který může 
být připojen na střídavý 
napájecí zdroj. 

 Označuje výstup, který může 
být připojen na střídavý nebo 
stejnosměrný napájecí zdroj. 

 

Symboly na přístrojích 
 
 

Symboly na přístrojích 
 
 

Elektrické 
symboly na 

přístrojích 

Následující tabulka popisuje elektrické symboly, které mohou být použity na přístrojích  
Applied Biosystems. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

    Bezpečnostní Následující tabulka popisuje bezpečnostní symboly, které mohou být použity na 
  symboly  přístrojích Applied Biosystems. Každý symbol může být použit sám o sobě nebo 

v kombinaci s textem, který vysvětluje případné riziko (viz “Bezpečnostní označení na 
přístrojích” na straně xviii). Tyto bezpečnostní symboly se mohou rovněž objevit 
v textu tohoto nebo dalších dokumentů vedle označení DANGER (NEBEZPEČÍ), 
WARNING (VÝSTRAHA) a CAUTION (VAROVÁNÍ). 

 

Symbol Popis 

 Indikuje, že byste měli získat další informace z manuálu a pokračovat 
s patřičnou obezřetností. 

 Indikuje možný úraz elektrickým proudem a nutnost pokračovat 
s patřičnou obezřetností. 

 Indikuje horký povrch nebo jiné riziko související s vysokou teplotou a nutnost 
pokračovat s patřičnou obezřetností. 

 Indikuje přítomnost laseru a nutnost pokračovat s patřičnou obezřetností. 

 Indikuje přítomnost pohyblivých součástí a nutnost pokračovat s patřičnou 
obezřetností. 
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Symbol Pozor 

 Tento výrobek nelze odstranit jako běžný komunální 
odpad. Postupujte podle místních předpisů o nakládání 
s odpadem s ohledem na minimalizaci rizika vlivu 
elektrického a elektronického odpadu na životní prostředí. 

Zákazníci z Evropské unie: 
Kvůli odstranění přístroje a jeho recyklaci kontaktujte 
místní zastoupení společnosti Applied Biosystems. 
Seznam kanceláří společnosti v Evropské unii naleznete 
na http://www.appliedbiosystems.com. 

 

Bezpečnostní označení na přístrojích 
 
 
 

Environmentální 
symboly na 

přístrojích 

Následující symbol se vztahuje ke všem elektrickým a elektronickým zařízením 
společnosti Applied Biosystems, které byly uvededny na evropský trh po 13. srpnu 2005. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Bezpečnostní označení na přístrojích 
 

Následující prohlášení CAUTION (VAROVÁNÍ), WARNING (VÝSTRAHA) a 
DANGER (NEBEZPEČÍ) mohou být použity na přístrojích Applied Biosystems 
v kombinaci s bezpečnostními symboly popsanými v předchozí části. 

 

English Česky 

CAUTION Hazardous chemicals. Read the 
Material Safety Data Sheets (MSDSs) before 
handling. 

VAROVÁNÍ  Nebezpečná chemikálie. Před 
použitím čtěte bezpečnostní list (MSDS). 

CAUTION Hazardous waste. Refer to 
MSDS(s) and local regulations for handling 
and disposal. 

VAROVÁNÍ Nebezpečný odpad. Při 
manipulaci a likvidaci postupujte podle pokynů 
v bezpečnostním listu a místních předpisů. 

WARNING Hot lamp. VÝSTRAHA Horká žárovka. 

WARNING Hot. Replace lamp with an 
Applied Biosystems lamp. 

VÝSTRAHA Horké. Zaměňte žárovku za 
žárovku Applied Biosystems. 

CAUTION Hot surface. VAROVÁNÍ Horký povrch. 

DANGER High voltage. NEBEZPEČÍ Vysoké napětí. 

WARNING To reduce the chance of electrical 
shock, do not remove covers that require tool 
access. No user-serviceable parts are inside. 
Refer servicing to Applied Biosystems 
qualified service personnel. 

VÝSTRAHA Neodstraňujte kryty, na jejichž 
odstranění je zapotřebí nástrojů – riziko úrazu 
elektrickým proudem. Potřeba uživatelských 
zásahů v prostoru pod krytem je vyloučena. 
Servis provádí pouze kvalifikovaný technik 
Applied Biosystems. 

CAUTION Moving parts. VAROVÁNÍ Pohyblivé součásti. 

WARNING This instrument is designed for 
12V, 75W Halogen lamps only. 

VÝSTRAHA Tento přístroj je určen pouze 
pro halogenové žárovky 12V, 75W. 



Instalace a údržba – Uživatelská příručka pro Real-Time PCR cyklery Applied Biosystems 7300/7500/7500 Fast xix 

Bezpečnost a elektromagnetická kompatibilita   

  

 

 

 

Bezpečnostní označení na přístrojích 
 
 
 

Umístění  
bezpečnostních 

označení 

Na Real-Time PCR systémech Applied Biosystems 7300/7500/7500 Fast jsou 
bezpečnostní označení umístěna, jak je vyobrazeno na obrázcích níže. 

 
 

Pozor 
 

 
Riziko poranění 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Riziko poranění 
 
 

Pozor 
 
 
 
 
 
 
 
 
 
 
 
 

Pozor 
 
 
 
 
 
 

Pozor 
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Obecná pravidla bezpečnosti při práci s přístrojem 

 
 
 
Obecná pravidla bezpečnosti při práci s přístrojem 

 

 
 

 RIZIKO PORANĚNÍ. Používejte tento výrobek pouze v souladu 
s postupy uvedenými v tomto dokumentu. Jiné používání než v souladu s instrukcemi 
Applied Biosystems může vést ke zranění nebo k poškození přístroje. 

 

 
Přemisťování 

a zvedání 
přístroje 

RIZIKO PORANĚNÍ. Přístroj smí přemisťovat pouze osoby nebo 
dodavatelé uvedení v návodu na přípravu místa. Rozhodnete-li se přístroj přemisťovat 
nebo zvedat poté, co byl instalován, provádějte to vždy v dostatečném počtu osob, za 
použití příslušného vybavení a odpovídajícím způsobem. Nesprávná manipulace může 
způsobit bolestivá a trvalá poranění zad. V závislosti na jeho hmotnosti může 
přemisťování nebo zvedání přístroje vyžadovat dvě a více osob. 

 

 
Přemisťování 

a zvedání 
počítačů a 

monitorů 

 
Zvedání nebo přenášení počítačů a monitorů provádějte vždy 

v dostatečném počtu osob. V závislosti na hmotnosti počítače a/nebo monitoru může 
jejich přemisťování nebo zvedání vyžadovat dvě a více osob.  
 
 
Před zvedáním počítače a/nebo monitoru: 
 

•   Ujistěte se, že máte ke zvedání počítače nebo monitoru vhodné nástroje. 

•   Ujistěte se, že na předpokládané dráze pohybu přenášeného objektu se nenacházejí 
žádné překážky. 

•   Při zvedání předmětu se současně neotáčejte. 

•   Dbejte, aby vaše páteř byla při zvedání předmětu ve stabilní neutrální poloze. 

•   Všechny zúčastněné osoby musí postup zvedání a přenášení vzájemně 
koordinovat. 

•   Nevyjímejte předmět z krabice, namísto toho položte krabici na bok a přidržte ji, 
zatímco někdo jiný nechá její obsah opatrně vyklouznout ven. 

 

 
Ovládání 
přístroje 

Ujistěte se, že každý kdo ovládá přístroj: 
 

•   byl obeznámen s obecnými pravidly bezpečnosti pro práci v laboratoři a 
zvláštními bezpečnostními pravidly týkajícími se tohoto přístroje. 

•   četl a pochopil veškeré související bezpečnostní listy (MSDS). Viz 
„O bezpečnostních listech” na straně xxi. 

 
 

 RIZIKO PORANĚNÍ. Používejte tento výrobek pouze v souladu 
s pokyny společnosti Applied Biosystems. Jiné používání než v souladu s instrukcemi 
Applied Biosystems může vést ke zranění nebo k poškození přístroje. 

 

 
Čistění nebo 

dekontaminace 
přístroje 

Před použitím jiné než výrobcem doporučené metody čistění či  
dekontaminace si u výrobce ověřte, že zvolená metoda nemůže způsobit poškození 
přístroje. 
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Bezpečná manipulace s chemikáliemi 
 
 
 
Bezpečná manipulace s chemikáliemi 

 
 

Výstraha – 
chemické riziko 

CHEMICKÉ RIZIKO. Před manipulací s jakýmikoliv 
chemikáliemi si prostudujte příslušný bezpečnostní list - Material Safety Data Sheet 
(MSDS), poskytnutý dodavatelem chemikálie, a řiďte se jeho pokyny . 

 
 
 

CHEMICKÉ RIZIKO. Veškeré chemikálie nacházející se 
v přístroji včetně tekutin v hadičkách představují potenciální riziko. Před 
výměnou reagencií nebo součástí přístroje si vždy zjistěte, jaké  chemikálie v něm 
byly použity. Pří práci používejte prostředky ochrany očí, ochranný oděv a rukavice. 

 
 
 

RIZIKO UCHOVÁVÁNÍ CHEMIKÁLIÍ. Nikdy neuchovávejte 
odpad ve skleněných nádobách kvůli možnosti jejich rozbití. Láhve na reagencie a 
odpad se mohou rozbít a vytéct. Každou odpadní láhev je zapotřebí umístit do 
bezpečnostního polyetylénového zásobníku s dotaženým víkem a úchyty zajištěnými ve 
svislé poloze. Při manipulacích s láhvemi obsahujícími reagencie a odpad používejte 
prostředky ochrany očí, ochranný oděv a rukavice. 

 
 

O bezpečnostních 
listech 

Výrobci chemikálií poskytují novým zákazníkům s dodávkou chemikálií bezpečnostní 
listy (MSDS). Bezpečnostní list je rovněž poskytnut spolu s dodávkou chemikálií 
v případě, že byl aktualizován. Bezpečnostní listy obsahují informace, které 
potřebujete pro bezpečné ukládání, manipulaci, přepravu a odstranění chemikálie.

  
Obdržíte-li s dodávkou chemikálie i bezpečnostní list, vždy jej založte – udržujte tyto 
listy aktuální. 

 

 
Získání 

bezpečnostního 
listu 

Bezpečnostní listy pro chemikálie dodávané společností Applied Biosystems získáte 
vždy od Applied Biosystems. Tato služba je bezplatná a dostupná 24 hodin denně.  
 
Chcete-li získat bezpečnostní list:: 

1. Otevřete stránku https://docs.appliedbiosystems.com/msdssearch.html 
 
2. V poli hledání zadejte název chemikálie, katalogové číslo nebo další informaci 

z bezpečnostního listu, který vás zajímá.  
 
3. Zvolte jazyk, klikněte na Search (Hledat). 
 
4. Zvolte dokument, který vás zajímá, klikněte pravým tlačítkem myši na jeho název a 

zvolte jednu z následujících možností: 

•   Open – Otevření dokumentu 

•   Print Target – Vytištění dokumentu 

•   Save Target As – Stažení dokumentu ve verzi PDF do zvoleného 
adresáře 
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Bezpečná manipulace s chemickým odpadem 

 
 
 

Pravidla 
manipulace 

s chemikáliemi 

Abyste minimalizovali riziko plynoucí z používání chemikálií, musíte: 
 

•  Přečíst a pochopit bezpečnostní listy dodávané výrobci chemikálií, a to ještě před 
tím, než začnete tyto chemikálie nebo rizikové materiály ukládat nebo s nimi 
manipulovat či pracovat. (Viz “O bezpečnostních listech” na straně xxi.) 

•   Minimalizovat kontakt s chemikáliemi. Používejte odpovídající osobní ochranné 
pomůcky pro práci s chemikáliemi (např. ochranné brýle, rukavice, ochranný 
oděv). Další bezpečnostní opatření naleznete v bezpečnostním listu. 

•   Minimizovat inhalaci chemikálií. Neponechávejte nádoby s chemikáliemi 
otevřené. Používejte odpovídající větrání (například digestoř). Další bezpečnostní 
opatření naleznete v bezpečnostním listu. 

•   Pravidelně kontrolovat, zda nedošlo k vylití nebo rozsypání chemikálií. Pokud 
k tomu dojde, postupujte podle čistících procedur doporučených výrobcem 
chemikálie v bezpečnostním listu. 

•   Dodržovat všechna místní nebo národní nařízení a předpisy týkající se uchovávání 
chemikálií, manipulace s nimi a jejich odstraňování. 

 

 
 

Bezpečná manipulace s chemickým odpadem 
 
 

Výstraha  - 
chemické 

riziko 

NEBEZPEČNÝ ODPAD. Při manipulaci s nebezpečným odpadem 
 a při jeho odstraňování se řiďte pokyny v bezpečnostním listu.

 

 
NEBEZPEČNÝ ODPAD. Odpady produkované přístroji Applied  

Biosystems představují potenciální riziko a mohou způsobit zranění, nemoc nebo smrt. 
 
 
 
 

RIZIKO UCHOVÁVÁNÍ CHEMIKÁLIÍ. Nikdy neuchovávejte 
odpad ve skleněných nádobách kvůli možnosti jejich rozbití. Láhve na reagencie a 
odpad se mohou rozbít a vytéct. Každou odpadní láhev je zapotřebí umístit do 
bezpečnostního polyetylénového zásobníku s dotaženým víkem a úchyty zajištěnými ve 
svislé poloze. Při manipulacích s láhvemi obsahujícími reagencie a odpad používejte 
prostředky ochrany očí, ochranný oděv a rukavice. 

 

 
Pravidla 

manipulace 
s chemickým 

odpadem 

Abyste minimalizovali riziko plynoucí z manipulace s chemickým odpadem, musíte: 
 

•   Přečíst a pochopit bezpečnostní listy, dodávané výrobci chemikálií, z nichž odpad 
vzniká, předtím než začnete chemický odpad ukládat, manipulovat s ním nebo ho 
odstraňovat. 

•   Mít k dispozici primární i sekundární nádoby na odpad. (Primární nádoba na odpad 
je pro jeho okamžité shromažďování. Sekundární nádoba na odpad obsahuje to co 
vyteče nebo se vysype z primární nádoby. Obě nádoby musí odpovídat typu 
ukládaného odpadu a splňovat nařízení místních i národních předpisů.) 

•   Minimalizovat kontakt s chemikáliemi. Při práci s chemikáliemi používejte 
odpovídající osobní ochranné pomůcky (např. ochranné brýle, rukavice, ochranný 
oděv). Další bezpečnostní opatření naleznete v bezpečnostním listu. 
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Bezpečná manipulace s elektrickými zařízeními  
 
 
 
 

•   Minimizovat inhalaci chemikálií. Neponechávejte nádoby s chemikáliemi otevřené. 
Používejte odpovídající větrání (například digestoř). Další bezpečnostní opatření 
naleznete v bezpečnostním listu. 

•   Manipulovat s chemickým odpadem v digestoři. 

•   Pytle s odpadem zajistit svorkou. 

•   Odstraňovat odpad z odpadní misky a odstraňovat odpadní láhve v souladu se 
správnou laboratorní praxí a místními i národními předpisy. 

 
Odstraňování odpadu Pokud při práci s přístrojem vznikne potenciálně nebezpečný odpad, musíte: 

 

•   Charakterizovat (analyzovat, pokud je to nutné) tento odpad, reagencie a 
substráty používané ve vaší laboratoři. 

•   Zajistit ochranu zdraví a bezpečnost všech pracovníků vaší laboratoře. 

•   Zajistit, že odpad z přístroje je ukládán, přenášen, transportován a odstraňován 
v souladu se všemi místními i národními předpisy. 

 
DŮLEŽITÉ!  Radioaktivní nebo biologické odpady mohou vyžadovat zvláštní způsoby 
zacházení a mohou se na ně vztahovat omezení stran možností jejich odstraňování. 
 

 
 

Bezpečná manipulace s elektrickými zařízeními 
 

 
 

NEBEZPEČÍ ÚRAZU ELEKTRICKÝM PROUDEM. Při 
ovládání Real-Time PCR systémů Applied Biosystems 7300/7500/7500 Fast bez 
ochranných krytů může dojít k vážnému úrazu elektrickým proudem. Neodstraňujte 
kryty přístroje. Po jejich odstranění je možný přístup ke zdrojům vysokého napětí. 

 
 

  Pojistky  NEBEZPEČÍ POŽÁRU. Použití nesprávných pojistek nebo zdroje 
vysokého napětí může vést k poškození přístroje a vzniku požáru. Před zapnutím 
přístroje ověřte, zda pojistky byly správně zapojeny, a že zdroj elektrického napětí ve 
vaší laboratoři splňuje požadavky přístroje. 

 
 
 

 NEBEZPEČÍ POŽÁRU. V zájmu nepřetržité ochrany před 
rizikem vzniku požáru používejte pouze pojistky typu a jmenovitého proudu 
odpovídajího požadavkům přístroje. 
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Pohyblivé součásti 
 
 
 

Zdroj  NEBEZPEČÍ ÚRAZU ELEKTRICKÝM PROUDEM. Pro 
bezpečný provoz zařízení je nezbytné jeho uzemnění. Nikdy nepoužívejte přístroj, 
který není správným způsobem uzemněn. 

 
 
 

NEBEZPEČÍ ÚRAZU ELEKTRICKÝM PROUDEM. Používejte 
pouze schválené elektrické kabely odpovídající napětí ve vaší elektrické síti. 

 
 
 

NEBEZPEČÍ ÚRAZU ELEKTRICKÝM PROUDEM. Připojte 
přístroj pouze do uzemněné zásuvky s odpovídajícím elektrickým proudem. 

 

 
Vysoké 
napětí 

Real-Time PCR systémy Applied Biosystems 7300/7500/7500 Fast spadají do třídy II 
(přepětí) a jsou klasifikovány jako přenosné přístroje 

 
 
 

Pohyblivé součásti 
 

 
Pohyblivé součásti                           RIZIKO PORANĚNÍ. Pohyblivé součásti se mohou zlomit či jinak 

poškodit. Při ovládání přístroje nesahejte na pohyblivé součásti. Před servisním zásahem 
vypojte přístroj ze sítě.  

 
 
 
 

Biologické riziko 
 
 

Biohazard  BIOHAZARD. Biologické lidské nebo zvířecí vzorky jako např. 
tkáně, tělní tekutiny a krev mohou být zdrojem infekčních onemocnění. Postupujte podle 
všech místních/národních předpisů. Používejte prostředky ochrany očí, ochranný oděv a 
rukavice. Prostudujte si a postupujte podle pokynů v následujících publikacích: 
 
 

•   Doporučení U.S. Department of Health and Human Services publikované 
v Biosafety in Microbiological and Biomedical Laboratories (č. 017-040-00547-4; 
http://bmbl.od.nih.gov), 

•   Occupational Safety and Health Standards, Bloodborne Pathogens 
(29 CFR§1910.1030; http://www.access.gpo.gov/nara/cfr/ 
waisidx_01/29cfr1910a_01.html). 

 

Další informace týkající se biologického rizika naleznete na: http://www.cdc.gov 
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Bezpečná práce 
 
 
 
Bezpečná práce 

 
Správná ergonomie vašeho pracovního místa může snížit nebo eliminovat únavu, 
bolest a námahu. Tyto průvodní jevy můžete omezit nebo odstranit takovým 
umístěním vašeho systému, které umožní jeho pohodlné ovládání. 

 
 

NEBEZPEČÍ SVALOVÉHO PORANĚNÍ. Toto nebezpečí je 
způsobeno např. ale nikoliv výlučně opakovanými pohyby, nevhodným umístěním, 
vysokou namáhavostí, udržováním těla ve statických pozicích, tlakem a dalšími faktory.  

 
 

Abyste toto nebezpečí snížili: 
 

•   Používejte zařízení, které vám umožní pracovat v neutrálních pozicích s dobrou 
dostupností klávesnice, monitoru a myši. 

•   Umístěte klávesnici, myš a monitor tak, aby byla umožněná relaxovaná poloha 
hlavy a těla. 

 
 
Bezpečnost a normalizace v oblasti elektromagnetické 
kompatibility (EMC) 

 
Tato část obsahuje informace o: 

 

•   Bezpečnostních předpisech v USA a Kanadě 

•   Kanadských normách EMC  

•   Evropských bezpečnostních předpisech a normách EMC 

•   Australských normách EMC 
 

 
Bezpečnostní 

předpisy v USA 
a Kanadě  

Tento přístroj byl testován podle norem UL 61010A-1 “Safety Requirements for 
Electrical Equipment for Laboratory Use, Part 1: General Requirements” a UL 61010-2-
010 “Particular Requirements for Laboratory Equipment for the Heating of Materials” a 
splňuje jejich požadavky. 
 

Tento přístroj byl testován podle normy CSA 1010.1 “Safety Requirements for Electrical 
Equipment for Measurement, Control, and Laboratory Use, Part 1: General 
Requirements” a splňuje její požadavky.

 

 
Kanadské 

normy EMC 
Tento přístroj byl testován podle normy ICES-001, Issue 3: “Industrial, Scientific, and 
Medical Radio Frequency Generators“ a splňuje její požadavky. 

 

 
Evropské 

bezpečnostní 
předpisy a normy 

EMC 
 

Bezpečnost 
 

Tento přístroj splňuje bezpečnostní požadavky evropské Směrnice pro nízké napětí 
73/23/EEC. Tento přístroj byl testován podle norem EN 61010-1:2001 “Bezpečnostní 
požadavky na elektrické měřící, řídící a laboratorní zařízení, část 1: Obecné požadavky”,  
EN 61010-2-010 “Zvláštní požadavky pro laboratorní zařízení pro ohřev materiálu” a EN 
61010-2-081:2002+A1:2003 “Zvláštní požadavky pro automatická a poloautomatická 
laboratorní zařízení pro analytické a jiné účely” a splňuje jejich požadavky.
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Bezpečnost a elektromagnetická kompatibilita   

  

Bezpečnost a normalizace v oblasti elektromagnetické kompatibility (EMC) 
 

 
 
 

EMC 
 

Tento přístroj splňuje požadavky směrnice Rady Evropské unie pro elektromagnetické 
rušení a odolnost vůči němu (EMC směrnice 89/336/EEC). Tento přístroj byl testován 
podle normy EN 61326 (Třída B) “Elektrická zařízení pro měření, kontrolu a laboratorní 
použití – požadavky EMC”. 

 

 
Australské 

normy EMC 
Tento přístroj byl testován podle normy AS/NZS 2064 “Limits and Methods 
Measurement of Electromagnetic Disturbance Characteristics of Industrial, Scientific, and 
Medical (ISM) Radio-frequency Equipment” a splňuje její požadavky”. 
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Kapitola 1 
 
 
 
 
 

 Před zahájením instalace 1 
 
 
 
 
 
 
 
 

Před zahájením 
instalace 

 
     Zapnutí počítače 

 
Viz strana 2  

 
 
 
 

Vybalení a  
příprava přístroje 
 

 

 
 
 

Instalace 
softwaru a 
zapnutí přístroje 

                          Volba metody  
                       instalace 

 

Viz strana 2  

 
 
 
 

Provedení  
kalibrace ROI  

 
 
 
 

Provedení kalibrace 
pozadí a optické 
kalibrace  

 

 
   Plánování instalace 

 
 Viz strana 5  

 

 
 
 

 
Provedení kalibrace 
barev 

 
 
 
 

 
Ověření funkčnosti  
přístroje 

 
 
 
 

Vypnutí systémů  
7300/7500/ 
7500 Fast 
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Zapnutí počítače 
 
 
 
Zapnutí počítače 

 
Před instalací Real-Time PCR systémů Applied Biosystems 7300/7500/7500 nejprve 
zapněte počítač a přihlašte se jako administrátor operačního systému Windows, tak jak 
je popsáno v příručce Applied Biosystems Real-Time PCR System Computer Setup 

Guide. 
 
 

Volba metody instalace 
 

Po zapnutí počítače pokračujte instalací systému. Zvolte metodu instalace: 
 

•   Průvodce instalací (Real-Time System Setup wizard) na instalačním CD 
nebo 

•   Tato příručka o instalaci a údržbě 
 

Obě metody vás provedou všemi kroky instalace a kalibrace systému. 
 
 
 
 
 
 
 
 
 

1.  Zapnutí počítače 
(Návod na přípravu počítače) 

2.  Instalace systému 
(Průvodce nebo tato příručka) 

 
 
 
 
Použití průvodce instalací (Real-Time System Setup Wizard) 

 
 

Použití 
průvodce 
instalací 

Průvodce instalací (Real-Time System Setup wizard) je online nástroj, který můžete 
použít namísto této příručky pro instalaci vašeho nového systému. 
 

Po zapnutí počítače a přihlášení se jako administrátor systému Windows, tak jak je 
popsáno v příručce Applied Biosystems Real-Time PCR System Computer Setup Guide, 
vložte instalační CD do diskové jednotky počítače. Průvodce se spustí po krátké prodlevě 
automaticky. Průvodce instalací poskytuje krok za krokem instrukce pro: 
 

•   Plánování instalace 

•   Vybalení a umístění přístroje 

•   Kontrolu dodávky 

•   Provedení kalibrace ROI  

•   Provedení kalibrace pozadí 

•   Provedení optické kalibrace (pouze 7500/7500 Fast) 
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Opakovaná 
kalibrace/ 
Ověření 

 
Účel 

 
Kdy provádět 

ROI Určuje pozice jamek v bloku. •   Každých 6 měsíců 

•   Po výměně halogenové žárovky 
 

Po provedení kalibrace ROI musíte rovněž 
provést kalibraci pozadí, optickou kalibraci 
(pouze 7500/7500 Fast), kalibraci barev a 
ověření funkčnosti přístroje. 

Pozadí Měří fluorescenci pozadí v přístroji. Během běhů je 
potom fluorescence pozadí odečítána z naměřených 
dat.  

•   Měsíčně 

•   Po výměně halogenové žárovky 
 

Po provedení kalibrace pozadí musíte rovněž 
provést optickou kalibraci (pouze 7500/7500 
Fast). 

Optická  
(pouze 7500/ 
7500 Fast) 

Kompenzuje vliv dodatečného filtru v modelech 
7500/7500 Fast. 

•   Měsíčně 

•   Po provedení kalibrace pozadí 

•   Po výměně halogenové žárovky 

Barvy Slouží pro charakterizaci jednotlivých barev. V průběhu 
běhu jsou spektra, která jsou výsledkem kalibrace 
barev, používána k rozlišení příspěvku jedné každé 
barvy do celkové přístrojem snímané fluorescence. 

Každých 6 měsíců 
 

Před jejím provedením musíte provést 
kalibraci pozadí (model 7300) nebo optickou 
kalibraci (modely 7500/7500 Fast) 

RNáza P Slouží k ověření, že je přístroj schopen rozlišit  
5000 a 10000 genomových ekvivalentů genu pro 
RNázu P s 99.7% koeficientem spolehlivosti. 

Po přemístění přístroje nebo je-li nutné 
ověření funkčnosti přístroje 

 

Volba metody instalace 
 

 
 
 
 
 
 
 

Použití průvodce 
pro rekalibraci 

systému 

•   Provedení kalibrace barev 

•   Ověření funkčnosti přístroje 1 
 

Průvodce instalací (Real-Time System Setup wizard) můžete rovněž použít i po 
zprovoznění přístroje pro provádění rutinních opakovaných kalibrací a 
ověřovacích běhů za účelem dosažení optimální funkčnosti systému: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Průvodce instalací spustíte pomocí  > All Programs > Applied Biosystems > 
7300/7500/7500 Fast System > Real-Time System Setup Wizard. 
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Volba metody instalace 
 
 
 
Použití příručky o instalaci a údržbě 

 
 

Použití této 
příručky pro 

instalaci 
systému 

Kromě možnosti použít pro instalaci systému průvodce instalací (Real-Time System 
Setup wizard) máte i možnost provést instalaci manuálně tak jak je popsáno 
v následujících kapitolách této příručky: 
 
 

 
Vybalení a příprava 
přístroje 
 
 
 
 
 
Instalace softwaru a 
zapnutí přístroje 
 
 
 
 
 
 
Provedení kalibrace  
ROI  
 
 
 
 
 
Provedení  
kalibrace 
pozadí 
 
 
 
 
Provedení  
kalibrace 
barev 
 
 
 
 
Ověření 
funkčnosti 
přístroje 

 

 
 

 
Použití této 
příručky pro 

rekalibraci 
systému 

 
Postupy uvedené v této příručce můžete použít pro účel manuální opakované kalibrace 
již zprovozněného systému. Průvodce instalací (Real-Time System Setup wizard) 
nicméně provádění opakovaných kalibrací automatizuje a eliminuje tak potřebu 
manuální kontroly spekter jednotlivých barev (Kapitola 6) a výpočtu parametrů pro 
ověření systému (Kapitola 7). 
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Plánování instalace 

 
 
 
Plánování instalace 
  1 

Instalace, kalibrace a ověření funkčnosti Real-Time PCR systémů společnosti Applied 
Biosystems 7300/7500/7500 Fast vám nezabere déle než jeden osmihodinový pracovní 
den. Během instalace nemusíte být přítomni po celou její dobu, nicméně je důvodné 
předpokládat, že strávíte u přístroje většinu této doby. 

 

 
Doporučený 

postup 
Kroky, které provádíte při používání této instalační příručky, a doba, kterou si tyto kroky 
vyžadují, jsou schematicky znázorněny níže. 

 
 

Poznámka:  Průvodce instalací (Real-Time System Setup wizard) provádí většinu níže 
zmíněných kroků automaticky a určité kroky pak vyžadují méně času. Jednotlivé 
kroky a doba jejich trvání viz strana “Planning the installation” (Plánování instalace) 
v průvodci instalací. 

 

 
 
 

Potřebná doba Úkol 
 
 

Nastavení počítače (viz příručka Applied Biosystems Real-Time 
PCR System Computer Setup Guide). 

 
~ 00:10:00 

 
Vybalení a příprava přístroje (Kapitola 2): 

a.  Volba dodatečného hardwaru a softwaru. 

b.  Vybalení a umístění systému 7300/7500/7500 Fast.  

c.  Kontrola dodávky. 

d.  Zprovoznění systému 7300/7500/7500 Fast. 
 
 
 
 

 
 
 
 
 

Viz pozn. níže 

Instalace a nastavení softwaru (Kapitola 3): 
a.  Instalace softwaru pro systém 7300/7500/7500 Fast. 

b.  Zapnutí, instalace ovladačů, aktualizace firmwaru.  

c.  Provedení testu funkčnosti přístroje. 

 
 
 
 
 
 

~ 00:30:00 

Provedení kalibrace ROI (Kapitola 4): 
a.  Příprava destičky pro kalibraci ROI 

b.  Vytvoření dokumentu destičky. 

c.  Provedení kalibrace ROI. 
 
 

pokračování na další straně 

Poznámka: U některých nových přístrojů může být zapotřebí provést aktualizaci firmwaru. Aktualizace se 
spustí automaticky a zabere ca. 45 minut. Vaše přítomnost je nutná pouze při zahájení a ukončení 
aktualizace. 

~ 00:45:00 

~ 00:15:00 
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7500 Fast 

Plánování instalace 
 
 
 
 
 

Doporučený postup (pokračování) 
 

Potřebná doba Úkol 
 

 
 
 
 
 

~ 00:30:00 

Provedení kalibrace pozadí (Kapitola 5): 
a.  Příprava destičky pro kalibraci pozadí.  

b.  Vytvoření dokumentu destičky. 

c.  Provedení kalibrace pozadí. 

d.  Analýza výsledků kalibrace pozadí. 
 

 
 
 

 
 
 

~ 00:10:00 

Provedení optické kalibrace (pouze 7500/7500 Fast, Kapitola 5): 
a.  Vytvoření dokumentu destičky. 

b.  Provedení optické kalibrace. 

c.  Analýza výsledků optické kalibrace. 
 

 
 

7300 
 
 
 
 

~ 01:00:00 

7500/7500 Fast 
 
 
 
 

~ 01:20:00 

Provedení kalibrace barev (Kapitola 6): 
a.  Příprava destiček pro kalibraci barev.  

b.  Vytvoření dokumentu destičky. 

c.  Provedení kalibrace barev. 

d.  Analýza výsledků kalibrace barev.  

e.  Vyhodnocení kalibračních spekter barev. 
 
 

7300/7500 7500 Fast Ověření funkčnosti přístroje (Kapitola 7): 
a.  Příprava ověřovací destičky TaqMan®  RNáza P. 

b.  Vytvoření dokumentu destičky. 

c.  Pŕovedení ověřovacího běhu. 

d.  Analýza výsledků ověřovacího běhu TaqMan® RNáza P. 
 
 

Poznámka: Vaše nutná osobní přítomnost u přístroje po celou dobu běhu je ca 5 minut. 

~ 02:00:00            ~ 00:40:00 

Viz pozn. níže 
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Kapitola 2 
 
 
 

Vybalení a příprava 
přístroje  

 
 
 
 

 2 
Před zahájením 
instalace 

 
 
 
 

Vybalení a 
příprava přístroje 

Volba dodatečného  
  hardwaru a softwaru Viz strana 9 

 

 
 
 

Instalace softwaru 
a zapnutí přístroje 

Vybalení a umístění systému 
7300/7500/7500 Fast 

 
Viz strana 12 

 
 
 
 

 
 
Provedení 
kalibrace ROI 

 
 

     Kontrola dodávky 

 
 
Viz strana 14 

 

 
 

 
Provedení kalibrace 
pozadí a optické 
kalibrace 

 

 
 
 

 
Provedení kalibrace 
barev 

 
 
 

Zprovoznění systému 
7300/7500/7500 Fast 

 
 
 
 
Viz strana 20 

 
 
 
 

 
Ověření funkčnosti  
přístroje 

 
 
 
 

Vypnutí systémů  
7300/7500/ 
7500 Fast 
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Dříve než začnete 
 
 
 
Dříve než začnete 

 
 

Poznámka:  Kroky uvedené v této příručce můžete provést rovněž pomocí průvodce 
instalací (Real-Time System Setup wizard). Vložte instalační CD do diskové 
mechaniky počítače, průvodce se spustí automaticky po krátké prodlevě. 

 
 

Potřebná doba 45 minut 
 

Potřebné 
pomůcky 

 
 
 
 
 
 
 
 

Nůžky nebo 
nůž 

Šroubovák 
(malý a úzký) 

Rukavice bez 
 pudru 

Ochranné brýle 

 

 
 

 Začínáme Dříve než začnete s instalací Real-Time PCR systému Applied Biosystems 7300/7500/ 
7500 Fast: 

 

•   Zprovozněte počítač podle návodu v příručce Applied Biosystems Real-Time PCR 

System Computer Setup Guide 

•   Přečtěte si příručku Applied Biosystems 7300/7500/7500 Fast Real-Time PCR 

System Site Preparation Guide a zkontrolujte seznam kroků, jejichž provedení je 
nutné před zahájením instalace, a které jsou v této příručce uvedeny. 

•   Připravte si výše uvedené pomůcky potřebné pro instalaci. 

•   Přečtěte si část “Výběr dodatečného hardwaru a softwaru” na straně 9 a, je-li to 
nutné, připravte si vše co chcete instalovat. 
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Výběr dodatečného hardwaru a softwaru 

 
 
Výběr dodatečného hardwaru a softwaru 

 
Před zahájením instalace si připravte dodatečný hardware a software, které chcete 
instalovat k systému 7300/7500/7500 Fast. 

 
 

Volba elektrických ochranných zařízení 
 

Společnost Applied Biosystems doporučuje používat ochranná elektrická zařízení, 

jejichž účelem je chránit systém 7300/7500/7500 Fast před ztrátou dat. 2 
 

 
Regulátor 
napětí 

Společnost Applied Biosystems doporučuje v oblastech, kde dochází k výkyvům napětí 
v rozsahu ±10%, používat 1.5-kVA regulátor napětí. Výkyvy napětí mohou nepříznivě 
ovlivnit funkci přístroje a data, která generuje. 

 
 

Poznámka:  Regulátor napětí monitoruje proud na vstupu do přístroje a upravuje 
vstupní příkon. Nechrání přístroj vůči nárazovému proudu nebo výpadku sítě. 

 

 
Záložní zdroj 

(UPS) 
Společnost Applied Biosystems doporučuje používat 1.5-kVA záložní zdroj 
(uninterruptable power supply, UPS), a to zejména v oblastech, kde dochází 
k výpadkům proudu. Výpadky proudu a další události, které neočekávaně ukončí 
funkci přístroje 7300/7500/7500 Fast, mohou poškodit data a případně zničit systém. 

 
 

DŮLEŽITÉ!   Zařízení UPS jsou vybavena bateriemi s omezenou dobou fungování, 
takže dodávají proud po omezenou dobu (od 30 minut do několika hodin). Jejich 
účelem je oddálit důsledky výpadku proudu, nikoliv sloužit jako náhradní elektrické 
zdroje. V případě výpadku proudu systém 7300/7500/7500 Fast vypněte (viz strana 
106) pokud neočekávate obnovení dodávky elektrického proudu během doby 
životnosti baterie UPS. 

 
 

Svodič přepětí Společnost Applied Biosystems doporučuje v oblastech s častými  elektrickými bouřemi 
nebo v blízkosti zařízení, která jsou elektricky rušivá jako lednice, klimatizace nebo 
centrifugy, používat 10-kVA svodiče přepětí. Krátkodobé výrazné kolísání elektrického 
napětí může neočekávaně ukončit fungování a tudíž poškodit počítač i systém 7300/ 
7500/7500 Fast. 

 
 

Poznámka:  Speciálně vyčleněný kabel a uzemnění spojující přístroj s hlavním 
rozvaděčem v budově může rovněž napomoci při eliminaci problémů vznikajících 
v důsledku  kolísání elektrického proudu. 
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Výběr dodatečného hardwaru a softwaru 
 
 
 
Připojení systému 7300/7500/7500 Fast do sítě 

 
Systém 7300/7500/7500 Fast funguje nezávisle na síťových vlastnostech operačního 
systému Windows XP Professional (pro fungování přístroje není nutné žádné speciální 
nastavení síťového protokolu nebo IP adresy). 

 
 

DŮLEŽITÉ!  Nepoužívejte systém 7300/7500/7500 Fast při současném připojení do 
bezdrátové sítě. Používání bezdrátové sítě může narušit proces ukládání dat a vést 
k jejich ztrátě. 

 
 
 

Zálohování dat 
 

Abyste zabránili ztrátě dat způsobené nepředpokládaným selháním počítače nebo 
jeho pevného disku, doporučuje společnost Applied Biosystems používat jedno 
nebo více zařízení pro zálohování dat. Je-li součástí vašeho systému laptop nebo 
desktop PC, můžete pro zálohování dat použít CD-RW jednotku. Budete-li ukládat 
soubory *.sds a *.sdt na CD pravidelně (týdně), vytvoříte si zálohu dat 
generovaných systémem 7300/7500/7500 Fast. Před instalací systému 
7300/7500/7500 Fast zvažte, jakou metodu zálohování dat budete používat. 

 
 

Instalace softwaru do systému 7300/7500/7500 Fast 
 

Chcete-li instalovat do systému 7300/7500/7500 Fast další programy, ujistěte se, že tyto 
programy: 

 

•   Nebrání komunikaci přes universal serial bus (USB) porty 
nebo 

•   Neinterferují s funkcemi programů Real-Time PCR systémů. 
 

Poznámka:  Chcete-li ověřit, že nedochází ke konfliktu s programy Real-Time PCR 
systémů, proveďte několik běhů s použitím několika prázdných destiček (destiček, které 
neobsahují reagencie) předtím, než budete na systému 7300/7500/7500 Fast analyzovat 
vzorky. 

 
 

Antivirus Pokud je systém 7300/7500/7500 Fast připojen do sítě, doporučuje společnost Applied 
Biosystems používání komerčních anitvirových programů. 

 

 
Archivace nebo 

komprese 
souborů 

Společnost Applied Biosystems doporučuje soubory pro archivaci dat generovaných 
systémem 7300/7500/7500 Fast komprimovat. Podrobnější informace naleznete v části 
“Archivace a zálohování souborů SDS” na straně 111. 
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Výběr dodatečného hardwaru a softwaru  
 

 
Zabezpečení 

počítače (firewall a 
kódovací nástroje) 

Pokud chcete instalovat programy pro zabezpečení počítače, abyste ochránili 
systém 7300/7500/7500 Fast připojený do sítě, ujistěte se, že tyto programy nebrání 
komunikaci přes USB port mezi přístrojem 7300/7500/7500 Fast a programem 
SDS. Pokud nástroje zabezpečení počítače omezí fungování USB portu, mohlo by 
dojít k poruchám komunikace. 

 
 

Poznámka:  Součástí operačního systému Microsoft Windows XP Professional, 
instalovaného na počítači, který je součástí systému 7300/7500/7500 Fast, je i 

integrovaná firewall. Společnost Applied Biosystems nepodporuje používání tohoto  2  
integrovaného nástroje systému Windows a nemůže poskytovat podporu při řešení 
problémů vzniklých v důsledku jeho používání. 

 

 
Systémové 
nástroje a 

programy pro 
optimalizaci 

výkonu systému 

Společnost Applied Biosystems doporučuje pro dosažení optimálního výkonu systému 
7300/7500/7500 Fast pravidelně používat nástroj pro defragmentaci disku, který je 
integrální součástí operačního systému Windows XP Professional, a komerční 
archivační nástroje. (Podrobnější informace naleznete v části “Čistění a defragmentace 
pevného disku” na straně 118.) 

 
 

Poznámka:  Před instalací jiného defragmentačního programu nebo jiného programu 
pro zlepšování výkonnosti systému se ujistěte, že tento program neinterferuje 
s funkcemi programu SDS jak je popsáno v části “Zabezpečení počítače (firewall a 
kódovací nástroje)” výše. 
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GR2349 
7300/7500 
People Lift 

Vybalení a umístění systému 7300/7500/7500 Fast  

 
 
 
Vybalení a umístění systému 7300/7500/7500 Fast  

 

 
 

RIZIKO VZNIKU PORANĚNÍ. Nepokoušejte se zvedat přístroj  
nebo jiné těžké předměty, pokud nejste poučeni o správném postupu této činnosti. 
Nesprávný postup zvedání může vést ke vzniku bolestivého a někdy i trvalého poranění 
zad. Používejte proto při zvedání nebo přenášení přístroje správný postup. Pro zvedání 
přístroje 7300/7500/7500 Fast je zapotřebí minimálně dvou osob. 

 

 
Kontrola 

kroků před 
instalací 

Před sestavením vašeho systému 7300/7500/7500 Fast zkontrolujte, zda jste provedli 
kroky uvedené v příručce Applied Biosystems 7300/7500/7500 Fast Real-Time 
PCR System Site Preparation Guide. Tuto příručku jste obdrželi ještě před dodáním 
přístroje a nalezenete v ní seznam požadavků přístroje z hlediska jeho nároků na okolí a 
elektrickou síť. 

 

 
Postup při 
zvedání a 

přemisťování 

•   Ověřte, že plocha, na 
kterou chcete přístroj 
umístit, má nosnost 
alespoň 54,5 kg (120 
liber). 

•   Ověřte, že na trase 
předpokládaného 
transportu přístroje 
nejsou žádné překážky. 

•   Udržujte svou páteř 
v neutrální pozici. 

•   Podřepněte v kolenou a 
zvedejte propnutím nohou. 

•   Nezvedejte předmět při 
současném otáčení se. 

•   Před zvedáním a 
přenášením se na 
jednotlivých krocích 
domluvte s tím, kdo s vámi 
tuto činnost provádí. 
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 Vybalení a umístění systému 7300/7500/7500 Fast 
 

 
 
 
Umístění součástí systému 

 
1.  Na vnější straně krabice, v níž je přístroj 

zabalen, naleznete dva indikátory: 

•   Indikátor náklonu (ve spodní části krabice), 
který signalizuje, zda byla krabice výrazně 
nakloněna 

•   Indikátor nárazu (ve svrchní části 
krabice), který signalizuje hrubé 
nakládání s krabicí 

 

Pokud některý z těchto indikátorů signalizuje 
náklon nebo náraz, proveďte níže uvedené 
kroky a následně vizuální kontrolu obsahu 
krabice: 

•   Je-li cokoliv v krabici poškozeno, 
kontaktujte společnost Applied Biosystems. 

•   Pokud nic není poškozeno, pokračujte 
v instalaci. 

 
2.  Přeřízněte popruhy držící krabici. 

 
3.  Přeřízněte pásku na vrchu krabice a 

krabici otevřete. 
 

4.  Vyjměte krabici obsahující instalační soupravu a 
odložte ji stranou. 

5.  Zvedněte a odstraňte vrchní část krabice. 

 

 
Rozříznout a 
otevřít 
 
 
 
Rozříznout a 
odstranit 

 
 
 
 
 
 

GR2351 
7300/7500 

box explode (step 2) 

 
Vyjmout 
 
 
 
 
 
 
 

2 

 

 
 

Zvednout 
a 
odstranit 

 

Zvednout  
a odstranit 

 
 
 
 
 
 

6.  Odstraňte ochranný kryt systému 
7300/7500/7500 Fast. 

 
7.  Přistupte k přístroji ze stran a pevně jej 

uchopte v rozích. 
 
8.  Záda udržujte rovná, propněte nohy a položte 

přístroj na stůl. Umístěte přístroj na stůl vedle 
počítače podle obrázku níže. 

Rovná záda 
 
 
 
 

GR2349 
7300/7500 

 
 
 
 
 
Podřepnout 
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√ Přístroj a počítač 

 •   7300/7500/7500 Fast 

•   Počítač Dell® Tower 

•   Plochý monitor Dell 

 •   7300/7500/7500 Fast  

•   Laptop Dell®  

 

Kontrola dodávky 

 
 
 

DŮLEŽITÉ!  V tuto chvíli nepřipojujte počítač k přístroji. 
 
 

7300/7500/7500 Fast s desktop PC 7300/7500/7500 Fast s laptopem 
 

 

 

 
 

 
 

Kontrola dodávky 
 

Před zahájením instalace ověřte, že jste obdrželi všechny součásti systému, které jste 
zakoupili. 

 

 
Kontrola 
dodávky 

1.  Ověřte, že jste održeli jednu z následujících variant. 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

Přístroj 7300/7500/7500 Fast s počítačem 
Dell® tower a plochým monitorem 

7300/7500/7500 Fast 
s laptopem Dell® 
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√                Instalační souprava    výr.č. 

 Instalační souprava 7300/7500 
 

•   Program Primer Express®  
 

•   Sada elektrických kabelů (Austrálie, 
Británie, Evropa, Severní Amerika, 
Japonsko) 

 

•   Optické destičky, 96-jamkové, 
s čárovými kódy (100 destiček) 

 

•   Universal Serial Bus (USB) kabel 
 

•   Halogenová žárovka (12V, 75W) 
 

•   Zelená destička 
 

•   Černá destička 
 

•   Stojánek 
 

•   Optické adhezivní fólie a nástroj 
k jejich připevnění 

 

Další položky (držák vizitek, 
odpovědní instalační karta, záruční 
list, poznámky) 

4349804 
 

4361938 
 

603615 
 
 
 

4306737 
 
 

4328260 
 

4345287 
 

4306819 
 

4305872 
 

4312063 
 

4311971 
4348209 

 

–– 

 

 
 
 
 

Pri m erExpress
™
 

V er s i on2.0 

  

 

Kontrola dodávky 
 
 
 

2.  Otevřete krabici s instalační soupravou a ověřte, že 
v závislosti na typu vašeho přístroje obsahuje 
následující položky: 

 
 
 
 
 
 
 
 
 

Primer 
Express®  

Sada elektrických kabelů 2 

 
 
 
 

 
Optické 
destičky  
 

 
USB kabel Halogenová 

žárovka 

 

 
 

  Zelená destička   Černá destička 
 
 

 
Stojánek 

 
 

 
Optické adhezivní fólie a  
nástroj k jejich připevnění 
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√                Instalační souprava    výr.č. 

 Instalační souprava 7500 FAST 
 

•  Program Primer Express® , 

Verze 3.0 
 

•  Sada elektrických kabelů 
(Austrálie, Británie, Evropa, 
Severní Amerika, Japonsko) 

 

•  Universal Serial Bus (USB) 
kabel 

 

•  Halogenová žárovka (12V 75W) 
 

•  Optické destičky Fast 96-
jamkové s čárovými kódy (kód 
128) (20 destiček) 

 

•  Černá destička 
 

•  Stojánek 
 

•  Optické adhezivní fólie a nástroj 
k jejich připevnění  

 

•  Papír fluorescenční zelený 
(není vyobrazen) 

 

Další položky (držák vizitek, 
odpovědní instalační karta, 
záruční list, poznámky) 

4361854 
 

4361938 
 
 

603615 
 
 
 

4328260 
 
 

4345287 
 

4346906 
 
 
 

4305872 
 

4312603 
 

4311971 
4348209 

 

4323077 
 
 

–– 

 

 
 
 
 

PrimerExp ress
™
 

V er s i on2.0 

Kontrola dodávky  

 
 
 
 
 
 
 
 
 
 
 
 

 
Primer 
Express®  

 
 
Sada elektrických kabelů 

 
 
 
 

 
Optické 
destičky 

 
USB kabel 

 
Halogenová 
žárovka 

 
 
 
 

 
Černá destička 

 
 
 
 

Stojánek  
Optické adhezivní fólie a  
nástroj k jejich připevnění 
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√                     Kit    výr.č. 

 TaqMan®  RNáza P, ověřovací 
destička (systémy 7300/7500) 

4350584 

 TaqMan®  RNáza P, ověřovací 
destička  FAST (systém 7500 
Fast) 

4351979 

 Kit(y) podle vašeho systému: 
 

•   Applied Biosystems 7300 
Real-Time PCR 
systém, Spektrální 
kalibrační kit obsahující: 

–   Destičku pro kalibraci 
     pozadí 

–   Destičky pro kalibraci 
barev (barvy FAM™, 
JOE™, NED™, ROX™, 
SYBR®  Green, TAMRA™ 
a VIC® ) 

–   Destičku pro kalibraci ROI  
 

•   Applied Biosystems 7500 
Real-Time PCR systém, 
Spektrální kalibrační kit I a II 
obsahující: 

–   Destičku pro kalibraci pozadí 

–   Destičky pro kalibraci barev 
(barvy CY3, CY5, FAM, 
JOE, NED, ROX, SYBR 
Green, TAMRA, TEXAS 
RED® a VIC) 

–   Destičku pro kalibraci ROI  
 

•   Applied Biosystems 7500 Fast 
Real-Time PCR systém 
Spektrální kalibrační kity I a II 
obsahující: 

–   Destičku pro kalibraci pozadí 

–   Destičky pro kalibraci barev 
(barvy CY3, CY5, FAM, 
JOE, NED, ROX, SYBR 
Green, TAMRA, TEXAS 
RED a VIC) 

–   Destičku pro kalibraci ROI 

 
 

4349182 
 
 
 
 
 
 
 
 
 
 
 
 

 
4349180 

(Kit I) 

4351151 
(Kit II) 

 
 
 
 
 
 
 
 
 

4360788 
(Kit I) 

4362201 
(Kit II) 

 

 
 
 
 
 

TaqMan® RNase P 
Instrument Verification Plate 

 
 
Applied Biosystems 7300 or 7500/7500 Fast Real-Time 
PCR system Spectral Calibration Kit 
 
 
 
 

Background ROI Calibration 
Plate Plate 

  

  

 

Kontrola dodávky 
 
 
 

3.  Ověřte, že jste obdrželi následující kity: 
 

 
TaqMan®  RNáza P, ověřovací destička 

 
 
 
 
 
 

TaqMan® RNáza P, 2 
 ověřovací destička 

 

  
Applied Biosystems 7300 nebo 7500/7500 Fast Real-Time 
PCR systém, Spektrální kalibrační kit 

 
 
 
 
 

Destička pro 
kalibraci 
pozadí 

Destička pro  
kalibraci ROI  

 
 
 
 
 
 
 
 
 

7300/7500/7500 Fast – Destičky pro 
kalibraci barev  (barvy FAM™, JOE™, 
NED™, ROX™, SYBR® Green, 
TAMRA™ a VIC®) 

Pouze 7500/7500  
Fast (barvy CY3,  
CY5 a TEXAS RED®) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

pokračování na další straně 



Kapitola 2  Vybalení a příprava přístroje  

Poznámky  
  
   
18 Instalace a údržba – Uživatelská příručka pro Real-Time PCR systémy Applied Biosystems 7300/7500/7500 Fast 

Kontrola dodávky  
 
 
 
 
 
 
 

√                     Kit    výr.č. 

 TaqMan®  Reagent Starter Kit 
(7300/7500 systémy, není 
vyobrazeno): 

 

•   TaqMan®  univerzální 
PCR Master Mix (2×), 
bez AmpErase®  UNG 
(1 mL) 

•   TaqMan®  esej pro 
kvantifikaci genové exprese, 
eukaryotická 18S rRNA 
(0.3 mL) 

•    cDNA lidských Raji buněk, 
(25 ng/µL) 

4352405 

 TaqMan® Fast Reagent Starter Kit 
(7500 Fast systém, není 
vyobrazeno): 

 

•   TaqMan®  Fast univerzální 
PCR Master Mix (2×), bez 
AmpErase®  UNG (1.25 mL) 

•   TaqMan®  esej pro 
kvantifikaci genové exprese, 
eukaryotická 18S rRNA 
(0.3 mL) 

•    cDNA lidských Raji buněk, 
(25 ng/µL) 

4352407 

 Katalog genomických esejí, 
CD (není vyobrazeno) 

4362363 
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√ Software a dokumentace výr.č. 

 Příručka Applied Biosystems 

Real-Time PCR System 

Computer Setup Guide 

4365367 

 Příručka Applied Biosystems 
7300/7500/7500 Fast Real-Time 

PCR System Installation and 

Maintenance Guide (tento 
dokument) 

4347828 

 Příručky Applied Biosystems 
7300/7500/7500 Fast Real-Time 

PCR System Getting Started: 
 

•   Absolute Quantitation 
 

•   Allelic Discrimination 
 

•   Plus/Minus 
 

•   Relative Quantitation 
 

Příručka Applied Biosystems 
7500/7500 Fast Real-Time PCR 
System: User Guide for the 21 CFR 
Part 11 Module in SDS Software 
v1.4 

 
 
 
 

4347825 
 

4347822 
 

4347821 
 

4347824 
 

4374432 

 Příručka Applied Biosystems Real-
Time PCR Systems Chemistry 
Guide 

4348358 

 Karta Applied Biosystems 

7500 Fast Real-Time PCR 

System Quick Reference Card 

(není vyobrazena) 

4362285 

 Příručka Applied Biosystems 
7300/7500/7500 Fast Real-Time 

PCR System Site Preparation 

Guide 

4347823 

 CD, SDS Software, v1.4:  
 •   7300 systém 4350809 

 •   7300 systém RT PCR RQ 
Study 

4350814 

 •   7500 systém 4350819 

 •   7500 Fast systém 4363619 

 Další položky (Setup and 
Maintenance Video CD, 
podložka pod myš, dopis 
zákazníkům, registrační karta) 

— 

 

 

Kontrola dodávky 
 
 
 

4.  Vybalte software a dokumentaci a ověřte, že jste 
obdrželi následující položky: 

 
 
 
 

Příručka SDS Chemistry 
 

Příručky Getting  
Started 

Příručka Installation and 
Maintenance  

 
Příručka Site Preparation 

 2 
 
 
 
 
 
 
 
 
 
  
 
 

Příručka 
Computer Setup 

 
 
 
 
 
 
 
 
 
 
 

CD s programem 
           SDS  

Setup and 
Maintenance 

Video CD 
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Kapitola 2  Vybalení a příprava přístroje 
Zprovoznění systému 7300/7500/7500 Fast  

 
 
 
 
Zprovoznění systému 7300/7500/7500 Fast  

 
 

DŮLEŽITÉ!  Nepřipojujte zatím USB kabel do přístroje 7300/7500/7500 Fast. 
 
 

Tato část popisuje jak zprovoznit systém 7300/7500/7500 Fast. 
 

 
Potřebné 
pomůcky 

•   šroubovák (malý a úzký) 

•   elektrický kabel (z instalační soupravy) 
 

 
Příprava místa Připravte místo podle návodu v příručce Applied Biosystems 7300/7500/7500 Fast 

Real-Time PCR System Site Preparation Guide. Naleznete tam údaje o hmotnostech, 
rozměrech a požadavcích na elektrickou síť. 

 
Příprava 
systému 

1.  Otevřete dvířka přístroje 7300/7500/7500 Fast. 
 

a.  Vložte tenký šroubovák do otvoru na hraně 
dvířek a zatlačte, až dvířka odskočí. 

b.  Otevřete dvířka. 
 
 
 

 
  2. Ověřte, že 

vyhřívaný 
kryt je 
úplně 
vysunut 
dopředu. 

 
 
 
 

 
 
 
 
Vyhřívaný 
kryt 

GR2482 

 
 
 

3.  Ověřte, že během transportu nedošlo k poškození 
přístroje 7300/7500/7500 Fast. 

Je-li přístroj poškozen, seznamte se s rozsahem 
škody (místo a vzhled) a kontaktujte technickou 
podporu společnosti Applied Biosystems nebo 
zástupce servisu (viz “Kde získat pomoc” na straně 
xiii). 
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 Kapitola 2  Vybalení a příprava přístroje 
Zprovoznění systému 7300/7500/7500 Fast  

 
 
 

4.  Uzavřete dvířka přístroje. 
 
 
 
 
 
 
 
 
 

2 
5.  Připojte elektrický kabel do přístroje 7300/7500/ 

7500 Fast a následně do zásuvky. 
 

Poznámka:  Součástí dodávky jsou kabely pro 
různé napětí elektrické sítě. Použijte kabel 
odpovídající vaší elektrické síti, ostatní kabely 
vyhoďte. 

 

 
 

6. Stiskněte hlavní spínač umístěný na čelním 
panelu vpravo dole a vyčkejte, než se systém 
7300/7500/7500 Fast spustí (ca 30 vteřin). 

 
 
 
 
 
 
 
 

7.  Jakmile se rozsvítí dioda na čelním panelu 
vlevo dole, stiskněte zásuvku, čímž ji 
vysunete. 

 

 
 
 
 
 
 
 
 
 

8.  Odstraňte transportní destičku ze zásuvky a 
odložte ji stranou. 

 
Poznámka:  Transportní destičku nevyhazujte. 
Použijete ji při dlouhodobém odstavení systému 
z provozu (viz strana 108). 

 

Vyjmout 
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Kapitola 2  Vybalení a příprava přístroje 
Zprovoznění systému 7300/7500/7500 Fast  

 
 
 

9.  Uzavřete zásuvku a vypněte přístroj stiskem 
hlavního spínače. 

 
Poznámka:  Zavíráte-li 
zásuvku, zatlačte na 
její pravé straně a pod 
úhlem. 

 

 
 
 
 
 
Zde 
tlačit 

 
 
Chcete-li instalovat nějaký další hardware 
(viz strana 9), proveďte to nyní. 

 
 
 
 
DŮLEŽITÉ!  Nepřipojujte zatím USB kabel do přístroje 
7300/7500/7500 Fast . 
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Kapitola 3 
 
 
 

Instalace softwaru a zapnutí  
přístroje 

 
 
 
 
 
 

Před zahájením 
Instalace 

 

 
 
 
 

Vybalení a 
příprava přístroje 

 

 
Instalace programu SDS 
pro systém 7300/7500/ 

7500 Fast 

 

3 
 

Viz strana 25 

 
Instalace 
softwaru a 
zapnutí přístroje 

 

 
 
 

 
Provedení 
kalibrace ROI 

 
 

            Zapnutí přístroje 

 

 
Viz strana 28 

 
 
 
 

 
Provedení kalibrace 
pozadí a optické 
kalibrace 

 
 

Provedení funkčního 
testu 

 

 
 
Viz strana 30 

 

 
 

Provedení kalibrace  
barev 

 
 
 
 

 
 
Ověření funkčnosti  
přístroje 

 

Řešení problémů Viz strana 32 

 
 
 
 

Vypnutí systémů  
7300/7500/ 
7500 Fast
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Přehled 

 
 
 
Přehled 

 
 

Poznámka:  Kroky uvedené v této příručce můžete rovněž provést pomocí průvodce 
instalací (Real-Time System Setup wizard). Průvodce otevřete tak, že vložíte do 
mechaniky počítače instalační CD. Průvodce se spustí automaticky po krátké prodlevě 
po vložení CD. 

 
 

Potřebná doba 45 minut 
 

Potřebné 
pomůcky 

 
 
 
 

 
CD – program SDS 
a dokumentace 

Rukavice bez pudru Ochranné brýle 

 
 

DŮLEŽITÉ!  Plánujete-li na počítač připojený k systému 7300/7500/7500 Fast instalovat 
ještě další programy (viz strana 10), dokončete nejprve instalaci systému 7300/7500/ 
7500 Fast tak, jak je popsána v této příručce, než přistoupíte k instalaci dalších 
programů. Instalace programů jiných výrobců na počítač systému 7300/7500/7500 Fast 
před ukončením kroků popsaných v této příručce může instalaci komplikovat. 

 
 
 

DŮLEŽITÉ!  Pokud instalujete program SDS spolu s modulem 21 CFR Part 11, seznamte 
se s příručkou Applied Biosystems 7500/7500 Fast Real-Time PCR System: User 
Guide for the 21 CFR Part 11 Module in SDS Software v1.4. 
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Instalace programu SDS pro systém 7300/7500/7500 Fast 
 

 
 

DŮLEŽITÉ!  Chcete-li instalovat program SDS, musíte být přihlášeni v systému 
Windows jako administrátor. 

 
 

1.  Připravte si instalační CD a dokumentaci. 
 

2.  Zapněte počítač a přihlašte se jako administrátor operačního systému Windows, jak 
 je popsáno v příručce Applied Biosystems Real-Time PCR System Computer Setup 
Guide. 

3 
3.  Vložte instalační CD programu SDS do CD mechaniky počítače. Po krátké 

 prodlevě se automaticky spustí průvodce instalací (Real-Time System Setup 
 wizard). 

 

Pokud se průvodce nespustí automaticky, poklepejte na ikonu  (My 
Computer), vyhledejte CD jednotku a poklepejte na SystemSetupWizard.exe. 

 
4.  Klikněte na Install the SDS Software (Instalace programu SDS). 

 

 
 
 
 
 
 
 
 
 
 
 
 

Klikněte 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.  Na stránce Software Installation Materials Required (Pomůcky potřebné 
k instalaci) zatrhněte volbu I have obtained the materials listed above 
(Mám připravené potřebné pomůcky), a klikněte  (Další). 
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. 

 

Instalace programu SDS pro systém 7300/7500/7500 Fast  
 
 
 

6.  Následně klikněte na ikonu  
(Instalace/Aktualizace programu SDS). Otevře 
se průvodce instalací (InstallShield® Wizard). 

 
7.  Na uvítací stránce klikněte  (Další). 

 
 
 
 
 
 
 
 
 
 
 
 

8.  Na stránce End User License Agreement 
(Licenční ujednání) klikněte  
(Ano), čímž ujednání přijmete. 

 
 
 
 
 
 
 
 
 
 
 

9.  Na stránce Choose Destination Location 
(Cílový adresář) klikněte na  (Další), 
čímž potvrdíte předvolený cílový adresář. 

 
 
 
 
 
 
 
 
 
 
 
10. Na stránce New Installation (Nová instalace) 

klikněte   (Další), čímž instalaci 
zahájíte. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Klikněte 
 

 
 
 
 
 
 
 
 
 
 
 
 
 Klikněte  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Klikněte 

 
 
 
 
 
 

 Klikněte 
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11. Jakmile je instalace ukončena, klikněte  
(Konec). 

7300 systém bez programu RQ:  

Postupte na krok 13. 
 

7300 s RQ, systémy 7500/7500 Fast: 

–  Po krátké prodlevě se zobrazí dialogové 
okno Product Registration (Registrace). 

–   Pokračujte krokem 12. 
 
12. Proveďte registraci programu (dialogové okno 

registrace se zobrazí pouze pro 7300 systém 
s RQ Study a 7500/7500 Fast systém): 

 

a.  Do pole Your Name zadejte vaše jméno. 
 

b.  Do pole Organization zadejte název vaší 
instituce. 

c.  Do pole Registration Code zadejte 
registrační kód, který naleznete na 
krabičce CD. 

d.  Klikněte . 
 

 
 
 
 

Poznámka:  Zobrazí-li se chybová hláška 
Network error, klikněte . Instalace se 
úspěšně dokončí i při zobrazení této hlášky. 
Tato hláška se zobrazuje pokud váš počítač není 
připojen do sítě. Pokud nepředpokládáte 
zapojení tohoto počítače do sítě, zvolte  Do not 
show me this message again (Tuto zprávu 
znovu nezobrazovat), následně Never again on 
this machine (Nikdy znovu na tomto počítači). 

 
Zobrazí se zpráva vyzývající vás k zadání 
dalších registračních kódů. 

 

13. Máte-li k dispozici další registrační kódy, 
klikněte  (Ano) a zopakujte krok 12. 
Jinak klikněte  (Ne). 

 
14.  Na stránce Real-Time System Setup wizard 

Software Installation (Průvodce instalací 
programu) klikněte  (Zavřít). 

 

15. Na stránce Real-Time System Setup wizard 
Welcome page (Uvítací stránka průvodce) 
klikněte  (Zavřít). 

 

Pokračujte částí “Zapnutí přístroje” na straně 28. 

 

 
 
 
 
 
 
 
 
 Klikněte 
 
 
 
 
 
 
 
a 
 

b 3 
c 

 
d 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Klikněte 
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Zapnutí přístroje 
 
 
 
Zapnutí přístroje 

 
 
DŮLEŽITÉ!  Nezapínejte přístroj pokud jste nenaninstalovali program SDS. Zapnete-li přístroj před instalací 
programu SDS, operační systém Windows provede instalaci ovladače, který neumožní správnou komunikaci 
přístroje a programu. 

 
 
 
DŮLEŽITÉ!  Ujistěte se, že počítač je nastaven tak, aby nemohl přejít do režimu spánku. Je-li tento režim aktivní, při 
přechodu do režimu spánku se zastaví sběr dat. Podrobnější informace naleznete v části “Nastavení obrazovky a 
možností napájení” na straně 141. 

 
 
Zapnutí 

 
1.  Pomocí USB kabelu propojte: 

•   USB port v zadní levé části přístroje  
a 

•   USB port počítače 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

USB propojení s počítačem Tower  USB propojení s laptopem 
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 Zapnutí přístroje 
 
 
 

2.  Stiskněte hlavní spínač přístroje 7300/7500/ 
7500 Fast. Následně: 

•   Postupně zablikají stavové diody v levém 
dolním rohu čelního panelu. 

–  Bliká-li zelená dioda, ujistěte se, že je 
zásuvka uzavřena. 

–  Svítí-li červená dioda, postupujte 
podle “Řešení problémů – Diody 
na čelním panelu” na straně 32.  

Hlavní spínač Stavové diody 
 

 
 
 

Zelená dioda 

(bliká) 

 

3 
Zavřete 
zásuvku 

 

 
 
 
 

•   Zelená dioda svítí (nebliká): 

–  Mezi přístrojem a počítačem bylo 
navázáno spojení. 

–  Operační systém Windows XP 
automaticky rozeznal přístroj jako 
nový hardware. 

–  Operační systém Windows XP 
automaticky instaloval ovladače potřebné 
pro ovládání přístroje. 

 
•   Jakmile je instalace ukončena, hláška 

Found New Hardware (Nalezen nový 
hardware) oznamuje, že přístroj je 
připraven k použití. 
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Provedení funkčního testu 
 
 
 
Provedení funkčního testu  

 

 
1.  Pokud není program SDS spuštěn, poklepejte na 

ikonu  na pracovní ploše. 
 
 
 
 
 
 
 
 
 

2.  V dialogovém okně Quick Startup (Rychlý start) 
zvolte Create New Document (Vytvořit nový 
dokument). 

 
 
 
 
 
 
 
 
 
 
 
 

3.  V průvodci New Document (Nový dokument) 
klikněte na  (Konec) čímž potvrdíte 
přednastavené parametry. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.  Zobrazí-li se vpravo uvedená chybová hláška, 
klikněte . Kalibraci ROI provedete po 
ukončení funkčního testu. 

 

Poklepejte 

 

 
 
 
 
 
 

Klikněte 
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 Provedení funkčního testu 

 
 
 

5.  Zvolte Instrument > Function Test (Přístroj > 
Funkční test). 

 
 
 
 

Zvolte 
 
 
 
 
 
 
 
 
 
 6.  V dialogovém okně Function Test (Funkční test) 

 ověřte, že všechny testy proběhly úspěšně: 
 

a.  Klikněte  (Všechny testy). 
 

b.  Pokud: 

•   Všechny testy proběhly úspěšně 
(Pass), pokračujte krokem 7. 

•   Některý z testů neproběhl úspěšně 
(Fail), postupujte podle  “Řešení 
problémů – Funkční testy” na 
straně 33. 

 

c.  Klikněte . 

 
 

a  Funkční testy – všechny úspěšné. 3 
 
 
 

b 
 
 
 
 

c 

 
 

Funkční test – Žárovka selhala. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

7.   Zvolte File > Close (Soubor > Zavřít) čímž 
dokument uzavřete. 

 
8.  Až vám program nabídne možnost dokument 

uložit, klikněte  (Ne). 
 

9.  V programu SDS zvolte File > Exit (Soubor > 
Konec).  

Pokračujte částí “Provedení kalibrace ROI” na 
straně 35. 

 
 
Zvolte 
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Řešení problémů 
 
 
 
Řešení problémů 

 
Tato část popisuje: 

 

•   Řešení problémů – Diody na čelním panelu, strana 32 

•   Řešení problémů – Funkční testy, strana 33 
 
 

Řešení problémů – Diody na čelním panelu 
 
 
Řešení problémů – Diody na čelním panelu 

 
Předpoklad: Svítí červená chybová dioda 

 
  •  Stiskněte dvířka přístroje, abyste se ujistili, že jsou zavřená. 

Pokud se rozsvítí zelená dioda, byla chyba způsobena 
otevřenými dvířky přístroje a instalace může pokračovat. 

 
Dvířka přístroje 

 

 
 
 
 
 

•   Zůstává-li červená dioda rozsvícena: 

a.  Otevřete dvířka přístroje. 

b.  Ujistěte se, že je uzavřený vyhřívaný vnitřní kryt.  

c.  Uzavřete dvířka přístroje. 

Pokud se rozsvítí zelená dioda, byla chyba způsobena 
otevřeným vnitřním krytem a instalace může pokračovat. 

 
 
 

•   Zůstává-li červená dioda rozsvícena, ověřte, že na počítači je 
zobrazena pracovní plocha systému Windows. Pokud tomu tak 
není: 

d.  Vypněte přístroj 7300/7500/7500 Fast.  

e.  Restartujte počítač. 

f.   Vyčkejte než se objeví pracovní plocha systému Windows. 

g.  Zapněte přístroj 7300/7500/7500 Fast. 

Pokud se rozsvítí zelená dioda, instalace může pokračovat. 

 

 
 
Vyhřívaný vnitřní kryt 
 
 
 
 
 
 
 
 
 
 
 
 
 

Pracovní plocha 
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Řešení problémů 
 
 
 
 
Řešení problémů – Diody na čelním panelu (pokračování) 

 
•   Zůstává-li červená dioda rozsvícena: 

h.  Ověřte, že k přístroji je připojen kabel USB. 

i.   Ověřte, že druhý konec kabelu USB je připojen k počítači. 

Pokud se rozsvítí zelená dioda, nebyl USB kabel správně 
zapojen a instalace může pokračovat. 

 
 
 

•   Zůstává-li červená dioda rozsvícena: 

j.   Vypněte přístroj 7300/7500/7500 Fast.  

k.  Vyčkejte 30 vteřin. 

l.   Zapněte přístroj 7300/7500/7500 Fast. 

 
•   Zůstává-li červená dioda rozsvícena, kontaktujte technickou 

podporu Applied Biosystems (viz strana xiii) nebo servisního 
technika. 

 
 
 
00:00:30 

3 

 
 
 
 
 
 
 
 
 
 
Řešení problémů – Funkční testy 

 

 
Řešení problémů – Funkční testy 

 
Předpoklad: USB Test se nezdařil 

 

1.  Vypněte přístroj, vyčkejte 30 vteřin a zapněte přístroj. 
 

2.  Proveďte funkční test přístroje (viz strana 30). 
 

3.  Pokud se test znovu nezdaří, ověřte, že USB propojení 
počítače a přístroje je v pořádku. 

 

4.  Proveďte funkční test přístroje (viz strana 30). 
 

5.  Pokud se test znovu nezdaří, kontaktujte technickou 
podporu Applied Biosystems (viz strana xiii) nebo servisního 
technika. (pokračování na další straně) 
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Řešení problémů 
 
 
 
 
Řešení problémů – Funkční testy (pokračování) 

 
Předpoklad: Test CCD, filtrů (Filter Wheel) nebo závěrky 
(Shutter) se nezdařil 

 

1.  Vypněte přístroj, vyčkejte 30 vteřin a zapněte přístroj. 
 

2.  Proveďte funkční test přístroje (viz strana 30). 
 

3.  Pokud se test znovu nezdaří, proveďte kalibraci ROI jak je 
popsáno v části “Provedení kalibrace ROI” na straně 35. 

4.  Ověřte, zda se obraz ROI objeví v okně ROI Inspector 
(Prohlížeč ROI). 

Ano –  Instalace může pokračovat. 

Ne – Kontaktujte technickou podporu Applied Biosystems 
(viz strana xiii) nebo servisního technika. 

 
Předpoklad: Test žárovky (Lamp Test) se nezdařil 

 

1.  Vypněte přístroj, vyčkejte 30 vteřin a zapněte přístroj. 
 

2.  Proveďte funkční test přístroje (viz strana 30). 
 

3.  Pokud se test znovu nezdaří, zvolte Instrument  > Lamp 
Status/Replacement (Přístroj > Žárovka – Stav/Výměna). 

 

4.  Pokud dialogové okno Lamp Status/Replacement (Žárovka – 
Stav/Výměna) hlásí chybný stav žárovky (Failed), vyměňte 
halogenovou žárovku (viz “Výměna halogenové žárovky” na 
straně 122). 

 

5.  Proveďte funkční test přístroje (viz strana 30). 
 

6.  Pokud se test znovu nezdaří, kontaktujte technickou 
podporu Applied Biosystems (viz strana xiii) nebo servisního 
technika. 

 
Předpoklad: Nezdařil se test cykleru (Thermal Cycler Test) 

 

1.  Vypněte přístroj, vyčkejte 30 vteřin a zapněte přístroj. 
 

2.  Proveďte funkční test přístroje (viz strana 30). 
 

3.  Pokud se test znovu nezdaří, kontaktujte technickou 
podporu Applied Biosystems (viz strana xiii) nebo servisního 
technika. 

 

 

 
 
 
 
 
 

Stav 
žárovky 
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4 
 

 

 

  

Kapitola 4 
 
 
 

Provedení kalibrace ROI 
(Regions of Interest) 

 
 
 
 
 
 

Před zahájením 
instalace 

 

 
 
 
 

Vybalení a 
příprava přístroje 

 
 
Příprava destičky 
pro kalibraci ROI 

 
 
Viz strana 38 

 
 

Instalace  
softwaru a  
zapnutí přístroje 

 

 
 
 
 

Provedení 
kalibrace ROI  

Vytvoření dokumentu 
destičky pro kalibraci ROI Viz strana 41 

 
 
 
 

 
Provedení kalibrace 
pozadí a optické 
kalibrace 
 
 
 

 
Provedení kalibrace 

ROI 

 
 

Viz strana 45 

 
 

Provedení kalibrace  
barev 
 
 

 
 
 

Ověření 
funkčnosti 
přístroje 
 
 

Řešení problémů 
 

Viz strana 49 

 
 

Vypnutí systémů  
7300/7500/ 
7500 Fast  
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Přehled 

 
 
 
Přehled 

 
 

Poznámka:  Kroky uvedené v této příručce můžete rovněž provést pomocí průvodce 
instalací (Real-Time System Setup wizard). Průvodce otevřete kliknutím na  > 
All Programs > Applied Biosystems 7300/7500/7500 Fast System > Real-Time 
System Setup Wizard. 

 
 

Potřebná doba 30 minut 
 

Potřebné 
pomůcky 
 

 
 
 
 
 
 
 
 
 
 
 

 
Applied Biosystems 

Real-Time PCR systém 
Spektrální kalibrační kit 

 

 
 
 
 

 
Kalibrační destička 

ROI 

 
 
 
 

 
 

Rukavice bez 
pudru 

 
 
 
 
 
 

 
 

Ochranné 
brýle 

 
 
 
 
 
 
 
 
 

GR2170 

 
Centrifuga s adapterem 

na destičky 

 
 

Kdy provádět 
kalibraci ROI 

Kalibraci ROI (Regions of Interest) proveďte: 
 

•   Při instalaci systému musíte provádět kalibrace v následujícím pořadí: 
 

a.  ROI 
 

b.  pozadí 
 

c.  optická (pouze systém 7500/7500 Fast) 
 

d.  barvy 
 

e.  ověření funkčnosti přístroje 

•   Každých 6 měsíců nebo podle potřeby, v závislosti na používání přístroje. 

•   Po výměně žárovky. 
 

 
DŮLEŽITÉ!  Po provedení kalibrace ROI musíte vždy provést kalibraci pozadí, 
optickou kalibraci (pouze systém 7500/7500 Fast), kalibraci barev a ověření funkčnosti 
přístroje. 
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Přehled 

 
 
 

Účel kalibrace 
ROI  

Kalibrace ROI (Regions of Interest, plošná kalibrace) slouží ke zmapování pozic 
jamek v destičce tak, aby program přístroje byl schopen přiřadit nárůst fluorescence 
v průběhu běhu určité specifické jamce na destičce. Jelikož přístroj používá pro 
rozlišení emise fluorescence v průběhu běhu sadu optických filtrů, je nutné provést 
kalibraci ROI pro každý jednotlivý filtr, abyste eliminovali vliv možných 
minortiních rozdílů v optické dráze. 
 

                   
 
Kalibrace ROI - náhled 

 

4 
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Standardní destičky –  
systém 7300 a 7500 

Destičky Fast – 
systém 7500 Fast 

Šikmý pravý horní roh 
 
 
 

A1 na druhé 
straně než je 
šikmý roh 
(A12). 

 

 
 
 

 
 

Maximální 
reakční 
objem 
100-µL  

 
 
Při promíchávání standardní destičky  
vortexujte a následně centrifugujte, aby se 
všechny reagencie dostaly na dno jamek. 

 

Poznámka:  Optické 96-jamkové destičky 
Fast nelze umístit do standardního bloku. 

Šikmý levý horní roh 
 
 

A1 v 
šikmém 
levém 
horním rohu 

 
 
 
 

 
 

Maximální 
reakční 
objem 
30-µL  

 
Destičky Fast centrifugujte, aby se všechny 
reagencie dostaly na dno jamek 

 

 
DŮLEŽITÉ!  Destičky Fast nevortexujte. 
Vortexování může vést ke ztrátě objemu. 

 

Poznámka:  Standardní destičky nejsou 
kompatibilní se systémem 7500 Fast a 
mohou se v 96-jamkovém Fast bloku 
poškodit. 

 

 

Příprava destičky pro kalibraci ROI 
 
 
 
Příprava destičky pro kalibraci ROI  

 
 

Standardní 
destičky a 

destičky Fast 

Použijte destičku podle typu vašeho systému. 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 

 

Příprava 
destičky 

 
 
DŮLEŽITÉ!  Při manipulaci s destičkou pro kalibraci ROI používejte 
rukavice bez pudru. 
 
 
1.  Spusťte program SDS poklepáním na ikonu  na pracovní ploše. 

 

 
 
 

Poklepejte 
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Příprava destičky pro kalibraci ROI 
 
 
 

2.  Vyjměte spektrální kalibrační kit z mrazáku a 
vyjměte destičku pro kalibraci ROI. 

 
 

3.  Vraťte spektrální kalibrační kit do mrazáku. Spektrální kalibrační kit 

 
Destička pro  
kalibraci ROI  

 
 
 
 

4. Nechte destičku pro kalibraci ROI ohřát na 
pokojovou teplotu (přibližně 5 minut). 

 
 

DŮLEŽITÉ!  Nevyjímejte destičku pro kalibraci 
ROI z obalu dokud nejste připraveni ji spustit. 
Fluorescenční barva v jamkách destičky je 
fotosenzitivní. Je-li destička delší dobu vystavena 
světlu, může to vést k poklesu fluorescenčního 
signálu. 

 
 

5.  Vyjměte destičku pro kalibraci ROI z obalu. 
Optickou fólii ponechte na destičce. 

 

Obal destičky pro kalibraci ROI nevyhazujte. 
Pokud destičku uchováváte v jejím obalu, 
můžete jí použít až třikrát. 

 
6.  Pouze pro standardní destičky: Vortexujte 

destičku po dobu 5 vteřin. Destičky Fast 
nevortexujte. 

 

(Následující kroky se vztahují na standardní 
destičky i destičky Fast.) 

 
7.  Destičku pro kalibraci ROI krátce centrifugujte 

v centrifuze s adaptery na destičky (< 1500 x g). 
 

DŮLEŽITÉ!  Destičku je nutné dobře promíchat a 
centrifugovat. 

 
 
 
Pokojová 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
<1500×g 

 
 
 
> 00:05:00 
 
 
 
 
 

               4 
 

 
 
 

00:00:05 

 

4 
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G
R

24
75

 

 

H

 
 

A

Příprava destičky pro kalibraci ROI 
 
 
 

8.  Ověřte, že tekutina je v každé jamce na dně. 
Pokud není, centrifugujte destičku znovu při 
vyšších otáčkách a delší dobu. 

 
Správně Špatně 

 
 
 
 
 
 
Umístění destičky do přístroje 

 
1.  Stiskem otevřete zásuvku. 

 
 
 
 
 
 
 
 
 
 
 
 

2.  Umístěte destičku pro kalibraci ROI do zásuvky. 
Ujistěte se, že destička je v držáku umístěna 
správně. 

 

Standardní destičky 

 
Tekutina na 
dně jamky. 

 
•   Nedostatečné otáčky 

nebo 
•   Nedostatečná doba centrifugace 

(systém 7300/7500) 
se šikmým rohem 
v pozici A12 vpravo 
nahoře. 

 

 
 

Destičky Fast 
(systém 7500 Fast) 
se šikmým rohem 
v pozici A1 vlevo 
nahoře. 

12 

 
Šikmý 
roh 

 
Jamka A1 

 
 
 

1        2        3        4        5        6        7        8        9        10       11       12 

A B 

C D 

E F 

G 

 A1      1 

 
 
 
 
 
 
 
 

3.  Uzavřete zásuvku. Zatlačte na její pravé straně a 
pod úhlem. 

 

Pokračujte částí “Vytvoření dokumentu destičky pro 
kalibraci ROI” na straně 41. 

 
 
 
 
 
 

Zde zatlačte 
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Vytvoření dokumentu destičky pro kalibraci ROI 
 
 
 
Vytvoření dokumentu destičky pro kalibraci ROI 

 
1.  Vytvořte nový dokument: 

 
a.  V dialogovém okně Quick Startup (Rychlý 

start) zvolte Create New Document 
(Vytvořit nový dokument). 

 
 
 
 
 
 
 
 
 
 
 
 

b.  Pokud není okno Quick Startup (Rychlý 
start) otevřeno, klikněte na ikonku  nebo 
zvolte File > New (Soubor > Nový). 

 

 
 
Zvolte 

 
4 

 
 

2.  V průvodci vytvořením nového dokumentu 
(New Document wizard) klikněte na  , 
čímž potvrdíte přednastavené parametry. 

 
Poznámka:  Dokument destičky není nutné 
pojmenovat ani uložit. Program SDS ukládá 
data kalibrace ROI automaticky do kalibračních 
souborů na pevném disku. 

 
 
 
 

Zobrazí-li se chybová hláška Network error, 
klikněte . Kalibraci ROI můžete provést i 
při zobrazení této chybové hlášky. 

 
Klikněte 

 
Poznámka:  Tato hláška se zobrazuje, pokud váš 
počítač není připojen do sítě. Pokud nepředpok-
ládáte zapojení tohoto počítače do sítě, zvolte  
Do not show me this message again (Tuto 
zprávu znovu nezobrazovat), následně Never 
again on this machine (Nikdy znovu na tomto 
počítači). 

 

 
 
 
Klikněte 
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Vytvoření dokumentu destičky pro kalibraci ROI  

 

 
 
 

Zobrazí-li se vpravo uvedená chybová hláška, 
klikněte  a pokračujte s kalibrací ROI. 

 
 
 
 
 
 
 
 

Klikněte 

 
3.  V programu SDS zvolte Instrument > 

Calibrate (Přístroj > Kalibrace). 
 

 
 
 
 

Zvolte 
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Vytvoření dokumentu destičky pro kalibraci ROI 
 
 
 

4.  Kliknutím na  (Ano) potvrďte, že 
chcete, aby se blok na vzorky spustil dolů. 

 

Otevře se dialogové okno ROI Inspector. 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Okno ROI Inspector 

Klikněte 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4 

 
 
 
 

5.  V dialogovém okně ROI Inspector klikněte 
pravým tlačítkem myši do černé části okna a 
zvolte Display Properties (Možnosti 
zobrazení). 

 
Zvolte 
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Vytvoření dokumentu destičky pro kalibraci ROI 

 
 
 

6.  V okně Image Viewer Control Properties 
(Vlastnosti prohlížeče obrazu), nastavte 
parametr Saturation threshold (Práh nasycení): 

 

a.  Zvolte Show Saturation (Zobrazit nasycení). 
 

b.  V poli Sat. Threshold (Práh nasycení) 
zadejte 4000. a 

c.  Klikněte . b 
c 

 
 
 

7.  V okně ROI Inspector nastavte ovládání 
žárovky: 

 

a.  Klikněte . 

b.  V poli Lamp Control (Ovládání žárovky) 
zvolte Idle (Nečinný), tím nastavíte nižší  a  
napětí žárovky pro kalibraci ROI.  

b 

Pokračujte částí “Provedení kalibrace ROI” na 
straně 45. 
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Provedení kalibrace ROI 
 
 
 
Provedení kalibrace ROI  

 

 
1.  V dialogovém okně ROI Inspector: 

 

a.  Nastavte dobu expozice (Exposure Time) na a 

2048. 

b.  Zvolte Filter A (Filtr A). 
 
 
 
 

b 
 
 

2.  Klikněte  (Snímek) čímž 
vytvoříte obraz ROI. 

 
3.  Ověřte, zda je vámi vytvořený obraz ROI 

přijatelný (obrázky vpravo znázorňují obraz 
nenasycený a přesycený). V přijatelném obrazu 
ROI: 

•   Jamky musí být co nejjasnější ale bez 
přesycení. (Provádíte-li kalibraci ROI jak je 
popsáno na straně 46, zobrazí se v případě 
přesycení varovná hláška). 

•   Mohou ale nemusí obsahovat několik 
červených pixelů, což je známka 
nasycení. 

 
 
 
 
 
 
 

4 
 
 
 
 
Nenasycený obraz ROI  

 

 

Nenasycený Normální 
nasycení 

Přesycený 

 
 
 
 
 
 
 
 

Dobré  Přijatelné Špatné 
 

 
4.  Je-li vámi vytvořený obraz ROI přijatelný, 

pokračujte krokem 5. 
 

Je-li vámi vytvořený obraz ROI přesycený, snižte 
dobu expozice (Exposure Time) na polovinu a 
klikněte  (Snímek). Opakujte tento 
postup dokud nedostanete přijatelný obraz ROI. 

 

Pokud se vám nedaří dostat přijatelný obraz ROI, 
postupujte podle “Řešení problémů” na straně 49. 

 
 
Přesycený obraz ROI  
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Provedení kalibrace ROI 
 
 
 

5.  Klikněte  (Vytvořit kalibrační data). 
 

Program zpracuje snímek a zobrazí 
informativní hlášku nebo obraz ROI: 

 
Zobrazí-li program: Proveďte: 

 

a.  Klikněte . 

b.  Snižte dobu expozice (Exposure Time) (viz krok 1a) 
na polovinu. 

c.  Opakujte kroky 2 a 5. 
 
 
 

nebo  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Velmi slabý obraz ROI nebo se vám nedaří 
provést úspěšnou kalibraci. 

 

Přijatelný obraz 

 
Úspěšná kalibrace – všechny 
jamky mají zelené kroužky 

Viz “Řešení problémů” na straně 49. 
 
 
Ověřte, že : 
•   Bylo detekováno všech 96 jamek . 

 
 
 
 

Úspěšná kalibrace – 
96 detekovaných jamek 

 
 
 

Poznámka: Zelený kroužek označuje, že daná jamka 
(region of interest) je jasně detekovatelná. 

•   V obrazu ROI je okolo každé jamky zelený kroužek. 

 
6.  Klikněte  (Uložit kalibrační data). 

 

Program uloží vytvořenou kalibraci ROI pro 
filtr A. V části Masks Loaded dialogového okna 
ROI Inspector se vedle filtru A zobrazí “OK”. 

 
 
 
 
Klikněte 
 
 
 
Po uložení se 
zobrazí OK 
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a 

 

 

Provedení kalibrace ROI 
 
 
 

7.   Opakujte kroky 1 až 5 pro všechny zbývající 
filtry: Filtr B, Filtr C a Filtr D (a Filtr E pro 
přístroje 7500 a 7500 Fast). 

 

Před provedením kalibrace každého filtru 
nastavte dobu expozice (Exposure Time) 
na 2048. 

Kalibrace ROI je provedena pokud se v části 
Masks Loaded zobrazuje u všech filtrů OK. 

 
8.   Klikněte  (Konec), čímž okno ROI 

Inspector zavřete. 
 

9.   V programu SDS zvolte File > Close (Soubor > 
Zavřít). 
 

10.  Budete-li vyzváni k uložení dokumentu, 
klikněte  (Ne). 

 
 
 
 
Vyjmutí destičky z přístroje 

 
 
 
 
 
Kalibrace je provedena 
pokud se v části Masks 
Loaded zobrazuje 
u všech filtrů OK 
 

 
Klikněte 
 

 
 
 
 
 
 
 
 

Zvolte 

 
 

RIZIKO PORANĚNÍ. Je-li 
přístroj v provozu, může být blok na vzorky ohřátý 
až na 100 °C. Před provedením následujících kroků 
vyčkejte dostatečnou dobu, než se blok ochladí na 
pokojovou teplotu. 

 
 

1.  V dialogovém okně ROI Inspector klikněte 
 (Blok dolů). 

a 
 

. 

 
 
 
 

2.  Stiskem otevřete zásuvku. 
 

Poznámka: Pokud se vám nedaří zásuvku 
otevřít, je možné, že blok je v horní pozici a 
brání jejímu vysunutí. Klikněte na , 
čímž blok přesunete dolů. 

 
 
 
 
 
 
 

4 
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Provedení kalibrace ROI 

 
 
 

3.  Vyjměte destičku a zasuňte zásuvku zpět do 
přístroje. 

 
 
 
 
 
 
 
 
 
 

4.  Umístěte kalibrační destičku zpět do obalu. 
 

5.  Systém 7300: Vraťte kalibrační destičku do 
spektrálního kalibračního kitu do mrazáku. 

 

Systém 7500/7500 Fast: 

–  Budete-li provádět kalibraci pozadí a 
optickou kalibraci (viz následující kapitola) 
během následujících osmi hodin, ponechte 
destičku pro kalibraci ROI v obalu ale při 
pokojové teplotě. Při optické kalibraci, která 
se provádí po kalibraci pozadí, budete 
používat tuto destičku pro kalibraci ROI. 

–  Budete-li provádět kalibraci pozadí a 
optickou kalibraci následující den, uložte 
zabalenou destičku do spektrálního 
kalibračního kitu do mrazáku. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
-20 to -25 °C 

 
Poznámka:  Destičku pro kalibraci ROI 
nevyhazujte. Pokud destičku uchováváte v jejím 
obalu při –20 až –25 °C, můžete jí použít po 
otevření až třikrát. 

 
 
Pokračujte částí “Provedení kalibrace pozadí a 
optické kalibrace” na straně 51. 

 
 
 

DŮLEŽITÉ!  Po provedení kalibrace ROI musíte 
rovněž provést kalibraci pozadí (viz strana 51), 
optickou kalibraci (pouze systémy 7500, viz strana 
62) kalibraci barev (viz strana 71) a ověření 
funkčnosti přístroje (viz strana 91). 
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Řešení problémů 

 
 
 
Řešení problémů 

 
 
Řešení problémů – Obraz ROI  

 
Předpoklad: Velmi slabý obraz ROI nebo se vám 
nedaří provést úspěšnou kalibraci. 

 

Blok na vzorky by mohl být ve spodní pozici. 
 

•   Pokud je v nastavení CCD Control Settings v okně 
ROI Inspector ikona  (Blok nahoru), 
klikněte na tuto ikonu , abyste přesunuli 
blok do horní pozice. 

•   Ověřte, že vyhřívaný vnitřní kryt je vytažen úplně 
dopředu a nebrání zasunutí zásuvky. 

 
 
 
 
 
 
Klikněte 

 
Vyhřívaný 
vnitřní kryt 

 
 
 
 
 
 

GR2482 4 
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Řešení problémů 
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Kapitola 5 
 

Provedení 
kalibrace pozadí a optické  

kalibrace 
 

 
 
 
 

Před zahájením  
instalace 

 
 
 
 

Vybalení a 
příprava přístroje 

Příprava destičky pro 
kalibraci pozadí 

Viz strana 54 

 
 
 
 

Instalace  
softwaru a  
zapnutí přístroje 
 

 

Vytvoření dokumentu 
destičky pro kalibraci pozadí 

 

 
Viz strana 56 

 
 
 

Provedení 
kalibrace ROI 

  
Provedení kalibrace pozadí Viz strana 58 

 
 

5 
 

Provedení kalibrace 
pozadí a optické 
kalibrace 

 
 

Analýza výsledků 
kalibrace pozadí 

 
 
Viz strana 59 

 

 
 
 

Provedení kalibrace 
barev 

 

Provedení optické 
kalibrace pro systém 

7500/7500 Fast 

 
 

Viz strana 62 

 
 

Ověření funkčnosti  
přístroje 

Řešení problémů 
 
Viz strana 67 

 
 

Vypnutí systémů  
7300/7500/ 
7500 Fast 
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Přehled 
 
 
 
Přehled 

 
 

Poznámka:  Kroky uvedené v této kapitole můžete rovněž provést pomocí průvodce 
instalací (Real-Time System Setup wizard). Průvodce otevřete kliknutím na  > 
All Programs > Applied Biosystems 7300/7500/7500 Fast System > Real-Time 
System Setup Wizard. 

 
 

Potřebná doba •   Systém 7300: Kalibrace pozadí: 30 minut 

•   Systémy 7500: 

–  Kalibrace pozadí: 30 minut 

–  Optická kalibrace: 10 minut 
 

Potřebné 
pomůcky 

 
 
 
 
 
 

 
 

 
 

Applied Biosystems Real-Time 
PCR systém  

Spektrální kalibrační kit 

Destička pro 
kalibraci pozadí 

 

 
Rukavice bez 

pudru 
 

Ochranné 
brýle 

 
GR2170 

 
Centrifuga s adapterem 

na destičky 

 
Kdy provádět 

kalibraci pozadí 
Kalibraci pozadí proveďte: 
 

•   Při instalaci systému musíte provádět kalibrace v následujícím pořadí: 
 

a.  ROI 
 

b.  pozadí 
 

c.  optická (pouze systém 7500/7500 Fast) 
 

d.  barvy 
 

e.  ověření funkčnosti přístroje 

•   Každých 6 měsíců nebo podle potřeby, v závislosti na používání přístroje. 

•   Po výměně žárovky. 
 

 
DŮLEŽITÉ!  Pouze systém 7500/7500 Fast: Po provedení kalibrace pozadí musíte vždy 
provést optickou kalibraci. 
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 Přehled 
 
 
 

Účel kalibrace 
pozadí 

Kalibrace pozadí slouží ke změření úrovně fluorescence pozadí v přístroji. 
V průběhu kalibrace pozadí systém: 
 

•   Provádí po dobu 10 minut při 60°C kontinuální odečítání signálu z destičky 
pro kalibraci pozadí obsahující PCR pufr. 

•   Spočítá průměrnou hodnotu zaznamenaných spekter a na jejich základě generuje 
výsledný kalibrační soubor. 

 

Systém během následně prováděných běhů používá tento kalibrační soubor pro 
odečet fluorescence pozadí z naměřených hodnot. 

 

 
Fluorescence 

pozadí 
V rámci měření fluorescence Real-Time PCR systémy Applied Biosystems 7300/ 
7500/7500 Fast je zaznamenávána i fluorescence, která je systému vlastní a běžně se 
označuje jako fluorescence pozadí. Fluorescence pozadí je složený signál, který je 
detekován v celém spektru. Tento signál sestává z fluorescence, která pochází z různých 
zdrojů: 
 

•   Elektronický šum pozadí 

•   Kontaminace v bloku na vzorky 

•   Spotřební plast (destičky a víčka) 
 

 
Doporučení 
pro kalibraci 

Nový přístroj: 
 

•   Vždy použijte nový kalibrační kit. 

•   Ujistěte se, že centrifuga, kterou používáte, je čistá. Před centrifugací vytřete 
závěsy centrifugy pomocí papírového ručníku. 

•   Abyste zabránili kontaminaci, manipulujte s kalibračními destičkami opatrně. 

Nepokládejte je na laboratorní stůl, neboť by mohlo dojít ke kontaminaci. Vždy  5 
je uložte zpět do jejich původních obalů. 
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 Příprava destičky pro kalibraci pozadí 
 
 
 
Příprava destičky pro kalibraci pozadí 

 
 
DŮLEŽITÉ!  Při manipulaci s destičkou  
pro kalibraci pozadí používejte rukavice 
bez pudru. 

 

 

1.  Vyjměte spektrální kalibrační kit z mrazáku a 
vyjměte připravenou destičku pro kalibraci 
pozadí. 

 

Případně můžete destičku pro kalibraci 
pozadí vytvořit podle návodu v příloze B, 
“Vytvoření vlastní destičky pro kalibraci 
pozadí.” 

2.  Vraťte spektrální kalibrační kit do mrazáku. 

Spektrální kalibrační kit 
 
Destička pro kalibraci pozadí 

 
3.  Nechte destičku pro kalibraci pozadí ohřát na 

pokojovou teplotu (přibližně 5 minut). 
 

4.  Vyjměte destičku pro kalibraci pozadí 
z obalu. 

 
 
 
Pokojová 

 
 
 
> 00:05:00 

 
DŮLEŽITÉ!  Obal destičky pro kalibraci pozadí 
nevyhazujte. Destičku pro kalibraci pozadí 
můžete použít až třikrát pokud je uchovávána 
v originálním obalu. 

 
 
 
 
 
 
 
 
 

5.  Pouze pro standardní destičky: Vortexujte 
destičku po dobu 5 vteřin. Destičky Fast 
nevortexujte. 

 

(Následující kroky se vztahují na standardní 
destičky i destičky Fast.) 

 
6.  Destičku pro kalibraci pozadí krátce centrifugujte 

v centrifuze s adaptery na destičky (< 1500 x g). 
 

DŮLEŽITÉ!  Destičku je nutné dobře promíchat a 
centrifugovat. 

 
 
 
< 1500 × 
g 

 
 
 
00:00:05 
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 Příprava destičky pro kalibraci pozadí 
 
 
 

7.  Ověřte, že tekutina je v každé jamce na dně. 
Pokud není, centrifugujte destičku znovu při 
vyšších otáčkách a delší dobu. 

 
Správně Špatně 

 
DŮLEŽITÉ!  Zabraňte znečistění spodní strany 
destičky pro kalibraci pozadí. Tekutiny a další 
kontaminující látky, které přilnou ke spodní 
straně destičky, mohou kontaminovat blok na 
vzorky a způsobit abnormálně vysoký signál 
pozadí. 

 
 
Pokračujte částí “Vytvoření dokumentu destičky 
pro kalibraci pozadí” na straně 56. 

 

 
 
Tekutina na 
dně jamky. 

 

 
 
•   Nedostatečné otáčky 

nebo 

•   Nedostatečná doba centrifugace 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5 
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Vytvoření dokumentu destičky pro kalibraci pozadí 
 
 
 
Vytvoření dokumentu destičky pro kalibraci pozadí 

 
1.  Vytvořte nový dokument: 

 
a.  Je-li otevřeno dialogové okno Quick Startup 

(Rychlý start), zvolte Create New 
Document (Vytvořit nový dokument). 

 
 
 
 
 
 
 
 
 
 
 
 

2.  Není-li dialogové okno Quick Startup (Rychlý 
start) otevřeno, klikněte na ikonku  nebo zvolte 
File > New (Soubor > Nový). 

 
 
 
 
 
 
 

3.  Proveďte nastavení v dialogovém okně New 
Document (Nový dokument): 

 

a.  Zvolte Assay > Background (Esej > Pozadí). 
 

b.  Zvolte Container > 96-Well Clear (96-
jamková destička). 

 

c.  Zvolte Template > Blank Document (Templát 
> Prázdný dokument).  

 

d.  V poli Operator vyplňte své jméno. 
 

e.  V poli Comments zadejte další informace, které 
chcete uložit spolu se souborem (např. čárový 
kód destičky). 

 

f.   V poli Plate Name (Název destičky) zadejte: 
Pozadi_<datum ve formátu DDMMRR> 
Například název destičky analyzované 
31. května 2005 bude: 
Pozadi_310505. 

 

g.  Klikněte . 

 

 
 
Zvolte 
 

 
 
 
 
 
 
 
 
 

a 
b 
c 

 
d 

e 

 

f 
g 
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  Vytvoření dokumentu destičky pro kalibraci pozadí 
 
 
 
 
 

4.  V programu SDS zvolte File > Save As 
(Soubor > Uložit jako) čímž otevřete 
dialogové okno Save As (Uložit jako). Pokud 
se v poli Save in (Uložit do) nezobrazuje 
“SDS Documents”  (Dokumenty SDS), 
vyhledejte adresář D:/Applied Biosystems 
>SDS Documents a klikněte  (Uložit). 

 

Pokračujte částí “Provedení kalibrace pozadí” na 
straně 58. 

 
 
 
 
Zde by mělo být 
SDS Documents 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5 
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G
R

2
4
7
5

 

 
 

H

Provedení kalibrace pozadí 
 
 
 
Provedení kalibrace pozadí 

 

 
1. Umístěte destičku do přístroje podle návodu 

v části “Umístění destičky do přístroje” na 
straně 40. 

 

 

 
12 A 

B 

C D  

E F  

G 

 

 
1       2       3       4       5       6       7       8       9       10      11      12 

Poznámka:  Pokud se vám nedaří zásuvku 
otevřít, je možné, že blok je v horní pozici a 
brání jejímu vysunutí. Blok přesunete do dolní 
pozice zvolením Instrument > Calibrate 
(Přístroj > Kalibrace), poté zavřete okno ROI 
Inspector (Prohlížeč ROI). 

 
 
 
 

 
Standardní destička 
Systém 7300/7500  

 

Šikmý 
roh 

Jamka A1 

 
1 

A 

 
 
 

 
Destička Fast 
Systém 7500 Fast 

 
 

2.  V programu SDS spusťte běh: 
 

a. Zvolte záložku Instrument (Přístroj). 
 

b. Klikněte . 
a 

Přístroj zahájí kalibraci pozadí. 
 b 

 
Poznámka:  Spuštění běhu může předcházet 
pauza (až 10 minut) během níž dochází 
k ohřevu vyhřívaného vnitřního krytu na 
nastavenou teplotu. 

 
 
Pokračujte částí “Analýza výsledků kalibrace pozadí” 
na straně 59. 

A1 
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Analýza výsledků kalibrace pozadí 
 
 
 
Analýza výsledků kalibrace pozadí 

 
1.  Po ukončení běhu klikněte  . 

 
 
 

Klikněte 
 
 

2.  Klikněte na ikonu  nebo zvolte Analysis > 
Extract Background (Analýza > Extrakce 
pozadí) . 

 

Program provede extrakci signálu pozadí a 
následně zobrazí jednu z hlášek: 

 
 
 
 
Zvolte 

 
 
 
 
 
 

Zobrazí-li program: Proveďte: 
 

Background Extraction Complete (Kalibrace pozadí 
ukončena)– Analýza byla úspěšná. 

 

Klikněte  a pokračujte krokem 4. 

 
 
 

 
Klikněte 

5 
Image exposure is too low… (Expozice obrazu příliš 
nízká…) – Program zastavil proces extrakce, protože 
naměřená spektra jsou pod detekčním prahem 
kalibrace. 

 
a. Klikněte . 

b.  Ověřte, že v přístroji je umístěna destička pro 
kalibraci pozadí. 

c.  Proveďte test žárovky. Viz “Sledování stavu 
žárovky” na straně 121. 

d.  Proveďte znovu běh pro kalibraci pozadí s toutéž 
destičkou. 

e.  Pokud program znovu hlásí, že expozice obrazu 
je příliš nízká, klikněte  a pokračujte 
krokem 4. 

 
 
 
 
 

Image exposure is too high… (Expozice obrazu 
příliš vysoká…) – Běh je neúspěšný. Program zastavil 
proces extrakce, protože naměřená spektra přesahují 
maximální limit pro systém 7300/7500/7500 Fast . 

Klikněte  a postupujte podle “Řešení problémů” 
na straně 67. 
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Analýza výsledků kalibrace pozadí 
 
 
 

4.  V dokumentu destičky zvolte záložku Results 
(Výsledky) a zvolte záložku Spectra (Spektra). 

 
 

a 
 

b 
 
 
 
 
 

5.  V dokumentu destičky zvolte všechny jamky. 
 
 
 
 
 
 
 
 
 
 
 
 

6.  Prostudujte zobrazená data – hledejte 
neregulérní spektrální píky, které přesahují 
následující hodnoty fluorescence (FSU): 

 
Filtr FSU 

A, B, C, D (7300/7500) >72,000 

E (7500) >90,000 
 

Pokud spektrum jedné nebo více jamek 
přesahuje udanou hodnotu FSU, destička pro 
kalibraci pozadí nebo blok na vzorky mohou 
obsahovat fluoreskující kontaminaci. Určete 
zdroj kontaminace. Viz “Řešení problémů” na 
straně 67. 

 
7.  Zvolte File > Close (Soubor > Zavřít). 

 
Kliknutím 
zvolte všechny 
jamky 

 
 
 
 
 
 
 
 
 
 
 
 
 
Možná 
kontaminace 
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 Analýza výsledků kalibrace pozadí 
 
 
 

Vyjmutí destičky 
z přístroje  

RIZIKO PORANĚNÍ. Je-li přístroj v provozu, může být blok na 
vzorky ohřátý až na 100 °C. Před provedením následujících kroků vyčkejte dostatečnou 
dobu, než se blok ochladí na pokojovou teplotu. 
 
 
1.  Po ukončení běhu vyjměte destičku pro kalibraci pozadí: 

 

a.  Stisknutím otevřete zásuvku. 
 

b.  Vyjměte destičku pro kalibraci pozadí. 
 

c.  Tlakem zavřete zásuvku. 
 

2. Umístěte destičku pro 
kalibraci pozadí zpět do 
obalu, a pak vraťte 
spektrální kalibrační kit 
do mrazáku. 

 
 
 
-20 to -25 °C 

 

 
 
 
 
 
 

DŮLEŽITÉ!  Destičku pro kalibraci pozadí nevyhazujte. Destičku pro kalibraci 
pozadí můžete použít až třikrát pokud je uchovávána v originálním obalu. 

 
 
 

Pokračujte částí: 
 

•   Systém 7300–  “Provedení kalibrace barev” na straně 71. 5 
•   Systém 7500/7500 Fast–  “Provedení optické kalibrace systému  

7500/7500 Fast” na straně 62. 
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 Provedení optické kalibrace systému 7500/7500 Fast 
 
 
 
Provedení optické kalibrace systému 7500/7500 Fast 
 

 

 
Potřebná doba 10 minut 

 

 
Potřebné 
pomůcky 

Kalibrační destička ROI  

 

 
Účel optické 

kalibrace sys-
tému 7500/ 
7500 Fast 

Optická kalibrace slouží ke kompenzaci vlivu dodatečného filtru v systémech 7500/7500 
Fast (tento filtr není v systému 7300). 

 

 
Kdy provádět 

optickou 
kalibraci 

Proveďte optickou kalibraci: 
 

•   Při instalaci systému musíte provést všechny kalibrace v tomto pořadí: ROI > 
Pozadí > Optická (pouze systém 7500/7500 Fast) > Barvy > Ověření funkčnosti 
přístroje. 

•   Po každé kalibraci pozadí systému 7500/7500 Fast. 
 
 
Příprava destičky pro kalibraci ROI 

 
Pokud jste po provedení kalibrace ROI ponechali destičku pro kalibraci ROI při pokojové 
teplotě (viz Kapitola 4, “Provedení kalibrace ROI (Regions of Interest)”), pokračujte 
krokem 6 níže – stočte veškeré kondenzáty, které se mohly vytvořit během doby, po 
kterou byla destička při pokojové teplotě. 

 
 

DŮLEŽITÉ!  Při manipulaci s destičkou pro kalibraci ROI používejte 
rukavice bez pudru. 

 
 

1. Vyjměte spektrální kalibrační 
kit z mrazáku a vyjměte 
destičku pro kalibraci ROI. 

 
2. Vraťte spektrální kalibrační kit 

do mrazáku. 

 
 
 
 
Spektrální kalibrační kit 
 
Destička pro 
kalibraci ROI  
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 Provedení optické kalibrace systému 7500/7500 Fast 
 
 
 

3.  Nechte destičku pro kalibraci ROI ohřát na 
pokojovou teplotu (přibližně 5 minut). 

 
DŮLEŽITÉ!  Nevyjímejte destičku pro kalibraci 
ROI z obalu dokud nejste připraveni ji spustit. 
Fluorescenční barva v jamkách destičky je 
fotosenzitivní. Je-li destička delší dobu vystavena 
světlu, může to vést k poklesu fluorescenčního 
signálu. 

 
 

4.  Vyjměte destičku pro kalibraci ROI z obalu. 

 
 
 
Pokojová 

 
 
 
> 00:05:00 

 
 

DŮLEŽITÉ!  Obal destičky pro kalibraci ROI 
nevyhazujte. Pokud destičku uchováváte 
v jejím obalu, můžete jí použít až třikrát. 

 
 

5.  Pouze pro standardní destičky: Vortexujte 
destičku po dobu 5 vteřin. Destičky Fast 
nevortexujte. 

 

(Následující kroky se vztahují na standardní 
destičky i destičky Fast.) 

 
6.  Destičku pro kalibraci ROI krátce centrifugujte 

v centrifuze s adaptery na destičky (< 1500 x g). 

 
 

< 1500 × g 

 
 

00:00:05 5 
 
 
 
 
 
 
 
 
 

7.  Ověřte, že tekutina je v každé jamce na dně. 
Pokud není, centrifugujte destičku znovu při 
vyšších otáčkách a delší dobu. 

Správně Špatně 

 
 
 

Tekutina na 
dně jamky. 

• Nedostatečné otáčky 
nebo 

• Nedostatečná doba centrifugace 
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Provedení optické kalibrace systému 7500/7500 Fast 
 
 
 

8.  Umístěte destičku do přístroje podle návodu 
v části “Umístění destičky do přístroje” na 
straně 40. 

 

 

 
12 A 

B 

C D  

E F  

G 

      4       5       6       7       8       9       10      11      12 

DŮLEŽITÉ!  Při manipulaci s destičkou 
pro kalibraci ROI používejte rukavice 
bez pudru. 

 
 
 

Standardní destička  
Systém 7300/7500 

 
  Jamka A1  
 
 

 
1 

A 

 
 

Destička Fast  
Systém 7500 Fast 

 
Vytvoření dokumentu destičky pro optickou kalibraci 

 
9.  Vytvořte nový dokument: 

 
a.  Je-li otevřeno dialogové okno Quick Startup 

(Rychlý start), zvolte Create New 
Document (Vytvořit nový dokument). 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

10. Není-li dialogové okno Quick Startup (Rychlý start) 
otevřeno, klikněte na ikonku  nebo zvolte File > 
New (Soubor > Nový). 

 
 
 
 
 
11. Proveďte nastavení v dialogovém okně New 

Document (Nový dokument): 
 

a.  Zvolte Assay > Calibration (Esej > Kalibrace). 
 

b.  Zvolte Container > 96-Well Clear (96-jamková 
destička). 

 

c.  Zvolte Template > Blank Document (Templát 
> Prázdný dokument). 

 

d.  V poli Operator vyplňte své jméno. 
 

e. V poli Comments zadejte další informace, které 
chcete uložit spolu se souborem (např. čárový 
kód destičky). 

 

 
 
Zvolte 
 

 
 
 
 
 
 
 
 

a 
b 
c 
 
d 
 
e 

 

f 

g 

Šikmý roh 
A1 



Kapitola 5  Provedení kalibrace pozadí a optické kalibrace  

Poznámky  
  
   
Instalace a údržba – Uživatelská příručka pro Real-Time PCR systémy Applied Biosystems 7300/7500/7500 Fast  65 

 

 

 Provedení optické kalibrace systému 7500/7500 Fast 
 

 
 
 

f.   V poli Plate Name (Název destičky) zadejte: 
Kalibrace_<datum ve formátu DDMMRR> 
Například název destičky analyzované 
31. května 2005 bude: Kalibrace_310505. 

 

g.  Klikněte  (Konec). 
 
12. V programu SDS zvolte File > Save As (Soubor > 

Uložit jako). 
 
 
 
 
 

Zvolte 
 
 
13. V dialogovém okně Save As (Uložit jako): 

 

a.  Pokud se v poli Save in (Uložit do) 
nezobrazuje “SDS Documents”  
(Dokumenty SDS), vyhledejte adresář 
D:/Applied Biosystems >SDS Documents. 

 

b.  Klikněte . 
 

Pokračujte částí “Provedení optické kalibrace” 
na straně 65. 

 
 

Provedení optické kalibrace 
 

1.  Spusťte kalibraci v programu SDS: 
 

a.  Zvolte záložku Instrument (Přístroj). 
 

b.  Klikněte . 

Přístroj zahájí kalibraci. 
 

Poznámka:  Spuštění běhu může předcházet 
pauza (až 10 minut) během níž dochází k ohřevu 
vyhřívaného vnitřního krytu na nastavenou 
teplotu. 

 
 

2.  Po ukončení běhu klikněte  . 

 
 
 
 

 
Zde by mělo být 
SDS Documents  

 
 
 
 
 

 
 

 5 
 
 
 
a 

b 

 
 
 

Klikněte 
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Provedení optické kalibrace systému 7500/7500 Fast 
 
 
 
Analýza výsledků optické kalibrace 

 
1. V SDS programu klikněte na ikonu  nebo zvolte Analysis > Extract (Analýza > 

Extrakce). 

 Program provede extrakci výsledků optické kalibrace a zobrazí hlášku o ukončení 
extrakce. 

 
2.  Klikněte  . 

 
3.  V programu SDS zvolte File > Close (Soubor > Zavřít). 

 

 
Vyjmutí destičky 

z přístroje 
RIZIKO PORANĚNÍ. Je-li přístroj v provozu, může být blok na 

vzorky ohřátý až na 100 °C. Před provedením následujících kroků vyčkejte dostatečnou 
dobu, než se blok ochladí na pokojovou teplotu. 
 
 
1.  Po ukončení běhu vyjměte destičku pro kalibraci ROI: 

 

a.  Stisknutím otevřete zásuvku. 
 

b.  Vyjměte destičku pro kalibraci ROI. 
 

c.  Tlakem zavřete zásuvku. 
 

2. Umístěte destičku pro 
kalibraci ROI zpět do 
obalu, a pak vraťte 
spektrální kalibrační kit 
do mrazáku. 

 
 
 
-20 to -25 °C 

 

 
 
 
 
 
 

DŮLEŽITÉ!  Destičku pro kalibraci ROI nevyhazujte. Destičku pro kalibraci ROI 
můžete použít až třikrát pokud je uchovávána v originálním obalu. 

 
 

Pokračujte částí “Provedení kalibrace barev” na straně 71. 



Kapitola 5  Provedení kalibrace pozadí a optické kalibrace  

Poznámky  
  
   
Instalace a údržba – Uživatelská příručka pro Real-Time PCR systémy Applied Biosystems 7300/7500/7500 Fast  67 

 

 

 Řešení problémů 
 
 
 
Řešení problémů 

 
 
Řešení problémů – Kalibrace pozadí 

 
Předpoklad: Nelze extrahovat data (neúspěšná kalibrace pozadí) 

 
Signály přesahující hodnotu 72,000 standardních fluorescenčních jednotek (fluorescent standard units - FSU) přesahují 
limit normální fluorescence pozadí přístrojů 7300/7500/7500 Fast. Takové signály mohou být známkou toho, že buď 
v pozadí nebo v bloku na vzorky jsou fluoreskující kontaminace. Mezi běžné kontaminace patří: zbytky po nápisech fixem, 
pudr z jednorázových rukavic a prach. 

 
Je zapotřebí zjistit zdroj kontaminace: 

 
1.  V dokumentu destičky pro kalibraci: 

a. Zvolte záložku Results  (Výsledky) 

b. Zvolte záložku Spectra (Spektra). 
 
 
 
 
 
 
 

2.  V dokumentu destičky zvolte všechny jamky. 

 
 
a 

b 

 
 
 
 
Kliknutím 
zvolte všechny 
jamky 

 
 
 
 

5 
 
 
 

3. Prostudujte zobrazená data – hledejte neregulérní spektrální 
pík nebo píky. 

Pokud spektrum jamky přesahuje hodnotu 72,000 FSU, je 
taková jamka považována za neregulérní a je možné, že je 
kontaminována. 

 
 
 
 
Možná 
kontaminace 
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Řešení problémů 
 
 
 
 
Řešení problémů – Kalibrace pozadí 

 
4.  Vyhledejte jamku (jamky), které obsahují kontaminaci tak, že 

v dokumentu destičky postupně označujete méně jamek. 

V následujícím příkladu je vysvětleno, jak vyhledat 
kontaminovanou jamku. 

a.  V záložce Spectra (Spektra) zvolte sloupce 1-6. Mezi spektry 
takto vybraných jamek se nenachází neregulérní pík. 
Kontaminovaná jamka tedy musí být ve sloupcích 7-12. 

 
 
 
 
 
 
 
 

b.  Zvolte sloupce 7-9. Mezi spektry takto vybraných jamek se 
nachází neregulérní pík. Kontaminovaná jamka tedy musí 
být ve sloupcích 7-9. 

 

 
 
 
 
 
 
 
 
 

c.  Zvolte jamky v řádku E a níže ve sloupcích 7-9. Mezi 
spektry takto vybraných jamek se nenachází neregulérní 
pík. Kontaminovaná jamka tedy musí být v prvních čtyřech 
jamkách sloupců 7-9. 

 
 
 
 
 
 
 
 

d.  Zvolte postupně každou z jamek v prvních čtyřech řádcích 
sloupců 7-9. Tímto způsobem najdete kontaminovanou 
jamku (B9). 

5.  Opakujte krok 4 dokud se vám nepodaří nalézt všechny 
kontaminované jamky. 

 
 
 
 
 
Kontaminovaná 
jamka není 
zobrazena 
 
 
 
 
 
 
 
 
 
 
 
 

Kontaminovaná 
jamka 

 
 
 
 
 
 
 
 
 
 

Kontaminovaná 
jamka není 
zobrazena 

 
 
 
 
 
 
 
 
 
 

Kontaminovaná 
jamka 

 
 
 

Kontaminovaná 
jamka 
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 Řešení problémů 
 
 
 
 
Řešení problémů – Kalibrace pozadí 

 
6.  Vytvořte novou destičku pro kalibraci pozadí (viz Příloha B,  

“Vytvoření vlastní destičky pro kalibraci pozadí” na straně 129.) 
 

7.  Proveďte kalibraci pozadí (viz “Provedení kalibrace 
pozadí” na straně 58). 

8.  Klikněte na ikonu   nebo zvolte Analysis > Extract 
Background (Analýza > Extrakce pozadí). 

9.  Opakujte krok 4 ze strany 68 – tím zjistíte, které jamky jsou 
kontaminované. 

Kontaminované jamky v nové destičce pro kalibraci pozadí: 

–   jsou v týchž pozicích jako jste zaznamenali v kroku 4: je 
kontaminován blok na vzorky. Proveďte dekontaminaci bloku 
na vzorky (viz “Dekontaminace bloku na vzorky” na straně 
112). 

–   nejsou: byla kontaminována původní destička. Prohlédněte 
tuto původní destičku. Ujistěte se, že na její spodní straně nebo 
svrchu nejsou žádné částice. 

10.  Pokud se po použití nové destičky pro kalibraci pozadí nebo 
dekontaminaci bloku na vzorky kalibrace nezdaří, proveďte 
následující test: 

a.  Stisknutím otevřete zásuvku. 

b.  Vložte černou destičku z instalační soupravy (nebo 
destičku obsahující kus černého papíru) do držáku. 

c.  Tlakem zavřete zásuvku. 
 

11.  Proveďte kalibraci pozadí (viz “Provedení kalibrace pozadí” na 
straně 58). 

a. Klikněte na ikonu   nebo zvolte Analysis > Extract 
Background (Analýza > Extrakce pozadí).  

b. Zvolte záložku Results (Výsledky), pak zvolte záložku  
Spectra (Spektra). 

c. Zvolte všechny jamky v dokumentu destičky. 
 

12.  Vyhledejte píky v zobrazení spekter. Je-li kontaminovaná 
jamka: 

–   přítomna, optický systém vašeho přístroje 7300/7500/7500 
Fast může být kontaminován. Kontaktujte technickou podporu 
Applied Biosystems nebo vašeho servisního technika. 

–   nepřítomna, je kontaminován blok na vzorky. Proveďte 
dekontaminaci bloku na vzorky (viz “Dekontaminace bloku 
na vzorky” na straně 112). 

 
 
 
 
 
 
 

Černé 
stínítko 

5 
 
 
 
 
 
 
 
Kontaminovaná  
jamka 
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Kapitola 6 
 
 
 
 
 

Provedení kalibrace barev 
 
 
 
 
 
 
 
 

Před zahájením 
instalace 

 
 
 
 

Vybalení a  
příprava přístroje 

Příprava kalibrace Viz strana 75 

 

 
 
 

 

Instalace  
softwaru a  
zapnutí přístroje 

 
     Vytvoření dokumentu 
destičky pro kalibraci barev 

 

 

Viz strana 76 
 

 
 
 

Provedení  
kalibrace ROI 

 
 
 
 

 
Provedení kalibrace 
pozadí a optické 
kalibrace 

Příprava destiček a 
provedení kalibrace barev 

 

Viz strana 77 

 
 
 
 

 
Provedení 
kalibrace barev 

 
Analýza výsledků 
kalibrace barev 

6 

 Viz strana 81 

 
 
 
 

 
Ověření funkčnosti 
přístroje 

 
 
 

Vyhodnocení 
kalibračních spekter 

 

 
 
 
Viz strana 84 

 
Vypnutí systémů  
7300/7500/ 
7500 Fast 
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Přehled 

 
 

Poznámka:  Kroky uvedené v této kapitole můžete rovněž provést pomocí průvodce 
instalací (Real-Time System Setup wizard). Průvodce otevřete kliknutím na  > 
All Programs > Applied Biosystems 7300/7500/7500 Fast System > Real-Time 
System Setup Wizard. 

 
 

Potřebná doba •   Systém 7300: 45 minut 

•   Systém 7500/7500 Fast: 1 hodina 
 

Potřebné 
pomůcky 

 
 

 
Applied Biosystems 

Real-Time PCR Systém 
Spektrální kalibrační kit 

 
 

Systém 7300/ 
7500/7500 Fast 

 
 

 
 

Destičky pro kalibraci 
barev (barvy FAM™, 
JOE™, NED™, ROX™, 
SYBR® Green, TAMRA™ 
a VIC®) 

 
 

Pouze systém 
7500/7500 Fast 

 
 
 
 
 
 
 
 
 
 
 

Destičky pro 
kalibraci barev 

(barvy CY3, CY5 
a TEXAS RED®) 

 
 
 
 
 
Ochranné 

brýle 
 

 
 
 
 
 
 
 
 
 

Rukavice bez 
pudru 

 
 
 
 
 
 
 
 
 
 
 

GR2170 

 
Centrifuga s adapterem 

na destičky 

 
 
 

Kdy provádět 
kalibraci barev 

Kalibraci barev proveďte: 
 

•   Při instalaci systému musíte provádět kalibrace v následujícím pořadí: 
 

a.  ROI 
 

b.  pozadí 
 

c.  optická (pouze systém 7500/7500 Fast) 
 

d.  barvy 
 

e.  ověření funkčnosti přístroje 

•   Každých 6 měsíců v závislosti na používání přístroje. 
 

 
DŮLEŽITÉ!  Před kalibrací barev musíte provést kalibraci pozadí. Na odečítání spekter 
jednotlivých barev má vliv stáří a používání přístroje. Společnost Applied Biosystems 
proto doporučuje provádět kalibraci barev nejméně jedenkrát za šest měsíců. 
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Účel kalibrace 
barev 

V rámci kalibrace barev systém: 
 

•   odečte spektra sérií standardů jednotlivých barev. 

•   uloží informace o spektrech jednotlivých barev v příslušném kalibračním souboru 
pro danou barvu v adresáři SDS. 

 

Při následně prováděných bězích pak program tato kalibrační data používá pro určení 
jednotlivých barev a jejich příspěvků do přístrojem celkově naměřené fluorescence 
v rámci běhu. 
 

Po ukončení běhu je každé snímání provedené v jeho průběhu uloženo v programu SDS 
ve formě nezpracovaných spektrálních dat. Příspěvek emise jedné každé fluorescenční 
barvy je v daném vzorku stanoven porovnáním nezpracovaných spektrálních dat a 
spektrálních dat této barvy uložených v kalibračním souboru. Ukládáte-li po ukončení 
analýzy dokument destičky, program uloží kalibrační soubor i fluorescenční data 
naměřená v průběhu daného experimentu. 

 

 
Soubory barev Real-Time PCR systémy společnosti Applied Biosystems používají pro kalibraci následující 

soubory barev: 
 

•   Systém 7300– FAM™, JOE™, NED™, ROX™, TAMRA™, VIC® a SYBR® 

Green I (váže dsDNA), předplněné v 96-jamkových destičkách pro kalibraci barev. 

•   Systémy 7500 a 7500 Fast – Všechny výše zmíněné barvy a CY3, CY5 a 
TEXAS RED® (ve výbavě je dodatečný filtr). 

 

Následující obrázek ukazuje emisní spektrum pro každou barvu a současně i filtry a 
vlnové délky, při nichž je daná barva snímána. 

 

 
 

  Systém 7500/7500 Fast  

Systém Systém 7300  
 

  Filtry 
Spektrum 

(nm) 

 
 
500 

A B C D E 
 

600 

 
 
700 

 

 
6 

 
    Emisní 

spektra 
 

 
 
 
 
 
 
 

        Barvy ~ 520 nm ~ 550 nm ~ 580 nm ~ 610 nm ~ 670 nm 
 

FAM 
SYBR Green 

 
JOE 
VIC 

 
TAMRA 
NED 
CY3 

 
ROX 
TEXAS RED 

 
CY5 
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Jiné barvy Přístroje 7300/7500/7500 Fast podporují používání jiných barev (než těch dodávaných 
společností Applied Biosystems). 

 

Fluorescence těchto barev musí spadat do spektrálního rozsahu, který jsou tyto přístroje 
schopny měřit: 

 

•   500 až 650 nm pro sytém 7300 

•   500 až 700 nm pro systémy 7500/7500 Fast 
 

Chcete-li na vašem přístroji použít jinou barvu, postupujte podle části “Vytvoření vlastní 
destičky pro kalibraci barvy” na straně 131. 
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Příprava kalibrace 

 

 
 
DŮLEŽITÉ!  Před provedením kalibrace barev musíte 
provést kalibraci ROI (viz strana 35), kalibraci 
pozadí (viz strana 51) a optickou kalibraci (pouze 
systémy 7500, viz strana 62). 

 
 
 
DŮLEŽITÉ!  Při manipulaci s destičkami pro  
kalibraci barev používejte rukavice 
bez pudru. 

 
 

1.  Vyjměte spektrální kalibrační kit z mrazáku a 
vyjměte z něj všechny destičky pro kalibraci 
barev. 

 
2.  Vraťte spektrální kalibrační kit do mrazáku. Spektrální kalibrační kit 

 
Destička pro kalibraci  
barvy FAM 

 
 
 
 
 

3.  Nechte destičky pro kalibraci barev ohřát na 
pokojovou teplotu (přibližně 5 minut). 

 
DŮLEŽITÉ!  Nevyjímejte destičku pro kalibraci 
barvy z obalu dokud nejste připraveni ji spustit. 
Fluorescenční barva v jamkách destičky je 
fotosenzitivní. Je-li destička delší dobu vystavena 
světlu, může to vést k poklesu fluorescenčního 
signálu. 

 
 
Pokračujte částí “Vytvoření dokumentu destičky pro 
kalibraci barev” na straně 76. 

 
 
 
Pokojová 

 
 
 
> 00:05:00 
 
 
 
 
 
 

6 

 



Kapitola 6 – Provedení kalibrace barev 
Vytvoření dokumentu destičky pro kalibraci barev  

Poznámky  
  
   
76 Instalace a údržba – Uživatelská příručka pro Real-Time PCR systémy Applied Biosystems 7300/7500/7500 Fast 

 

 
 
 
 
Vytvoření dokumentu destičky pro kalibraci barev 

 
1.  Vytvořte nový dokument 

 
a.  Je-li otevřeno dialogové okno Quick Startup 

(Rychlý start), zvolte Create New 
Document (Vytvořit nový dokument). 

 
 
 
 
 
 
 
 
 
 
 
 

2.  Není-li dialogové okno Quick Startup (Rychlý 
start) otevřeno, klikněte na ikonku  nebo zvolte 
File > New (Soubor > Nový). 

 
 
 
 
 
 
 

3.  Proveďte nastavení v dialogovém okně New 
Document (Nový dokument): 

 

a.  Zvolte Assay >  Pure Spectra (Čistá spektra). 
 

b.  Zvolte Container > 96-Well Clear (96-jamková 
destička). 

 

c.  Zvolte Template > Blank Document (Templát > 
Prázdný dokument). 

 

d.  V poli Operator vyplňte své jméno. 
 

e.  V poli Comments zadejte další informace, které 
chcete uložit spolu se souborem (např. čárový 
kód destičky). 

 

f.   Klikněte  (Konec). 
 

Poznámka:  Pojmenovat či uložit 
dokument destičky pro kalibraci barev 
není nutné. Program SDS ukládá 
spektrální data jednotlivých barev 
automaticky na pevném disku počítače. 

 

 
 
Zvolte 
 
 
 
 
 
 
 
 
 
 
 
 

a 
 

b 

c 

 
 
d 

e 

 
f 
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Zobrazí se okno Pure Spectra Calibration 
Manager (Správce kalibrace čistých spekter). 

 

Pokračujte částí “Příprava destiček a provedení 
kalibrace barev” na straně 77. 

 
Obrázek 1 Příprava destiček a provedení kalibrace barev 

 
Volba barvy 

 
1.  V okně Pure Spectra Calibration Manager: 

 

a.  V poli Dye List (Seznam barev) zvolte, 
kterou barvu chcete kalibrovat. 

b.  Klikněte  (Kalibrovat). 
 
 

a b 
 

c.  Jste-li vyzváni k ukončení práce v aktivním 
dokumentu, klikněte  (Ano). 

 
Klikněte 

 
 
 
 

Poznámka:  Objeví se hláška vyzývající vás 
k vložení destičky. V tuto chvíli neklikejte 
ani Yes (Ano) ani No (Ne). 

 
 
 
 
 
 
Příprava a vložení destičky pro kalibraci barvy 

 
1.  Vyjměte destičku pro kalibraci barvy z obalu. 

  
 6 

DŮLEŽITÉ!  Obal destičky pro kalibraci barvy 
nevyhazujte. Pokud destičku uchováváte v jejím 
obalu, můžete jí použít až třikrát. 

 
 

2.  Pouze pro standardní destičky: Vortexujte 
destičku po dobu 5 vteřin. Destičky Fast 
nevortexujte. 

 

(Následující kroky se vztahují na standardní 
destičky i destičky Fast.) 
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G
R

2
4
7
5

 

 
 

H

 

 
 
 
 

 3.  Destičku pro kalibraci barvy krátce centrifugujte 
v centrifuze s adaptery na destičky (< 1500 x g). 

 
 
 
< 1500 × g 

 
 
 
00:00:05 

 
 
 
 
 
 
 
 

4.  Ověřte, že barevný standard je v každé jamce na 
dně. 

 

Pokud není, centrifugujte destičku znovu při 
vyšších otáčkách a delší dobu. 

 
Správně Špatně 

 

 
 

Tekutina na 
dně jamky. 

• Nedostatečné otáčky 
nebo 

• Nedostatečná doba centrifugace 
 

 
5.  Ověřte, že destička pro kalibraci barvy, kterou 

se chystáte použít, odpovídá barvě zvolené 
v okně Pure Spectra Calibration Manager. 

 
 
 
 
Označení barvy 

 
 
 
 
 
 
 
 

6.  Umístěte destičku do přístroje podle návodu 
v části “Umístění destičky do přístroje” na 
straně 40. 

 

 

 
12 A 

B 

C D  

E F  

G 

 

Poznámka:  Zavíráte-
li zásuvku, zatlačte na 
její pravé straně a pod 
úhlem. 

 
 
 
 
 
 
Zde 
tlačit 

 
 
 
 
 Systém 7300/7500  
Standardní destička 

Šikmý roh 
 
Jamka A1 

 
1 

A 

 
 
 

Systém 7500 Fast  
Destička Fast 

 
 
Provedení kalibrace barev 

 

V hlášce vyzývající vás ke vložení destičky (viz 
krok 1c na straně 77) klikněte  (Ano) a 
vyčkejte na dokončení běhu (~5 minut). 

 

 
 
 
 
> 00:05:00 

 
 

Klikněte 

A1 
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Během provádění kalibrace barvy je ovládání správce 
Pure Spectra Calibration Manager znemožněno. 

 

 
 Vyjmutí destičky z přístroje 

 
RIZIKO PORANĚNÍ. a b 

Je-li přístroj v provozu, může být blok na vzorky 
ohřátý až na 100 °C. Před provedením následujících 
kroků vyčkejte dostatečnou dobu než se blok ochladí 
na pokojovou teplotu. 

 
 

1.  Po ukončení běhu: 
 

a. Stiskem otevřete zásuvku. 
b. Vyjměte destičku pro kalibraci barvy ze zásuvky. 
c. Zasuňte zásuvku zpět do přístroje. c d 

d. Umístěte destičku pro kalibraci barvy zpět do 
obalu a vraťte kalibrační destičku do 
spektrálního kalibračního kitu do mrazáku. 

 
Poznámka:  Destičku pro kalibraci barvy 
nevyhazujte. Pokud destičku uchováváte 
v jejím obalu při –20 až –25 °C, můžete ji 
použít po otevření až třikrát. 

 
 
 
Kalibrace ostatních barev 

 
1.  Klikněte  (Další barva). 

 
2.  Opakujte kroky v části “Příprava a vložení destičky 

pro kalibraci barvy” na straně 77 až “Kalibrace 
ostatních barev” na straně 79 – tím provedete 
kalibraci ostatních barev (JOE, NED, ROX, SYBR 
Green, TAMRA, VIC). 

 
 
 

6 
 
Klikněte 

 
Poznámka:  Používáte-li přístroj 7500 nebo 7500 
Fast, proveďte též kalibraci barev CY3, CY5 a 
TEXAS RED. 
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3. Po provedení kalibrace všech barev ve vašem 
spektrálním kalibračním kitu klikněte  
(Konec). 

 

 
 
 
 
 
 

Pokračujte částí “Analýza výsledků kalibrace 
barev” na straně 81. 

 
 
 
 
 
 
 
 
Klikněte 
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Analýza výsledků kalibrace barev 

 
 
Při spuštění běhu s destičkou pro kalibraci barvy 
program SDS automaticky vytvoří a uloží dokument 
této destičky. Po ukončení kalibračních běhů pro 
každou barvu zůstávají dokumenty pro danou destičku 
otevřeny na pozadí dokumentu programem aktuálně 
zobrazovaného. Pro ukončení kalibrace je nutné 
analyzovat všechny otevřené dokumenty destiček pro 
kalibraci barev následujícím způsobem. 

 

 
1. Z nabídky Windows (Okna) zvolte 

dokument destičky, který chcete analyzovat. 
 

2. Zvolte záložku Results (Výsledky), následně 
zvolte záložku Spectra (Spektra). 

 
 
 
 

3.  Klikněte do levého horního rohu vyobrazení 
destičky, tím zvolíte všechny jamky v dokumentu 
destičky. 

 
 
 
 
 
 
 
 

4.  Klikněte na ikonu  nebo zvolte Analysis > 
Extract Pure Spectra (Analýza > Extrakce 
čistých spekter). 

 

Program SDS provede extrakci a zobrazí hlášku 
(viz další strana). 

 
Program SDS vytvoří 
dokument destičky pro 
každou kalibrovanou barvu 
(na pozadí otevřeného 
dokumentu) 
 

 
 
 
 
 
 
 
 
 
 

Zvolte 

 
Zvolte 

 
 
 

Klikněte 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Klikněte 
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Zobrazí-li program: Proveďte: 
 

Pure Spectra Extraction Complete (Extrakce čistých 
spekter hotova) – Analýza je úspěšná. 

 

Klikněte  a pokračujte krokem 5. 
 

 
DŮLEŽITÉ! Tímto není kalibrace barev ukončena. Před 
uzavřením dokumentu destičky musíte prohlédnout 
vyobrazená spektra jak je popsáno v krocích 5 až 8. 
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Zobrazí-li program: Proveďte:  
Opravná hláška   

Klikněte OK a pokračujte krokem 5. Údaje o tom jak 
program provádí automatickou opravu kalibračních  
spekter, naleznete v části “Spektra jednotlivých barev” na 
straně 83). 

 
 
 
 
 

Chybová hláška  
 Klikněte , vložte destičku pro kalibraci barvy a 

proveďte znovu kalibrační běh. 
 

Pokud se kalibrace znovu nezdaří, proveďte kalibraci 
s novou destičkou pro kalibraci barvy. 

 
 
 
 

5.  V dokumentu destičky pro kalibraci barvy: 
 

a.  Zvolte záložku Results (Výsledky). 
 

b.  Zvolte záložku Spectra (Spektra). 
 
 
 
 
 

6.  Klikněte do levého horního rohu vyobrazení 
destičky, tím zvolíte všechny jamky v dokumentu 
destičky. 

 

 
 
 
 
 
 
 
 

7.  Za použití tabulek z části “Vyhodnocení 
kalibračních spekter barev” na straně 84 jako 
návodu ověřte, že spektrální píky dané barvy 
jsou detekovány ve správném filtru: 

•   Systém 7300 – viz strana 84 

•   Systém 7500 – viz strana 86 

•   Systém 7500 Fast – viz strana 88 
 

Pokud jsou spektrální píky dané barvy 
detekovány v nesprávném filtru, možná jste 
během kalibrace použili destičku s nesprávnou 
barvou. Opakujte kalibraci za použití správné 
kalibrační destičky. 

 
 
 
 

a 

b 

 
Klikněte 
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8.  Zvolte File > Close (Soubor > Zavřít). 
 

Program SDS zobrazí dokument destičky pro 
další barvu. 

 
DŮLEŽITÉ!  Nezavírejte dokument destičky 
předtím než jste provedli extrakci. V průběhu 
kalibrace vytváří program dokumenty destiček 
pro každou kalibrovanou barvu tak jak jsou 
analyzovány. Před zavřením musíte každou z nich 
extrahovat zvlášť. 

 

9.  Opakujte kroky 1 až 8 – extrahujte kalibrační 
data pro každou z kalibrovaných barev. 

 
 
 
 
 
Zvolte 

 

Po ukončení kalibrace ostatních barev uzavřete otevřený dokument destičky a pokračujte částí “Ověření funkčnosti 
přístroje” na straně 91. 

 
Spektra jednotlivých barev 

 
Výsledkem kalibrace barev je soubor spektrálních profilů, které lze chápat 
jako jakýsi fluorescenční podpis každé barvy. Každý profil sestává z 96 
linek, jež představují fluorescenci naměřenou v každé z 96 jamek destičky 
pro kalibraci dané barvy. Program SDS vynáší výsledná data každého 
spektrálního profilu do grafu zobrazujícího závislost naměřené fluorescence 
na použitém filtru.  

 

Při extrakci kalibračních dat z kalibračního běhu, kterou program provádí, je 
vyhodnocován fluorescenční signál generovaný v každé jamce v kontextu 
spekter celé destičky. Spektra jsou obecně přijatelná pokud mají píky 
v tomtéž filtru jako celá skupina a liší se jen mírně při jiných vlnových 
délkách (odlišnost není na obrázku vpravo vyobrazena). 

 

Program SDS může kompenzovat určité problémy ve spektrálním profilu 
záměnou (automatická oprava) nesprávného spektra určité jamky spektrem 
sousední jamky. Je nicméně povoleno pouze několik takových záměn a 
kalibrace může být zamítnuta, pokud se spektra sousedních jamek liší 
výrazně.

 
 
 
 
 
 
 
 
Správné spektrum 

 

 
 
 
 
 
 
 
Spektrální pík totožné 
vlnové délky a jen mírně 
odlišný 

Poznámka:  Jelikož jamky v destičce pro kalibraci barev obsahují danou 
barvu v identické koncentraci, výsledné signály by měly být pro všechny 
jamky obdobné. Drobné variace spekter a píků jsou způsobeny malými 
rozdíly v optické a excitační energii mezi jednotlivými jamkami. 

Nesprávné spektrum 
Několik spektrálních píků 
při rozdílných vlnových 
délkách  

 
 

6 
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Vyhodnocení kalibračních spekter barev 

 
Níže uvedené tabulky použijte pro ověření, že je pík spektra dané barvy detekován ve 
správném filtru vašeho systému: 

 

•   Systém 7300 – viz strana 84 

•   Systém 7500 – viz strana 86 

•   Systém 7500 Fast – viz strana 88 
 

Je-li pík spektra dané barvy detekován v nesprávném filtru,  možná jste během 
kalibrace použili destičku s nesprávnou barvou. Opakujte kalibraci pro tuto barvu. 

 

 
 
 

Tabulka 1 Spektra barev podporovaných systémem 7300 
 

Přístroj Barva Filtr Pík (nm) 

Systém 7300 FAM A ~520 nm 
 
 
 
 
 
 
 
 
 
 

JOE B ~550 nm 
 
 
 
 
 
 
 
 
 
 

NED C ~580 nm 
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Tabulka 1 Spektra barev podporovaných systémem 7300 (pokračování) 
 

Přístroj Barva Filtr Pík (nm) 

Systém 7300 ROX D ~610 nm 
 
 
 
 
 
 
 
 
 
 

SYBR 
Green 

A ~520 nm 

 
 
 
 
 
 
 
 
 

TAMRA C ~580 nm 
 
 
 
 
 
 
 
 
 
 

VIC B ~550 nm 
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. 

 

Tabulka 2 Spektra barev podporovaných systémem 7500 
 

Přístroj Barva Filtr Pík (nm) 

Systém 7500  FAM A ~520 nm 
 
 
 
 
 
 
 
 
 

JOE B ~550 nm 
 
 
 
 
 
 
 
 
 
 

NED C ~580 nm 
 
 
 
 
 
 
 
 
 
 

ROX D ~610 nm 
 
 
 
 
 
 
 
 
 
 

SYBR 
Green 

A ~520 nm 
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Tabulka 2 Spektra barev podporovaných systémem 7500  (pokračování) 
 

Přístroj Barva Filtr Pík (nm) 

Systém 7500  TAMRA C ~580 nm 
 
 
 
 
 
 
 
 
 
 

VIC B ~550 nm 
 
 
 
 
 
 
 
 
 
 

CY3 C ~580 nm 
 
 
 
 
 
 
 
 
 
 
 

CY5 E ~670 nm 
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TEXAS RED D ~610 nm 
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Tabulka 3 Spektra barev podporovaných systémem 7500 Fast 
 

Přístroj Barva Filtr Pík (nm) 

Systém 7500 Fast  FAM A ~520 nm 
 

 
 
 
 
 
 
 
 
 

JOE B ~550 nm 
 
 
 
 
 
 
 
 
 
 

NED C ~580 nm 
 
 
 
 
 
 
 
 
 
 
 

ROX D ~610 nm 
 
 
 
 
 
 
 
 
 
 

SYBR 
Green 

A ~520 nm 
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Tabulka 3 Spektra barev podporovaných systémem 7500 Fast  (pokračování) 
 

Přístroj Barva Filtr Pík (nm) 

Systém 7500 Fast  TAMRA C ~580 nm 
 

 
 
 
 
 
 
 
 
 

VIC B ~550 nm 
 
 
 
 
 
 
 
 
 
 

CY3 C ~580 nm 
 
 
 
 
 
 
 
 
 
 

CY5 E ~670 nm 
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TEXAS RED D ~610 nm 
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Kapitola 7 
 
 
 
 
 

Ověření funkčnosti přístroje 
 
 
 
 
 
 
 
 

Před zahájením  
instalace 

 
 
 

 
 

Vybalení a  
příprava přístroje 

Příprava ověřovací destičky 
TaqMan® RNáza P 

 

Viz strana 94 

 

 
 
 

 

Instalace 
softwaru a 
zapnutí přístroje 

 
Vytvoření dokumentu destičky 
pro ověření pomocí RNázy P 

 

 

Viz strana 96 

 

 
 
 

Provedení  
kalibrace ROI 

 
 
 

 
 
Provedení kalibrace 
pozadí a optické 
kalibrace 

   Provedení ověřovacího 
              běhu 

Viz strana 98

 

 
 
 

 
Provedení 
kalibrace barev 

 

Analýza výsledků běhu 
TaqMan® RNáza P 

 
Viz strana 99 

 

 
 
 

Ověření funkčnosti  
přístroje 
 7 

Řešení problémů  Viz strana 104 
 

 

Vypnutí systémů  
7300/7500/ 
7500 Fast 
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Přehled 
 

Poznámka:  Kroky uvedené v této kapitole můžete rovněž provést pomocí průvodce 
instalací (Real-Time System Setup wizard). Průvodce otevřete kliknutím na  > 
All Programs > Applied Biosystems 7300/7500/7500 Fast System > Real-Time 
System Setup Wizard. 

 
 

Potřebná doba •   Systém 7300/7500 – ~ 2 hodiny 

•   Systém 7500 Fast – ~ 40 minut 
 

Potřebné pomůcky 
 
 
 
 

 
 

 
 
 

Kit pro ověření fukčnosti 
přístroje TaqMan® RNáza P  

Destička TaqMan®  RNáza P 
pro ověření funkčnosti 

přístroje 

 

Rukavice bez 
     pudru 

Ochranné brýle  
GR2170 

 
Centrifuga s adapterem na 

destičky 

 
 

Kdy ověřovat 
funkčnost 

přístroje 

Společnost Applied Biosystems doporučuje použít destičku TaqMan® RNáza P pro 
ověření funkčnosti přístroje: 
 

•   Při instalaci systému musíte provádět kalibrace v následujícím pořadí: 
 

a.  ROI 
 

b.  pozadí 
 

c.  optická (pouze systém 7500/7500 Fast) 
 

d.  barvy 
 

e.  ověření funkčnosti přístroje. 

•   Při přemístění přístroje. 

•   Je-li zapotřebí ověřit funkčnost přístroje 7300/7500/7500 Fast. 
 

 
Účel běhů 

RNázy P 
Běh s destičkou TaqMan® RNáza P pro ověření funkčnosti přístroje ověřuje fungování 
Real-Time PCR systémů Applied Biosystems 7300/7500/7500 Fast. Destička s RNázou P 
obsahuje rozplněné reagencie potřebné pro detekci a kvantifikaci genomových kopií 
lidského genu pro RNázu P (jednokopiový gen kódující RNázovou podjednotku enzymu 
RNáza P). Každá jamka obsahuje: 
 

•   Reakční směs: 

–  Systémy 7300/7500: 1× TaqMan® univerzální PCR mastermix 
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–  Systémy 7500 Fast: 1× TaqMan® Fast univerzální PCR mastermix 

•   Primery na RNázu P 
•   Sonda značená FAM™ 

•   Lidská genomová DNA o známé koncentraci (templát) 
 

Obrázky níže znázorňují uspořádání standardů a skupin neznámých vzorků na destičce 
RNáza P. Destička RNáza P obsahuje pět skupin standardů  (1250, 2500, 5000, 10000 
a 20000 kopií), dvě skupiny neznámých vzorků (5000 a 10000 kopií) a čtyři 
netemplátové kontroly (NTC). 

 

 
 
 

5000 kopií 
Skupina neznámých  vzorků 1 

 

 
NTC STD 1250 STD 2500 

 

STD 5000 STD 10000 STD 20000 

 
10i000 kopií 

Skupina neznámých  vzorků 2 

1    2    3    4    5    6    7    8    9   10  11  12 
A 

RNáza P 
B                 Skupina neznámých  vzorků 1 
C 

D NTC STD 1250 STD 2500 

E STD 5000 STD 10000 STD 20000 

F 
RNáza P 

G                Skupina neznámých  vzorků 2 
H 

 
Destička pro systém 7300/7500 Destička pro systém 7500 Fast 

 

Po skončení běhu program SDS: 
•   Vytvoří standardní křivku na základě průměru hodnot CT (threshold cycle) pro 

jednotlivé replikáty standardů. 

•   Vypočítá koncentraci dvou skupin neznámých vzorků za použití této standardní 
křivky. 

•   Ověří funkčnost přístroje pomocí následujícího výpočtu za použití průměrného 
počtu kopií a standardní odchylky pro skupiny neznámých vzorků 
o koncentracích 5000 a 10000 kopií: 

 
[(CopyUnk2 ) – 3( σCopyUnk2)] > [(CopyUnk1) + 3(σCopyUnk1)] 

 

kde: 

•    CopyUnk1 = Průměrný počet kopií skupiny 1 (Obsahuje 5000 kopií) 
•    σCopyUnk1 = Standardní odchylka skupiny1 (Obsahuje 5000 kopií) 
•    CopyUnk2 = Průměrný počet kopií skupiny 2 (Obsahuje 10000 kopií) 
•    σCopyUnk2 = Standardní odchylka skupiny 2 (Obsahuje 10000 kopií) 

 
Ověření funkčnosti přístroje je úspěšné, pokud získaná data dokládají, že přístroj je 
schopen rozlišit 5000 a 10000 genomových ekvivalentů s 99.7% koeficientem 
spolehlivosti. 

 

DŮLEŽITÉ!  Při analýze je z každé skupiny neznámých vzorků v 96-jamkové destičce  7 
TaqMan RNáza P pro ověření funkčnosti přístroje možné vyloučit maximálně šest 
odlehlých bodů (tzv. outlier). 
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Příprava ověřovací destičky TaqMan® RNáza P 
 
 

DŮLEŽITÉ!  Před provedením běhu s destičkou 
RNáza P  musíte provést kalibraci ROI (viz strana 
35), kalibraci pozadí (viz strana 51) a kalibraci barev 
(viz strana 71). 

 
 
 

DŮLEŽITÉ!  Při manipulaci s ověřovací 
destičkou RNáza P používejte rukavice 
bez pudru. 

 
 

1.   Vyjměte ověřovací kit TaqMan RNáza P 
z mrazáku,  vyjměte z něj destičku RNáza P a 
vyčkejte, než se destička ohřeje na pokojovou 
teplotu (asi 5 minut). 

 
 
 
Pokojová 

 
 
 
> 00:05:00 

 
Ověřovací destička  
RNáza P 

 
 
 
 

2.  Vyjměte destičku RNáza P z obalu. 
 

Poznámka:  Obsahuje-li destička RNáza P 
kompresní vložku, oddělte ji od destičky. 
Společnost Applied Biosystems 
nedoporučuje používání kompresních 
vložek na přístrojích 7300/7500/7500 Fast. 

 
 

3.  Pouze pro standardní destičky: Vortexujte 
destičku po dobu 5 vteřin. Destičky Fast 
nevortexujte. 

 

(Následující kroky se vztahují na standardní 
destičky i destičky Fast.) 

 
4.  Destičku krátce centrifugujte v centrifuze 

s adaptery na destičky (< 1500 x  g). 
 

DŮLEŽITÉ!  Destičku je nutné dobře promíchat a 
centrifugovat. 

 

< 1500 × g 
 
00:00:05 
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5.   Ověřte, že tekutina je v každé jamce destičky 
na dně. Pokud není, centrifugujte destičku 
znovu při vyšších otáčkách a delší dobu. 

 

Pokračujte částí “Vytvoření dokumentu destičky pro 
ověření pomocí RNázy P” na straně 96. 

Správně Špatně 

 
Tekutina na 
dně jamky. 

 
•   Nedostatečné otáčky 

nebo 
•   Nedostatečná doba centrifugace 
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Vytvoření dokumentu destičky pro ověření pomocí RNázy P 
 

1.   Vytvořte nový dokument: 
 

a.  Je-li otevřeno dialogové okno Quick Startup 
(Rychlý start), zvolte Create New Document 
(Vytvořit nový dokument). 

 
 
 
 
 
 
 
 
 
 
 

2.  Není-li dialogové okno Quick Startup (Rychlý 
start) otevřeno, klikněte na ikonku  nebo zvolte 
File > New (Soubor > Nový). 

 
 
 
 
 
 

 3. Proveďte nastavení v dialogovém okně New 
Document (Nový dokument): 

 

a.  Zvolte Assay > Standard Curve (Absolute 
Quantitation) (Standardní křivka – Absolutní 
kvantifikace). 

 

b.  Zvolte Container > 96-Well Clear (96-
jamková destička). 

 

c.  Zvolte Template > AQ RNase P Install 
(Templát > AQ RNáza P Instalace). 

 

d.  V poli Operator vyplňte své jméno. 
 

e.  V poli Comments zadejte další informace, 
které chcete uložit spolu se souborem (např. 
čárový kód destičky). 

f.   V poli Plate Name (Název destičky) zadejte 
čárový kód destičky RNáza P. 

 

g.  Klikněte  (Konec). 

 

 
 
Zvolte 
 
 
 
 
 
 
 
 
 

a 

b 
c 

 

 
d 

 

 
 

e 

f 

g 
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4.  V programu SDS zvolte File > Save As (Soubor 
> Uložit jako). 

 
DŮLEŽITÉ! Dokument destičky neupravujte. 
Vzorky, detektory i teplotní profil jsou 
uloženy v programu. 

 
Zvolte 

 
 
 
 
 

5.  Uložte dokument. V dialogovém okně Save As 
(Uložit jako) zvolte adresář: 

 

Pokud se v poli Save in (Uložit do) 
nezobrazuje “SDS Documents”  (Dokumenty 
SDS), vyhledejte adresář D:/Applied 
Biosystems >SDS Documents. 

 

Po zvolení adresáře klikněte  (Uložit). 
Připravte a analyzujte destičku RNáza P podle 
popisu na straně 98. 

 
 
 
 

 
Zde by mělo být 
SDS Documents 
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G
R

2
4
7
5

 

 
 

H

 

 
 
 

Provedení ověřovacího běhu 
 

 
1. Umístěte destičku do přístroje podle návodu 

v části “Umístění destičky do přístroje” na 
straně 40. 

 

 

 
12 A 

B 

C D  

E F  

G 

 

 
1       2       3       4       5       6       7       8       9       10      11      12 

Poznámka:  Zavíráte-
li zásuvku, zatlačte na 
její pravé straně a pod 
úhlem. 

 
 
 
 
 
 
Zde 
tlačit 

 
 
 
 
Systém 7300/7500  
Standardní destička 

Šikmý roh 
 
Jamka A1 

 
1 

A 

 
 
 

Systém 7500 Fast  
Destička Fast 

 
 

2.  Spusťte běh v dokumentu destičky: 
 

a.  Zvolte záložku Instrument (Přístroj). 
 

b.  Klikněte . 
 a 

Spustí se běh, který trvá 1,5 až 2 hodiny při 
použití Real-Time PCR přístroje 7300/7500  b 
nebo < 40 minut při použití Real-Time PCR 
přístroje 7500 Fast.   

 
Poznámka: Spuštění běhu může předcházet 
pauza (až 10 minut) během níž dochází 
k ohřevu vyhřívaného vnitřního krytu na 
nastavenou teplotu. 

 
 

3.  Po ukončení běhu klikněte . 
 

Pokračujte částí “Analýza výsledků běhu 
TaqMan® RNáza P” na straně 99. 

 

 
 
 
 
Klikněte 

 

A1 
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Analýza výsledků běhu TaqMan® RNáza P 
 

1. V programu SDS zvolte Analysis > Analysis 
Settings (Analýza > Nastavení analýzy). 

 
Zvolte 

 
 
 
 
 
 
 
 

2. V dialogovém okně Analysis Settings (Nastavení 
analýzy): 

 

a.  Zvolte Auto Ct. 
 

b.  Klikněte  . 
 
 

a 
 
 

b 
 
 
 

3. V programu SDS klikněte na ikonu  
nebo zvolte Analysis > Analyze (Analýza 
> Analyzuj). 

 

Program SDS provede analýzu běhu a v záložce 
Results (Výsledky) zobrazí její výsledky. 

 
 
 
 
 
 

4.  Otevřete výsledky. V dokumentu destičky: 
 

a.  Zvolte záložku Results (Výsledky). 
 

b.  Zvolte záložku Amplification Plot 
(Graf amplifikace). 

 
 
 
Zvolte 
 
 
 
 
 
 
 
 
 
 

a 

b 
 

7 
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5. Zobrazte výsledky. V záložce Amplification 
Plot (Graf amplifikace): 

 

a.  Klikněte do levého horního rohu vyobrazení 
destičky, tím zvolíte všechny jamky 
v dokumentu destičky. 

b.  Zvolte graf Data > Ct vs. Well 
Position (Výsledky > Závislost Ct na 
pozici jamky). 

 

 
 
 
 

6.  Ověřte uniformitu obou skupin replikátů 
porovnáním seskupení hodnot CT. 

 

Klikněte 

 
Poznámka: V důsledku experimentální chyby 
mohou být některé jamky amplifikovány 
nedostatečně nebo vůbec. Takové jamky většinou 
vedou k CT hodnotám, které jsou výrazně odlišné 
od průměru dané skupiny replikátů. Pokud budou 
takovéto jamky (odlehlé body) zahrnuty do 
analýzy, mohou chybně ovlivnit její výsledky. 

 
 

7. Jsou-li přítomny odlehlé body, zopakujte 
analýzu běhu: 

 

a.  Ve vyobrazení destičky zvolte jamky, 
jejichž výsledkem jsou odlehlé body. 

b.  Zvolte View > Well Inspector 
(Zobrazit > Prohlížeč jamek). 

 
 
 
 

Odlehlé body 

Čísla na ose X grafu odpovídají jamkám v 96-jamkové 
destičce. Počínaje jamkou A1 jsou jamky číslovány 
zleva doprava a shora dolů. 

1 2 3 
 

13   14   15 
 

25   26   27 
 

37   38   39 
 

49   50   51 
 

61   62   63 
 

73   74   75 
 

85   86   87 

4 5 6 7 8 
 
16   17   18   19   20 
 
28   29   30   31   32 
 
40   41   42   43   44 
 
52   53   54   55   56 
 
64   65   66   67   68 
 
76   77   78   79   80 
 
88   89   90   91   92 

9    10   11   12 
 
21   22   23   24 
 
33   34   35   36 
 
45   46   47   48 
 
57   58   59   60 
 
69   70   71   72 
 
81   82   83   84 
 
93   94   95   96 

 
 
Destička pro systém 
7300/7500  

Odlehlé 
body 
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c.  V okně Well Inspector (Prohlížeč jamek), 

zvolte Omit Well (Vynechat jamku). 
 

d.  Klikněte na ikonu  nebo zvolte Analysis > 
Analyze (Analýza > Analyzuj), čímž 
provedete analýzu bez vynechaných jamek. 

 
8.  Opakujte krok 7 na předcházející straně i pro 

další jamky, jejichž výsledkem jsou odlehlé 
body. 

 
DŮLEŽITÉ!  Při analýze je z každé skupiny 
neznámých vzorků v destičce RNáza P možné 
vyloučit maximálně šest odlehlých bodů. 
Naleznete-li více než šest odlehlých bodů, 
postupujte podle části “Řešení problémů” na 
straně 104. 

 
 

9. V záložce Results (Výsledky) zvolte záložku 
Standard Curve (Standardní křivka). 

 
 
 
 

Zvolte 
 
 
 
Vynechaná jamka 
je přeškrtnutá 

 
 
 

Zvolte 
 
 
 
 
 
 
 
10. V záložce Standard Curve (Standardní křivka) 

ověřte, že hodnota R2 je ≥0.990. 
 
 
 
 
 
 
 

Musí být ≥0.99 
 
 
 
11. V záložce Results (Výsledky) zvolte záložku 

Report (Zpráva). 
 

 7 
Zvolte 
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12. Vypočítejte hodnotu ověřovacího parametru pro 
skupinu vzorků obsahujících 5000 kopií: 

 

a.  V záložce Report (Zpráva) vyhledejte 
skupinu vzorků s 5000 kopiemi. 

 

b.  Dosaďte hodnoty ze sloupců Mean 
Qty (Průměrné množství) a StdDev 
Qty (Množství – standardní odchylka) 
do vzorce: 

Parametr 5K = Mean Qty + 3(StdDev Qty) 
 
 
 
 
 
 
 
 

a b b 
 

13. Vypočítejte hodnotu ověřovacího parametru pro 
skupinu vzorků obsahujících 10000 kopií: 

 

a.  V záložce Report (Zpráva) vyhledejte 
skupinu vzorků s 10000 kopiemi. 

 

b.  Dosaďte hodnoty ze sloupců Mean 
Qty (Průměrné množství) a StdDev 
Qty (Množství – standardní odchylka) 
do vzorce: 

Parametr 10K = Mean Qty – 3(StdDev Qty) 
 

14. Porovnejte parametry zjištěné pro skupiny 
vzorků s 10000 a 5000 kopiemi: 

•  Je-li parametr 10K (krok 13) větší než 5K 
(krok 12), systém 7300/7500/7500 
Fast splnil instalační požadavky na 
ověření funkčnosti. 

•   Není-li parametr 10K větší než 5K, systém 
7300/7500/7500 Fast nesplnil instalační 
požadavky na ověření funkčnosti. 
Pokračujte podle části “Řešení problémů” 
na straně 104. 

 
 
 
 
 
 
 
a b b 
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Vyjmutí destičky z přístroje 

 
 RIZIKO PORANĚNÍ. Je-li 

přístroj v provozu, může být blok na vzorky ohřátý až 
na 100 °C. Před provedením následujících kroků 
vyčkejte dostatečnou dobu, než se blok ochladí na 
pokojovou teplotu. 

 
 

1.  Vyjměte destičku RNáza P: 
 

a.  Stiskem otevřete zásuvku. 
 

b.  Vyjměte destičku RNáza P ze zásuvky. 
 

c.  Zasuňte zásuvku zpět do přístroje. 
 

2.  Destičku vyhoďte. 
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Řešení problémů 

 
 

Řešení problémů – Běh s destičkou RNáza P 
 

Předpoklad: Více než šest odlehlých bodů ve výsledcích 
běhu s destičkou RNáza P 

 
Kontaktujte vašeho servisního a prodejního zástupce 
společnosti Applied Biosystems a objednejte výměnu destičky 
TaqMan RNáza P pro ověření funkčnosti přístroje. Pokud se 
ověření nezdaří ani s touto destičkou, kontaktujte technickou 
podporu společnosti Applied Biosystems nebo vašeho 
servisního technika. 

 
Předpoklad: Ověřovací běh s destičkou RNáza P se nezdařil 

 
1.  Vyjměte destičku RNáza P: 

a.  Stiskem otevřete zásuvku. 
b.  Vyjměte destičku RNáza P ze zásuvky.  
c.  Zasuňte zásuvku zpět do přístroje. 

2.  Podržte destičku proti světlu a ověřte, že všechny jamky 
obsahují stejné množství tekutiny. 

Pozorujete-li rozdíly v množství tekutiny, ověřte zda nedošlo 
k poškození zatavení jamek s nižším množstvím tekutiny nebo 
k odparu. 

Porovnejte rovněž, zda nejsou jamky s nižším množstvím 
tekutiny totožné s odlehlými body, které jste odstranili 
z destičky. Pokud ano, je možné, že je destička špatně 
zatavena, což vedlo k odparu dotyčných vzorků. 

 

3.  Kontaktujte vašeho servisního a prodejního zástupce 
společnosti Applied Biosystems a objednejte výměnu destičky 
TaqMan RNáza P pro ověření funkčnosti přístroje. Pokud se 
ověření nezdaří ani s touto destičkou, kontaktujte technickou 
podporu společnosti Applied Biosystems nebo vašeho 
servisního technika. 

 
 

   RIZIKO PORANĚNÍ. Je-li 
přístroj v provozu, může být blok na vzorky ohřátý až 
na 100 °C. Před provedením následujících kroků 
vyčkejte dostatečnou dobu, než se blok ochladí na 
pokojovou teplotu. 
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Kapitola 8 
 
 
 

Vypnutí systémů 
7300/7500/7500 Fast  

 
 
 
 
 
 

Před zahájením 
instalace 

 

 
 
 
 

Vybalení a  
příprava přístroje 

 

 
 
 

 

Instalace softwaru 
a zapnutí přístroje 
 

 

 
 
 

Provedení 
kalibrace ROI 

Krátkodobé vypnutí Viz strana 106 

 
 
 
 

 
Provedení kalibrace  
pozadí a optické  
kalibrace 
 
 

 

 

Provedení 
kalibrace barev 
 

         
      Dlouhodobé vypnutí

 

 

 
 
 
 

Ověření funkčnosti  
přístroje 
 
 

 
 
 

Vypnutí systémů 
7300/7500/7500 Fast 

  8 
 
 

Viz strana 108
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Kapitola 8  Vypnutí systémů 7300/7500/7500 Fast 
Krátkodobé vypnutí 

 
 
 
Krátkodobé vypnutí 

 
 
Tento postup proveďte, pokud přístroj použijete 
během následujících 7 dní. 

 
Potřebná doba 

 

5 minut 
 
Krátkodobé vypnutí 

 
1.  Stiskem otevřete zásuvku. 

 
 
 
 
 
 
 
 
 
 
 
 

2.  Je-li v zásuvce destička, vyjměte ji a zasuňte 
zásuvku zpět do přístroje. 

 
 
 
 
 
 
 
 
 
 

3.  Stiskněte hlavní spínač přístroje. 

Po  Út  St  Čt  Pá So Ne 
 
 
 
 
 

 

≤  1 týden 
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 Kapitola 8  Vypnutí systémů 7300/7500/7500 Fast 
Krátkodobé vypnutí 

 
 
 

4.  Vypněte počítač a  monitor: 
 

a.  Zvolte  >   Shut Down (Vypnout). 

b.  V dialogovém okně Shut Down Windows 
(Vypnutí Windows) (není zobrazeno) zvolte 

 Shut Down (Vypnout). 

c.  Vypněte monitor. 
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Kapitola 8  Vypnutí systémů 7300/7500/7500 Fast 
Dlouhodobé vypnutí 

 
 
 
Dlouhodobé vypnutí 

 
 
Tento postup proveďte, pokud přístroj nepoužijete 
dříve než po 7 dnech. 

 
Potřebná doba 

 

5 minut 
 
Potřebné pomůcky 

 

Transportní destička (z kroku 8 na straně 21) 
 
Dlouhodobé vypnutí 

 
1.  Stiskem otevřete zásuvku. 

 
2.  Je-li v zásuvce destička, vyjměte ji. 

 
3.  Vložte do zásuvky transportní destičku. 

 
Poznámka:  Nemáte-li transportní destičku 
k dispozici, použijte běžnou nepoužitou destičku. 
Během odstávky leží optický blok přístroje na 
destičce, čímž je chráněn. 

 
 

4.  Zasuňte zásuvku zpět do přístroje. 
 

5.  Stiskněte hlavní spínač přístroje. 
 
 
 
 
 
 
 
 
 
6.  Vypněte počítač a  monitor: 

 

a. Zvolte  >   Shut Down (Vypnout). 

b. V dialogovém okně Shut Down Windows 
(Vypnutí Windows) (není zobrazeno) zvolte 

 Shut Down (Vypnout). 

c. Vypněte monitor. 

Po  Út  St  Čt  Pá So Ne 
 
 
 
 
 

 
> 1 týden 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vložte 
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 Údržba přístroje A 
 
 
 
 
 
 

■   Doporučený postup údržby..................................................................................... 109 
 

■   Archivace a zálohování souborů SDS ................................................................... 111 
 

■   Dekontaminace bloku na vzorky ............................................................................ 112 
 

■   Čistění a defragmentace pevného disku.................................................................. 118 
 

■   Přemístění systému 7300/7500/7500 Fast ............................................................. 119 
 

■   Sledování stavu žárovky ......................................................................................... 121 
 

■   Výměna halogenové žárovky.................................................................................. 122 
 

■   Výměna pojistek přístroje....................................................................................... 126 
 

■   Aktualizace operačního systému a opravné balíčky ............................................... 128 
 
 
Doporučený postup údržby 

 
 

Každý  
týden  
 

Po  Út  St  Čt  Pá So Ne 

•   Ověřte volné místo na disku 

•   Archivujte nebo zálohujte dokumenty destiček (dokumenty sds) (viz strana 111) 

•   Vypněte a zapněte počítač a přístroj (vypněte, poté zapněte počítač a přístroj) 

•   Otřete povrch přístroje utěrkou 
 
 
 

 DŮLEŽITÉ!  Při čistění systému 7300/7500/7500 Fast nikdy nepoužívejte 
organická rozpouštědla. 

Týden (7 dnů) 

 
Každý 
měsíc 

 
 Po  Út  St  Čt  Pá So Ne 

•   Proveďte kalibraci pozadí (viz strana 51) 

•   Proveďte optickou kalibraci systému 7500/7500 Fast (viz strana 62) 

•   Vyčistěte a defragmentujte pevný disk přístroje (viz strana 118) 
 
 
 
 
 
Měsíc (30 dnů) 
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Doporučený postup údržby 
 
 
 

Každých šest 
měsíců 

 

•   Proveďte kalibraci ROI (Region of Interest) (viz strana 35) 
•   Proveďte optickou kalibraci systému 7500/7500 Fast (viz strana 62) 
•   Proveďte kalibraci barev (viz strana 71) 

 Leden  Červenec 
 

Po  Út   St   Čt  Pá  So  Ne                 Po  Út   St   Čt  Pá  So  Ne 
  

 
 

 
6 měsíců 

Poznámka:  Kalibraci pozadí můžete použít pro kontrolu možné kontaminace. Je-li 
provedena výměna některých součástí optického systému, musíte provést kalibraci ROI, 
kalibraci pozadí, optickou kalibraci (pouze 7500/7500 Fast) a kalibraci barev. 

 

 
Ostatní kroky 

údržby 
Provádějte následující kroky údržby podle potřeby pro řešení vzniklých problémů: 
 

•   Dekontaminace bloku na vzorky (viz strana 112) 

•   Přemístění systému 7300/7500/7500 Fast (viz strana 119) 

•   Výměna halogenové žárovky (viz strana 121) 

•   Výměna pojistek přístroje (viz strana 126) 

•   Aktualizace operačního systému Microsoft Windows (viz strana 128) 
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Archivace a zálohování souborů SDS 
 
 
 
Archivace a zálohování souborů SDS 

A 
Archivace 

souborů SDS 
Pomocí nějakého kompresního nástroje můžete provádět archivaci souborů SDS, 
čímž ušetříte místo na pevném disku vašeho počítače. Můžete použít různé 
komerčně dostupné kompresní nástroje. PKZIP a *.arc jsou formáty archivů běžné 
v operačním systému Microsoft® Windows®. 

 

 
Zálohování 

souborů SDS 
Společnost Applied Biosystems důrazně doporučuje zálohování souborů SDS 
vytvořených vaším systémem 7300/7500/7500 Fast, neboť toto zálohování: 
 

•   Chrání před případnou ztrátou dat způsobenou nepředpokládaným selháním 
počítače nebo jeho pevného disku/disků. 

•   Šetří místo na vašem pevném disku a optimalizuje výkon, pokud stará data po 
zálohování vymažete. 

 

Více informací o volbě zařízení pro zálohování dat viz “Zálohování dat” na 
straně 10. 

 

 
Volba 

postupu pro 
správu dat 

Společnost Applied Biosystems doporučuje zvolit vhodný postup pro správu souborů 
vytvářených programem SDS. Během jednodenního používání vytvoří Real-Time PCR 
systém 7300/7500/7500 Fast společnosti Applied Biosystems více než 10 MB dat. Správě 
dat je zapotřebí věnovat pozornost pouze provádíte-li na přístrojích 7300/7500/7500 Fast 
absolutní nebo relativní kvantifikaci. Tyto v reálném čase monitorované běhy generují 
významně více dat než alelická diskriminace nebo experimenty typu plus/mínus. 

 

 
Ověření 

volného místa 
na disku 

Provádíte-li na přístrojích 7300/7500/7500 Fast v reálném čase monitorované pokusy, 
ověřujte volné místo na vašem pevném disku každý týden. Zbývá-li na pevném disku 
20% jeho maximální kapacity, převeďte stará data na zálohovací médium. 
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Dekontaminace bloku na vzorky 
 
 
 
Dekontaminace bloku na vzorky 

 

 
 

RIZIKO PORANĚNÍ. Neodstraňujte kryt přístroje. Uvnitř systému  
7300/7500/7500 nejsou žádné součásti, které můžete bezpečně sami opravit. 
Domníváte-li se, že existuje nějaký problém, kontaktujte servisního technika společnosti 
Applied Biosystems. 

 
 
 

 RIZIKO PORANĚNÍ. Je-li přístroj v provozu, může být blok na 
vzorky ohřátý až na 100 °C. Před provedením následujících kroků vyčkejte dostatečnou 
dobu, než se blok ochladí na pokojovou teplotu . 

 
 
 

Před použitím jiné než výrobcem doporučené metody čistění či  
dekontaminace  si u výrobce ověřte, že zvolená metoda nemůže způsobit poškození 
přístroje. 

 
 

Následující procedura vysvětluje jak odstranit fluorescenční kontaminace z bloku na 
vzorky přístroje 7300/7500/7500 Fast. Proveďte tuto proceduru mají-li běhy pro 
kalibraci pozadí problematický průběh s jednou nebo více jamkami s abnormálně 
vysokými signály, což je známka přítomnosti fluorescenční kontaminace. 

 
 
 
 

Potřebná doba 30 minut 
 

 
Potřebné 
pomůcky 

Pipetman (100-µL) 
se špičkami 

95% etanol  
 
 
 
 
 
 
 
 

 
Deionizovaná 

voda 

10% chlornan 
sodný 

 
 
 
 
 
 
 

Tyčinky s bavlnou 
nebo nylonem a 
utěrka 

 
 
 
 
 
 

 
 

 
Ochranné 
brýle Šroubovák 

Rukavice bez 
pudru 

 



Příloha A 

Poznámky  
  
   
Instalace a údržba – Uživatelská příručka pro Real-Time PCR systémy Applied Biosystems 7300/7500/7500 Fast  113 

Dekontaminace bloku na vzorky 
 
 
 
Čistění jamek 

 
DŮLEŽITÉ!  Při provádění této 
operace používejte rukavice bez 
pudru. 

 
 

1.  Identifikujte kontaminované jamky bloku na 
vzorky (viz “Řešení problémů” na straně 67). 

 
2.  Vyjměte destičku a držák. 

 
3.  Uzavřete zásuvku. Zatlačte na její pravé straně a 

pod úhlem. 
 

4.  Manuálně přesuňte blok do horní pozice pomocí 
okna ROI Inspector: 

 

a.  Je-li otevřeno dialogové okno Quick 
Startup (Rychlý start), zvolte Create New 
Document (Vytvořit nový dokument). 
Není-li dialogové okno Quick Startup 
(Rychlý start) otevřeno, klikněte na ikonku 

 nebo zvolte File > New (Soubor > 
Nový). 

 

b.  V průvodci New Document klikněte 
 (Konec). 

c.  V programu SDS zvolte Instrument > 
Calibrate (Přístroj > Kalibrovat). 

 

d.  Ve výstražné hlášce klikněte  (Ano), 
čímž přesunete blok na vzorky do dolní 
pozice. 

Otevře se dialogové okno ROI Inspector. 
 

e.  V dialogovém okně ROI Inspector klikněte 
 (Blok nahoru). 

 
5.  Vypněte a vypojte systém 7300/7500/7500 Fast 

ze zásuvky. Nechte jej vychladnout 15 minut. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Zde 
stiskněte 

 
 

A 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

> 00:15:00 
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Dekontaminace bloku na vzorky 
 
 
 

6.  Otevřete dvířka přístroje 7300/7500/7500 Fast. a b 
 
 

a.  Vložte tenký šroubovák do otvoru na okraji 
dvířek a tlakem otevřete dvířka. 

 

b.  Otevřete dvířka. 
 
 
 
 

7.  Zvedněte západku a zatlačte vyhřívaný vnitřní 
kryt dozadu. 

 

 
 
 
 
 
 
 
 
 
 

8.  Vyčistěte kontaminované jamky bloku na 
vzorky pomocí malého množství deionizované 
vody: 

 

a.  Pipetujte malý objem deionizované vody 
do všech kontaminovaných jamek. 

b.  Vypláchněte jamku několikrát pipetováním 
vody nahoru a dolů. 

c.  Pipetujte vodu do odpadu. 
 

 
 

d.  Pomocí tyčinky s bavlnou několikrát 
vytřete vnitřek každé kontaminované 
jamky. 

 

e.  Vysušte zbytky deionizované vody 
utěrkou, která nepouští vlákna. 

 

a 
 
 
 

Deionizovaná voda 
 
 
 
 
 
 
 
 
d e 
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Dekontaminace bloku na vzorky 
 
 
 

9.  Tažením vysuňte vyhřívaný vnitřní kryt přístroje 
úplně dopředu. Zvedněte západku a zajistěte 
vyhřívaný vnitřní kryt do příčné lišty. 

 
 
 
 
 
 
 
 
 
 
 
 
 
10. Připojte sytém 7300/7500/7500 Fast do zásuvky a 

zapněte jej. 
 
 
 
 
 
 
 
 
 
 
11. Vytvořte novou destičku pro kalibraci pozadí (viz 

Příloha B, “Vytvoření vlastní destičky pro 
kalibraci pozadí” na straně 129.) 

 
12. Proveďte běh pro kalibraci pozadí, 

abyste ověřili, že se vám podařilo 
kontaminaci odstranit (viz “Provedení 
kalibrace pozadí a optické kalibrace” na 
straně 51). 

 
13. Je-li kontaminace stále přítomna, opakujte 

kroky 1 až 7, pak pokračujte krokem 14. 

 
 
 
 

                  A 
 

 

 
 
 
 
 

Kontaminace 

 
 

 CHEMICKÉ RIZIKO. 
Etanol je hořlavá tekutina a vytváří hořlavé 
výpary. Způsobuje podráždění očí, kůže a 
dýchacího ústrojí a může způsobit poškození 
centrálního nervového systému a jater. Přečtěte 
si bezpečnostní list a dodržujte pokyny při 
manipulaci. Používejte prostředky ochrany očí, 
ochranný oděv a rukavice. 

 
 
 
 
 

A 
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Dekontaminace bloku na vzorky 
 
 
 

14. Vyčistěte kontaminované jamky bloku na vzorky 
pomocí malého objemu 95% etanolu: 

 

a.  Pipetujte malý objem 95% etanolu do všech 
kontaminovaných jamek. 

b.  Vypláchněte jamku několikrát pipetováním 
etanolu nahoru a dolů. 

c.  Pipetujte etanol do odpadu.  
 
15. Opakujte kroky 8 až 11 – opláchněte jamky 

bloku na vzorky a ověřte, že jste kontaminaci 
odstranili. 

Je-li kontaminace stále přítomna, opakujte 
kroky 1 až 7, pak pokračujte krokem 16. 

 
 
95% roztok etanolu 

 
DŮLEŽITÉ!  Po čistění pomocí chlornanu 
sodného nebo etanolu vždy vypláchněte jamky 
pomocí deionizované vody. 

 
 
 

 CHEMICKÉ RIZIKO. 
Chlornan sodný je dezinfekční prostředek, 
který může poleptat kůži a způsobit její 
depigmentaci. Přečtěte si bezpečnostní list a 
dodržujte pokyny při manipulaci. Používejte 
prostředky ochrany očí, ochranný oděv a 
rukavice bez pudru. 

 
 
16. Vyčistěte kontaminované jamky bloku na vzorky 

pomocí malého objemu 10% roztoku chlornanu 
sodného: 

 

a. Pipetujte malý objem 10% roztoku 
chlornanu sodného do všech 
kontaminovaných jamek. 

b. Vypláchněte jamku několikrát pipetováním 
roztoku chlornanu sodného nahoru a dolů. 

c. Pipetujte roztok chlornanu sodného do 
odpadu  
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Dekontaminace bloku na vzorky 
 
 
 

17. Opakujte kroky 8 až 11– opláchněte jamky 
bloku na vzorky a ověřte, že jste kontaminaci 
odstranili. 

 
 

10% roztok chlornanu sodného A 
 

DŮLEŽITÉ!  Po čistění pomocí chlornanu 
sodného nebo etanolu vždy vypláchněte jamky 
pomocí deionizované vody. 

 
 

Je-li kontaminace stále přítomna, kontaktujte 
technickou podporu společnosti Applied 
Biosystems (viz strana xiii). 

 
18. Ujistěte se, že je vyhřívaný vnitřní kryt úplně 

uzavřen a zajištěn. Pokud ne, zobrazí se 
chybová hláška. 
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Čistění a defragmentace pevného disku 
 
 
 
Čistění a defragmentace pevného disku 

 

 
Kdy čistit a defragmentovat pevný disk 

 

•   Alespoň jedenkrát měsíčně 

•   Zobrazí-li se zpráva operačního systému 
Windows o potřebě defragmentace 

 
Čistění disku 

 
1.  Na ploše Windows zvolte  > All 

Programs (Všechny programy). 
 

2.  Zvolte Accessories > System Tools > Disk 
Cleanup (Příslušenství > Nástroje systému > 
Čistění disku). 

 
3.  Zvolte jednotku, kterou chcete defragmentovat a 

klikněte  . Klikněte   i při 
následujících výzvách. 

 
4.  Opakujte i pro ostatní jednotky. 

 
Defragmentace 

 
1.  Na ploše Windows zvolte  > All 

Programs (Všechny programy). 
 

2. Zvolte Accessories > System Tools > Disk 
Defragmenter (Příslušenství > Nástroje systému 
> Defragmentace disku). 

 
3. V horní části dialogového okna zvolte pevný 

disk, který chcete defragmentovat. 
 
 

4.  Klikněte  (Defragmentovat). 
 

5. Objeví-li se hláška o ukončení defragmentace, 
klikněte Close (Zavřít). 

 
6.  Opakujte kroky 3 až 5 i pro ostatní diskové 

jednotky počítače. 

 
 
 
Klikněte 

 



Příloha A 

Poznámky  
  
   
Instalace a údržba – Uživatelská příručka pro Real-Time PCR systémy Applied Biosystems 7300/7500/7500 Fast  119 

 

 

Přemístění systému 7300/7500/7500 Fast  
 
 
 
Přemístění systému 7300/7500/7500 Fast 

A 
 

   RIZIKO VZNIKU PORANĚNÍ.  
Nepokoušejte se zvedat přístroj nebo jiné těžké 
předměty, pokud nejste poučeni o správném postupu 
této činnosti. Nesprávný postup zvedání může vést 
ke vzniku bolestivého a někdy i trvalého poranění 
zad. Používejte proto při zvedání nebo přenášení 
přístroje správný postup. Pro zvedání přístroje 7300/ 
7500/7500 Fast je zapotřebí minimálně dvou osob. 

 
 

DŮLEŽITÉ!  Přemisťování vašeho Real-Time PCR 
přístroje Applied Biosystems 7300/7500/7500 Fast 
může způsobit drobné změny v nastavení optického 
systému. 

 
 

1.  Vložte transportní destičku nebo 96-jamkovou 
destičku do přístroje. 

 
2.  Manuálně přesuňte blok do horní pozice pomocí 

okna ROI Inspector: 
 

a. Klikněte na ikonu  nebo zvolte File > 
New (Soubor > Nový). 

b.  V průvodci New Document klikněte  
(Konec). 

c. V programu SDS zvolte Instrument > 
 Calibrate (Přístroj > Kalibrovat). 

d.  Ve výstražné hlášce klikněte  (Ano), 
čímž přesunete blok na vzorky do dolní 
pozice. 

Otevře se dialogové okno ROI Inspector. 

e.  V dialogovém okně ROI Inspector klikněte 
 (Blok nahoru). 

 
3.  Přemístěte váš systém 7300/7500/7500 Fast podle 

pokynů na straně 12. 
 

4.  Propojte jednotlivé součásti systému (viz 
“Zprovoznění systému 7300/7500/7500 Fast” na 
straně 20). 
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Přemístění systému 7300/7500/7500 Fast 
 
 
 

5.  Proveďte běh s destičkou pro ověření přístroje 
TaqMan® RNáza P (viz strana 91). 

•   Pokud se běh zdaří, není nutné přístroj 
znovu kalibrovat. 

•   Pokud se běh nezdaří, proveďte novou 
kalibraci přístroje podle kroků 6 až 9. 

 

 
 
 
 

6.  Proveďte kalibraci ROI (viz strana 35). 
 

7.  Proveďte kalibraci pozadí (viz strana 51). 
Proveďte optickou kalibraci používáte-li systém 
7500 nebo 7500 Fast (viz strana 62). 

 
8.  Proveďte kalibraci barev (viz strana 71). 

 
9.  Proveďte ověření funkčnosti přístroje (viz 

strana 91). 
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Sledování stavu žárovky 
 
 

Sledování stavu žárovky 
A 

Ověření stavu Ověřte dostává-li halogenová žárovka dost elektrického proudu: 
 

1.  Klikněte na ikonu  nebo zvolte File > New (Soubor > Nový). 

2.  V průvodci New Document klikněte  (Konec). 

3.  V programu SDS zvolte Instrument > Lamp Status/Replacement (Přístroj > 
Žárovka - Stav /Výměna). 

 

V dialogovém okně Lamp 
Status/Replacement 
(Žárovka – Stav/Výměna) je 
v řádce Lamp Current 
(Elektrický proud do 
žárovky) udána hodnota 
elektrického proudu 
v amperech. Řádek 
Condition (Stav) nabývá 
těchto hodnot: 

 
•   Good (Dobrý) – 

Žárovka funguje 
normálně. Není potřeba ji měnit. Klikněte  (Zavřít). 

•   Failed (Špatný) – Žárovku je nutné vyměnit. Klikněte  (Zavřít) a vyměňte 
žárovku podle níže uvedeného postupu. 

•   Change Soon (Výměna brzy) – Žárovka je používána více než 2000 hodin. Je 
doporučeno ji brzy vyměnit. Klikněte  (Zavřít) a rozhodněte, zda ji 
vyměníte. 

 

Je-li zapotřebí žárovku vyměnit, postupujte podle části “Výměna halogenové žárovky” 
na straně 122. 

 

 
Výstražná 

upozornění 
Je-li proud do žárovky příliš nízký, mohou být v průběhu běhu zobrazena tři různá 
výstražná upozornění: 

 
Upozornění Popis 

Upozornění – Není 
detekován dostatečný proud 
v žárovce. Žárovka není 
instalována nebo je 
zapotřebí ji vyměnit. 

Zobrazí se na začátku běhu je-li proud v žárovce pod 
přijatelnou mezí. 

 

Běh nemůže pokračovat. Musíte vyměnit halogenovou 
žárovku. 

Upozornění – Není 
detekován dostatečný proud 
v žárovce. Žárovka není 
instalována nebo je 
zapotřebí ji vyměnit. 

Zobrazí se v průběhu běhu dostane-li se proud v žárovce pod 
přijatelnou mez. Beh je zastaven. 

 

Klikněte OK, zkontrolujte zprávy systému (Log) a vyměňte 
žárovku. 

 

Běh nemůže pokračovat. Musíte vyměnit halogenovou 
žárovku. 
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Výměna halogenové žárovky 
 

 
 
 

Upozornění Popis 

Upozornění – Žárovka je 
používána déle než 2000 
hodin. Doporučujeme brzkou 
výměnu žárovky, abyste zajistili 
optimální fungování. 

Zobrazí se na začátku běhu je-li žárovka používána déle než  
2000 hodin. 

 

Klikněte Cancel Run (Ukončit běh) a vyměňte žárovku nebo 
klikněte Continue Run (Pokračovat v běhu). 

 
 
 

Výměna halogenové žárovky 
 

 
 

 RIZIKO VZNIKU PORANĚNÍ. Systém 7300/7500/7500 Fast 
a žárovka jsou horké! Je-li žárovka používána, může být velice horká. Vyčkejte 
dostatečně dlouhou dobu, než se žárovka ochladí, a při manipulaci s ní používejte 
ochranné rukavice bez pudru. 

 
 
 

 RIZIKO VZNIKU PORANĚNÍ. Při manipulaci se žárovkou 
používejte jednorázové rukavice bez pudru, abyste zabránili popálení a zkrácení 
životnosti instalované žárovky. 

 
 
 
 

 
VÝSTRAHA. Přístroj je určen pro 12V, 75W halogenovou žárovku.

 
 

Vyměňte halogenovou žárovku po zhruba 2000 hodinách provozu. 
 

Potřebná doba 30 minut 
 

Potřebné  
pomůcky 

 
 
 

Halogenová 
žárovka 

(12V, 75W) 

Šroubovák, 
     malý 

Rukavice 
bez pudru 

Ochranné 
    brýle 
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 Výměna halogenové žárovky 
 
 
 
Výměna žárovky 

 

DŮLEŽITÉ!  Při manipulaci se žárovkou používejte  A 
rukavice bez pudru. 

 

 
 
 
 

1.  Vypněte a vypojte systém 7300/7500/7500 Fast 
ze zásuvky. Nechte jej vychladnout 15 minut. 

 
 
 
 
 
 
 
 
 

  2.  Otevřete dvířka přístroje 7300/7500/7500 Fast. 
 

a.  Vložte tenký šroubovák do otvoru na okraji 
dvířek a tlakem otevřete dvířka. 

 

b.  Otevřete dvířka. 
 
 

 RIZIKO VZNIKU 
PORANĚNÍ. Systém 7300/7500/7500 Fast 
a žárovka jsou horké! Je-li žárovka používána, 
může být velice horká. Vyčkejte dostatečně 
dlouhou dobu, než se žárovka ochladí, a při 
manipulaci s ní používejte ochranné rukavice 
bez pudru. 

 
 

3.  Vyjměte žárovku z přístroje: 
 

a.  Vyklopte páčku, zajišťující žárovku, 
směrem dopředu. 

 

b.  Pevně uchopte žárovku a vyjměte ji směrem 
vzhůru a ven z úchytu. 

                                   
 

 
 
 
 
 
 
 
 
 
 

a b 

 
DŮLEŽITÉ!  Neodtýkejte se žárovky nemáte-li 
rukavice bez pudru. Zkracujete tak její životnost. 

 
 
 
 
 
 
 
 
 
 
 

> 00:15:00 
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Výměna halogenové žárovky 
 
 
 

4.  Posuďte stav žárovky (vnitřek špatné žárovky 
bývá černě potažen). 

 
 
 
 
 
 
 
 
 
 
 

5.  Vložte do přístroje novou žárovku: 
 

a.  Zaklopte páčku, zajišťující žárovku, 
směrem nahoru. 

 

b.  Pevně uchopte žárovku, vložte ji do úchytu a 
opatrně zasuňte směrem dolů na její místo. 

 

 
 
 
 
 

6.  Uzavřete dvířka. 
 
 
 
 
 
 
 
 
 
 
 
 

7.  Připojte systém 7300/7500/7500 Fast do 
zásuvky a zapněte jej. 

 
 

Dobrá žárovka 
 
 
 
 
 

Špatná žárovka 
Vyměňte 

 
 
 
 

a b 
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Výměna halogenové žárovky 
 
 
 

8.  Otevřete dialogové okno ROI Inspector: 
 

a.  Je-li otevřeno dialogové okno Quick Startup 
(Rychlý start), zvolte Create New Document 
(Vytvořit nový dokument). Není-li dialogové 
okno Quick Startup (Rychlý start) otevřeno, 
klikněte na ikonku  nebo zvolte File > New 
(Soubor > Nový). 

 

b.  V průvodci New Document klikněte  
(Konec). 

c.  V programu SDS zvolte Instrument > 
Calibrate (Přístroj > Kalibrovat). 

 
9.  V dialogovém okně ROI Inspector zvolte Lamp 

Control > Idle (Kontrola žárovky > Nečinná). 

 
 

A 
 
 
 
Zvolte 

 
 
 
 
 

Zvolte 
 
 
 
 
10. Za běhu přístroje se podívejte skrze otvory jeho 

dvířek a ověřte, že žárovka svítí, poté klikněte 
 (Hotovo). 

 
Pokud žárovka nesvítí, může být vadná. Vyměňte 
ji za novou. Nesvítí-li ani ta, zkontrolujte pojistky 
přístroje (viz strana 126). 

 
11. Po výměně žárovky proveďte níže uvedené 

kalibrace. Viz: 

•   Kapitola 4, Provedení kalibrace ROI 
(Regions of Interest) 

•   Kapitola 5, Provedení kalibrace pozadí a 
optické kalibrace 

•    Kapitola 6, Provedení kalibrace barev 
•    Kapitola 7, Ověření funkčnosti přístroje 

 
 
 
 
 
Měli byste vidět světlo 
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Výměna pojistek přístroje 
 
 
 
Výměna pojistek přístroje 

 

 
 

NEBEZPEČÍ POŽÁRU. Z důvodu ochrany před rizikem vzniku 
požáru používejte pro výměnu pouze certifikované pojistky typu a jmenovitého proudu 
shodného s pojistkami, které jsou v přístroji umístěny. 

 
 

Potřebná doba 30 minut 
 

Potřebné 
pomůcky 

 

 
 

 
Pojistky (2), 12,5A, 
250V, 5 x 20 mm 

Plochý 
šroubovák 

Rukavice 
bez pudru 

Ochranné 
     brýle 

 
 

Výměna 
pojistek 

1.  Vypněte přístroj a vypojte jej ze zásuvky. 
 

 
 

2.  Pomocí plochého šroubováku vyšroubujte a vyjměte držáky pojistek z přístroje. 
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A 

Výměna pojistek přístroje 
 
 
 

3.  Vyjměte každou pojistku z jejího držáku a ověřte 
zda je v pořádku. Vnitřek špatné pojistky bývá 
černě potažen. 

 
4.  Vyměňte špatné pojistky za nové (12,5A, 250V, 

5 x 20-mm). 
 

Poznámka:  Hodnoty napětí a proudu jsou na 
držáku pojistky. 

 
 

5.  Vraťte držák pojistek zpět do přístroje.  
 

6.  Připojte systém do zásuvky a zapněte jej. 
 

Pokud se přístroj zapne, byla instalace 
úspěšná. 

 
Poznámka: Defekt pojistek může být důsledkem 
kolísání elektrické sítě. Chcete-li tento vliv 
eliminovat, zvažte používání elektrického 
ochranného zařízení (viz strana 9). 

 
 

Dobrá 
pojistka 
 
 
 
Špatná 
pojistka 
Vyměňte 
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Aktualizace operačního systému a opravné balíčky 
 
 
 
Aktualizace operačního systému a opravné balíčky 

 
Pokud vás k tomu nevyzve zástupce společnosti Applied Biosystems, neinstalujte vyšší 
verzi operačního systému na počítač připojený k přístroji 7300/7500/7500 Fast. Nová 
verze operačního systému Microsoft Windows může způsobit konflikt s programem SDS 
a váš přístroj může být neovladatelný. 

 

 
Aktualizace – 

opravné 
balíčky 

Chcete-li instalovat opravný balíček operačního systému, přečtěte si poznámky k verzi 
programu SDS (release notes) s ohledem na vzájemnou kompatibilitu. 

 
 

Poznámka:  Servisní technici společnosti Applied Biosystems provádějí údržbu 
operačního systému v rámci údržby celého systému. Během servisních návštěv 
provádějí aktualizace operačního systému počítače tak, jak jsou tyto aktualizace 
dostupné a validované společností Applied Biosystems. 
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Příloha B 
 
 
 
 
 

Vytvoření vlastní destičky 
pro kalibraci pozadí 

 
 

Přehled  

 
B 

Kdykoliv je to možné, používejte destičku pro kalibraci pozadí, která je součástí 
spektrálního kalibračního kitu. Destičky, které jsou součástí kitu, obsahují pufr, který 
je přesným modelem reagencií používaných v PCR, a proto pomocí nich získáte 
kalibrační data vysoké kvality. Nemáte-li nicméně k dispozici destičku pro kalibraci 
pozadí ze spektrálního kalibračního kitu, můžete si ji vytvořit níže uvedeným 
způsobem. 

 

 
Potřebné 
pomůcky 

Pipetman, 200-µL 
(se špičkami) 

Deionizovaná 
voda 

 
Ochranné brýle 

 
 
 
 
 

 
Optická 96-jamková 

destička Applied 
Biosystems nebo 96-

jamková destička Fast  

Optická adhezivní fólie 
nebo optická plochá 

víčka 

 
Rukavice bez pudru 

 
 
 
Vytvoření vlastní destičky pro kalibraci pozadí 

 
 

DŮLEŽITÉ!  Při přípravě destičky pro kalibraci pozadí používejte 
rukavice bez pudru. 

 
 

1.  Vyjměte 96-jamkovou optickou destičku Applied Biosystems nebo 
96-jamkovou destičku Fast z krabice a umístěte ji na čisté suché 
místo. 

 
2.  Pipetujte 50 µL (systém 7300/7500) nebo 20 µL (systém 7500 Fast) 

deionizované vody do každé jamky reakční destičky. 
 

3.   Pomocí optické adhezivní fólie nebo optických plochých víček 
destičku uzavřete. 

 

Proveďte kalibraci pozadí s touto destičkou stejným způsobem jakým provádíte 
kalibraci pozadí s destičkou ze spektrálního kalibračního kitu. Viz Kapitola 5, 
“Provedení kalibrace pozadí a optické kalibrace.” 
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Příloha B 
Vytvoření vlastní destičky pro kalibraci pozadí 
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Příloha C 
 
 
 
 
 

Vytvoření vlastní destičky  
pro kalibraci barvy 

 
 
 
 
 
 

Přehled 
 

Real-Time PCR systémy 7300/7500/7500 Fast společnosti Applied Biosystems lze 
využít pro reakce používající vlastní barvy (barvy nevyráběné společností Applied 
Biosystems). Tyto barvy musí emitovat fluorescenci ve spektrálním rozsahu  
měřitelném těmito systémy: 

 

•   500 až 650 nm pro systém 7300 

•   500 až 700 nm pro systémy 7500/7500 Fast 
 

Před použitím vlastních barev na přístrojích 7300/7500/7500 Fast musíte: C 
•   Stanovit optimální koncentraci barvy 

•   Vytvořit vlastní destičku pro kalibraci barvy 

•   Přidat tuto barvu do programu SDS  

•   Provést kalibraci barvy (viz Kapitola 6, “Provedení kalibrace barev.”) 
 

 
Potřebné 
pomůcky 

 
Pipetman se špičkami 

(200-µL a 1000-µL)  Voda, 
deionizovaná 

 
 
 
 
 
 
 
 
 
 

ABI PRISM® optická 
96-jamková destička a 

optická 96-jamkova 
destička Fast 

 
Zkumavky 

 (2-mL a 10-mL) 
 
 
 
 
 
 
 
 

 
 

Optická adhezivní 
fólie nebo optická 
plochá víčka 

 
 

Ochranné 
    brýle 

 

 
 
 

 
Rukavice 
bez pudru 

 
 
 
 
Vlastní barva(y) 

 
 
 
 
 
 

 Centrifuga 
s adaperem 

 
 
GR2170 
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Stanovení optimální koncentrace barvy 
 
 
 
Stanovení optimální koncentrace barvy 

 
 
DŮLEŽITÉ!  Při vytváření vlastní destičky 
pro kalibraci barvy používejte rukavice 
bez pudru. 

 
 

1.  Ve středních jamkách 96-jamkové destičky 
připravte ředící řady vlastních barev (například  
25, 50, 100, 200, 400, 800, 1600 a 3200 nM)  
v objemu 50-µL pro systém 7300/7500 a 20-µL  
pro systém 7500 Fast. 

 
2.  Uzavřete jamky reakční destičky pomocí optické 

adhezivní fólie. 
 

3.  Vytvořte nový dokument v programu SDS: 
 

a.  Je-li otevřeno dialogové okno Quick Startup 
(Rychlý start), zvolte Create New 
Document (Vytvořit nový dokument). 

b.  Není-li dialogové okno Quick Startup (Rychlý 
start) otevřeno, klikněte na ikonku  nebo 
zvolte File > New (Soubor > Nový). 

 
4.  V dialogovém okně New Document (Nový 

dokument) klikněte  (Konec). 

 
 

25 50   100  200 
 
 
 
 

400  800 1600 3200 

 
Poznámka:  V tomto dokumentu destičky není 
nutné definovat detektor, vzorky a parametry 
běhu. Účelem tohoto běhu je zjistit správnou 
pracovní koncentraci barvy, čehož je docíleno na 
základě analýzy intenzit nezanalyzovaných  
spekter ředící řady dané barvy. 

 
 

5.  Vložte připravenou destičku do přístroje: 
 

a.  Stiskem otevřete zásuvku. 
 

b.  Umístěte destičku pro kalibraci barvy 
do držáku destičky. 

c.  Uzavřete zásuvku. Zatlačte na její pravé 
straně a pod úhlem. 
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Stanovení optimální koncentrace barvy 
 
 
 

6.  V programu SDS zvolte Instrument > Calibrate 
(Přístroj > Kalibrace). 

 
 
 
 

Zvolte 
 
 
 
 
 

7.  Kliknutím na  (Ano) potvrďte, že chcete, 
aby se blok na vzorky spustil dolů. 

 
 
 
 

 
C 

Klikněte 

 
8. V dialogovém okně ROI Inspector vytvořte obraz 

ROI pro každý filtr počínaje filtrem A: 
 

a.  V poli Exposure Time (Doba expozice) 
zadejte 1024. 

a 
b. Klikněte  (Blok do horní pozice). 

 

c.  Zvolte Filter A (Filtr A). b 
 

d.  Klikněte  (Snímek). . 
 c 
 
 

e.  Ověřte nasycení obrazu. 
 

Nenasycený Normální 
   nasycení 

 
 
 
 
 
 
 
 

Dobře   Špatně 

Přesycený 

 

 
f.   Zaznamenejte, která jamka dává 

nejjasnější signál bez saturace. Tato jamka 
obsahuje nejlepší koncentraci vaší vlastní 
barvy pro filtr A. 
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Vytvoření vlastní destičky pro kalibraci barvy 
 
 
 

9.  Opakujte krok 8 (body c až f) pro zbývající filtry. 
 

10.  Poté co stanovíte optimální koncentraci pro každý filtr, stanovte optimální 
koncentraci pro vlastní barvu: 

•   Porovnejte výsledky ze všech filtrů. 

•   Zvolte koncentraci, která dává nejjasnější signál ve všech filtrech, ale bez 
saturace. 

 

 
Vyjmutí 

destičky 
z přístroje 

RIZIKO PORANĚNÍ. Je-li přístroj v provozu, může být blok na 
vzorky ohřátý až na 100 °C. Před provedením následujících kroků vyčkejte dostatečnou 
dobu, než se blok ochladí na pokojovou teplotu. 
 
 
1.  V dialogovém okně ROI Inspector klikněte  (Blok dolů). 

 
2.   Vyjměte destičku z přístroje: 

 

a.  Stiskem otevřete zásuvku. 
 

b.  Vyjměte destičku. 
 

c.  Zasuňte zásuvku zpět do přístroje. 
 

Poznámka: Pokud se vám nedaří zásuvku otevřít, je možné, že blok je v horní 
pozici a brání jejímu vysunutí. Zvolte Instrument > Calibrate (Přístroj > 
Kalibrovat), čímž blok přesunete dolů, a uzavřete okno ROI Inspector. 

 
 

3.   Klikněte  (Hotovo). 
 
 

Vytvoření vlastní destičky pro kalibraci barvy 
 

1.   Připravte 5 mL (systém 7300/7500) nebo 2 mL (systém 7500) vlastní barvy 
v koncentraci stanovené v kroku 10 na straně 134. 

 
2.  Pipetujte 50 µL (systém 7300/7500) nebo 20 µL (systém 7500 Fast) takto 

ředěné vlastní barvy do všech jamek optické reakční destičky. 
 

3.  Pomocí optické adhezivní fólie destičku uzavřete. 
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Přidání vlastní barvy do programu SDS 
 
 
 
Přidání vlastní barvy do programu SDS 

 
1.   V programu SDS zvolte Tools > Dye Manager 

(Nástroje > Správce barev). 
 
 

Zvolte 
 
 
 
 
 
 

2.  V dialogovém okně Dye Manager (Správce 
barev) klikněte  (Přidat). 

 
 
 

Klikněte C 
 
 
 
 
 

3.  V dialogovém okně Add Dye (Přidat barvu) 
zadejte název barvy (Name) a klikněte  . 

 
4.  Klikněte  (Hotovo). 

 

Proveďte běh s vlastní destičkou pro kalibraci 
barvy (viz Kapitola 6, “Provedení kalibrace 
barev.”) 

 
 
 
Zadejte název 
barvy 
 
 
Klikněte 
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Přidání vlastní barvy do programu SDS  
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Nastavení počítače 
 
 
 
 
 
 

Poznámka:  Obsah této přílohy je totožný s informacemi obsaženými v příručce Applied 

Biosystems Real-Time System Computer Setup Guide. 
 
 

■   Vybalení počítače a nastavení napětí...................................................................... 138 
 

■   Propojení součástí a zapnutí ................................................................................... 140 
 

■   Nastavení obrazovky a možností napájení.............................................................. 141 
 

■   Připojení k síti a stažení Adobe Acrobat ................................................................ 144 
 
 
 
 
 
 
 

D 
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Desktop Laptop 

  

  
 

Vybalení počítače a nastavení napětí 
 
 
 
Vybalení počítače a nastavení napětí 

 
 
Poznámka:  Fotografie a obrázky v této příloze jsou obecného charakteru a jejich účelem je provést vás celým 
procesem nastavení. Mohou se mírně lišit od vaší konkrétní situace. Účelem níže uvedeného vyobrazení přístroje 
je znázornit umístění přístroje a počítače. 

 
 

1.  Vybalte součásti počítače z krabic.  
 
Položte krabici 
na bok a nechte 
počítač 
vyklouznout 

 
 
 
 

 
´ 

 
 
 

2.  Umístěte monitor, počítač, klávesnici a myš na 
stůl podle nákresu. Zatím nepropojujte jednotlivé 
součásti ani USB kabel do přístroje či počítače. 
Mohlo by dojít k nainstalování nesprávných 
ovladačů. 

 

D 
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Vybalení počítače a nastavení napětí 
 
 
 

3.  Desktopy: Nastavte napětí a zapojte přívodní kabel: 
 

a.  Prohlédněte zadní stranu počítače. 
 

b.  Je-li váš počítač vybaven přepínačem 
napětí, nastavte napětí: 

 
       Volič 
       napětí  

 
Země Napětí 

   USA/Japonsko 115 
Evropa/Austrálie 230 

 
 

DŮLEŽITÉ!  Vždy ověřte, že nastavení napětí 
na zadní straně vašeho počítače odpovídá napětí 
v místní síti. Nesprávné nastavení voliče napětí 
může vést k poškození počítače. 

 
 

Nemá-li váš počítač volič napětí, je vybaven automatickou detekcí napětí a 
provádí tedy detekci napětí v síti automaticky. 

 
c.  V USA: Použijte přívodní kabel dodávaný s počítačem. 

Mimo USA: V soupravě kabelů (PN603615) dodávané spolu s počítačem 

zvolte odpovídající přívodní kabel (ostatní kabely můžete vyhodit).  D 
 
 
DŮLEŽITÉ!  Mimo  USA musíte použít přívodní kabel ze soupravy kabelů a 
nikoliv přívodní kabel dodaný v krabici počítače. 

 
 

4.  Laptopy: Připojte přívodní kabel (síťové adaptéry laptopů jsou vybaveny 
automatickou detekcí napětí a detekují napětí v místní síti automaticky): 

a.  V USA: Použijte přívodní kabel dodávaný s počítačem. 
 

Mimo USA: V soupravě kabelů (PN4346883) dodávané spolu s počítačem 
zvolte odpovídající přívodní kabel a připojte jej mezi síťový adaptér a 
zásuvku (ostatní kabely můžete vyhodit). 

 
DŮLEŽITÉ!  Mimo  USA musíte použít přívodní kabel ze soupravy kabelů a 
nikoliv přívodní kabel dodaný v krabici počítače. 
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D

Propojení součástí a zapnutí 
 
 
 
Propojení součástí a zapnutí 

 
1.  Propojte myš, klávesnici a monitor podle 

příručky, která je součástí dodávky počítače. 
Ověřte správnost propojení podle níže uvedených 
obrázků. 

 

 
Desktop Laptop 

 
 
 
 
 
 
 
 
 
 
 
 

  Myš 
 

 Klávesnice 
 

El. síť 

 

 
Monitor 

 
 
El. síť 

  Myš El. síť 

 
Jsou-li součástí dodávky dva 
kabely pro propojení počítače 
a monitoru, použijte kabel s 
konektorem DVI (obrázek 
vpravo). 

 
 
 
 
 
 
 

2.  Zapněte počítač a monitor (počítač typu desktop 
viz obrázek vpravo). 

 

Hlavní spínač laptopu je na horní straně 
klávesnice uprostřed. 

 

Vyčkejte než se počítač spustí. 
 

3.  Přihlašte se do počítače jako administrátor 
systému Windows (více informací vám 
podá správce vaší sítě). 
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Nastavení obrazovky a možností napájení 
 

 
 
 

Zobrazí se pracovní plocha systému Windows. 
 
 
 
 
 

Pracovní 
plocha 
Windows 
 

 
 
 
 
 
 

Nastavení obrazovky a možností napájení 
 
 
DŮLEŽITÉ!  Pro nastavení obrazovky a možností 
napájení počítače musíte mít administrátorská práva. 

 
 

1.  Zvolte  >  Control Panel (Ovládací panely). 
 

2.  V levé horní části okna Control Panel (Ovládací 
panely) zvolte Switch to Classic View (Přepnout 
do klasického zobrazení). 

 
D 

 
 

Klikněte 
 
 
 
 
 

3.  V okně Control Panel (Ovládací panely) dvakrát 
poklepejte na Display (Obrazovka). 

 
 

Dvakrát klikněte 
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Nastavení obrazovky a možností napájení 
 
 
 

4.  V okně Display Properties (Vlastnosti obrazovky) a 
nastavte spořič obrazovky: 

 

a.  Zvolte záložku Screen Saver (Spořič 
obrazovky). b 

 
b.  Zvolte None (Žádný). 

 

 
 
 
 
 
 
 

5.  V okně Display Properties (Vlastnosti obrazovky) a 
nastavte písmo: 

 

a.  Zvolte záložku Appearance (Vzhled). 
 

b.  Zvolte Font size > Normal (Velikost písma 
> Normální). 

 
b 

 
 
 
 
 

6.  V okně Display Properties (Vlastnosti obrazovky),  a 
nastavte barvy: 

a.  Zvolte záložku Settings (Nastavení). b D 
 

b.  V okně Screen resolution (Rozlišení obrazovky) c 
zvolte pomocí posouvátka rozlišení 1280 by 
1024 pixels (1280 × 1024 pixelů). 

 

 
Poznámka:  Maximální rozlišení některých 
laptopů je 1024 × 768 pixelů. 

 
 

c.  Zvolte Color quality > Highest (32 bit) 
(Kvalita barev > Nejvyšší (32 bit). 

 
7.  Klikněte . 

 
8.  Používáte-li laptop a zobrazí-li se hláška Flat 

Panel Warning, klikněte . 
 
 
 

Klikněte 
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Nastavení obrazovky a možností napájení 
 
 
 

9.  V dialogovém okně Monitor Settings 
(Nastavení monitoru), klikněte . 

 
 
 
 
 
 
 
10. V okně Control Panel (Ovládací panely) dvakrát 

klikněte na Power Options (Možnosti napájení). 

 
 
 
 
 
 
 
Klikněte 

 
 
 

Dvakrát klikněte 
 

 
 
 
 
 
 
11. Nastavte možnosti napájení. V dialogovém okně a 

Power Options Properties (Vlastnosti napájení): 
 

a.  Zvolte záložku Power Schemes (Napájecí 
schéma). 

 

b.  Volbu Turn off monitor (Vypnout monitor) 
nastavte na Never (Nikdy).  

 

c. Volbu Turn off hard disks (Vypnout pevné  D 
disky) nastavte na Never (Nikdy). 

 
d. Volbu System standby (Pohotovostní režim) 

nastavte na Never (Nikdy) 
 b 

e. Volbu System Hibernates (Hibernace)  c 
nastavte na Never (Nikdy) (tato možnost 
nastavení se nezobrazuje v laptopech). d 

f.   Zvolte záložku Hibernate (Hibernace, není e 
vyobrazeno) a ujistěte se, že volba Enable f 
Hibernation checkbox (Umožnění hibernace) 
není zatržena. 

 

g.  Klikněte . 
 

 
DŮLEŽITÉ!  Ujistěte se, že nastavení Hibernate 
(Hibernace) je vypnuto. Je-li zapnuto, zastaví se 
sběr dat z přístroje v okamžiku přechodu 
počítače do stavu hibernace. 

 
 
12. Uzavřete okno Control Panel (Ovládací panely). 
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Připojení k síti a stažení Adobe Acrobat 
 
 
 
Připojení k síti a stažení Adobe Acrobat 

 
1.  Připojte váš počítač k síti. Více informací o připojení k síti vám podá váš správce 

sítě. 
 

DŮLEŽITÉ!  Nepřipojujte systém 7300/7500/7500 Fast do bezdrátové sítě 
(wireless network). Používání bezdrátové sítě může vést ke konfliktu se sběrem 
dat z přístroje a k jejich ztrátě. 

 
 

2.  Stáhněte Adobe® Acrobat® Reader (volně dostupný program v licenci shareware) 
ze stránek www.adobe.com. Adobe® Acrobat® Reader musíte stáhnout proto, 
abyste mohli otevírat dokumenty, na něž odkazuje průvodce instalací Real-Time 
System Setup Wizard a online soubory Nápovědy (Help) programu Sequence 
Detection System. 

 
3.  Po ukončení nastavení počítače pokračujte s instalací buď podle: 

•   Průvodce instalací Real-Time System Setup Wizard na instalačním CD 
(spustí se automaticky po krátké prodlevě po vložení tohoto CD do CD 
mechaniky počítače), nebo 

•   Této příručky o instalaci a údržbě. 
 

 
 
 
 

D 
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Číslice 
7500/7500 Fast systém, optická 
kalibrace  

kdy provádět     62 
o kalibraci     62 
potřebná doba     62 
potřebné pomůcky     62  
provedení     62, 65  
příprava destičky     62 
vytvoření dokumentu destičky     64 

 
A 
aktualizace operačního systému Windows     128 
analýza 

destička RNáza P     99 
výsledky kalibrace barev     81 
výsledky kalibrace pozadí     59 
výsledky kalibrace ROI     45 
výsledky optické kalibrace (pouze systém 

7500/7500 Fast)     66 
antivirový program     10 
Applied Biosystems  

kontakt     xiii 
připomínky zákazníků k doku- 

mentaci     xii 
technická podpora     xiii 

archivace souborů SDS     111 

 
B 
barvy     73, 84, 86, 88 
běh 

destička pro kalibraci barev     77 
destička pro kalibraci pozadí     58 
destička pro kalibraci ROI     45 
destička RNáza P     98 

bezdrátová síť, nepoužívat     10 
bezpečnostní listy 

popis      xxi 
získání     xiii, xxi 
při manipulaci s chemikáliemi     xxi 
při práci s přístrojem     xx 

bezpečnostní normy     xxv 
bezpečnostní označení, na přístrojích     xviii  
bezpečnostní software     11 
bezpečnostní symboly, na přístrojích     xvii 
 

 
biologické odpady, manipulace     xxiii 
biologické riziko     xxiv 

doporučení     xxii, xxiii  
ergonomie     xxv  
chemický odpad     xxii  
normy     xxv 
opakované pohyby     xxv 
ovládání přístroje     xx 
pohyblivé součásti     xx 
přemisťování a zvedání  

přístroje     xx  
při manipulaci s elektrickými 

zařízeními     xxiii 
blok na vzorky, dekontaminace     112  

 
C 
CY3 barva     73, 87, 89 
CY5 barva     73, 87, 89 

 
Č 
červená stavová dioda, řešení  

problémů     32 
čistění bloku na vzorky     112 

 
D 
defragmentace pevného disku     118 
dekontaminace bloku na vzorky     112 
destička pro kalibraci barev 

běh     77 
vytvoření vlastní     131 

destička pro kalibraci pozadí  
běh     58 
opakované použití     54 
příprava     54 
vytvoření     129 

destička pro kalibraci ROI 
běh     45 
ochrana před světlem     39 
opakované použití     39 
příprava     38 

destičky 
Fast a standardní     38 
Fast, nevortexovat     38 
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Fast, popis     38 
opakované použití     54 
standardní, popis     38 
šikmý roh     40 
umístění do přístroje     40 
vyjmutí z přístroje     47 

dioda chybová, řešení problémů     32 
diody na čelním panelu 

umístění     29 
řešení problémů     32 

disk, čistění     118 
disk, kontrola stavu volného místa     111  
dlouhodobé vypnutí     108 
dodávka, kontrola     14  
dokumentace, dodávaná s přístrojem     19 
dokumentace, související     xii 
dokument destičky 

7500/7500 Fast, optická kalibrace     64 
kalibrace barev     76 
pozadí     56 
RNáza P     96 

doporučení 
chemický odpad, bezpečná  

manipulace     xxii 
chemický odpad, odstraňování     xxii  
chemikálie, bezpečná manipulace     xxii 

DŮLEŽITÉ (IMPORTANT!)     xii  
bezpečnost     xvi 
výstražná upozornění     xii 

DŮLEŽITÉ (IMPORTANT), popis     xvi  

 
E 
elektrická ochranná zařízení     9 
elektrická zařízení, bezpečná manipulace     xxiii 
elektromagnetická kompatibilita, normalizace. 

Viz EMC normy 
EMC normy     xxv  
ergonomie, bezpečnost     xxv 

 
F 
FAM™ barva     73, 84, 86, 88 
Fast destička  

popis     38 
nevortexovat     38 
šikmý roh     40 

Fast systém, spektra barev     88 
firewall     11 
Funkční test 

provedení     30 
řešení problémů     33 

 
H 
halogenová žárovka 

výměna     121 
 

výstraha, horké     122, 123 
hardware, výběr dodatečného     9 
hlavní spínač, umístění     21 
 

CH 
chemický odpad, bezpečná manipulace     xxii 
chemikálie, bezpečná manipulace     xxi, xxii  
 

I 
instalace 

kontrola dodávky     14 
plánování     5 
potřebná doba     5 
používání průvodce     2 
používání příručky Instalace a údržba     4 
před zahájením     1  
příprava místa     20 
SDS program     25 
SDS program, nutnost administrátorských práv 

    25 
software třetích stran     10 
volba metody     2 
Windows, opravné balíčky     128 

instalace a údržba, přehled     v  
instalační souprava, obsah     15, 16 
instalační souprava, TaqMan® RNáza P     17 

 
J 
JOE™ barva     73, 84, 86, 88 

 
K 
kalibrace  

barev     71 
optická (pouze systém 7500/7500 ¨ 

Fast)     62 
pozadí     53 
ROI     37 

kalibrace barev  
analýza výsledků     81 
kdy provádět     72 
o kalibraci     73  
potřebná doba     72 
potřebné pomůcky     72 
provedení     77 
příprava destiček pro kalibraci barev     75 
spektra, 7300     84  
spektra, 7500     86  
spektra, 7500 Fast     88 
spektra, vyhodnocení     84 
vlastní     131 
vytvoření dokumentu destičky     76 

kalibrace pozadí 
analýza dat     59 
kdy provádět     52 
potřebná doba     52 
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potřebné pomůcky     52  
provedení     58 
účel     53 
vytvoření dokumentu destičky     56 

kalibrace ROI  
o kalibraci     37 
kdy provádět     37 
potřebná doba     36 
potřebné pomůcky     36  
provedení     45 
příklady nasycení     45 
příprava destičky     38 
řešení problémů     49 
úspěšná     46 
vytvoření dokumentu destičky     41, 56, 

64, 76, 96, 113,119, 121, 125  
kalibrační spektra barev     84, 86, 88 
kategorie přepětí     xxiv 
každých šest měsíců     110 
každý měsíc     109  
každý týden     109 
kity dodávané 

balení     15, 16 
software a dokumentace     15, 19 
Spektrální kalibrační     17 
TaqMan® Reagent Starter     18 
TaqMan® RNáza P     17 

kódovací software      11  
komprese souborů     10 
kontaminace 

dekontaminace bloku na vzorky     112 
vyhledání kontaminovaných jamek     67 

kontrola 
čistění disku     118 
defragmentace pevného disku     118  
dodávky     14 
připojení k síti     10  
zapnutí     2, 20 

krátkodobé vypnutí     106 
 

M 
možnosti napájení, nastavení     141  
 
N 
napětí, regulátor    9 
nastavení 

možnosti napájení     141 
nastavení obrazovky     141 

nasycení, kalibrace ROI     45 
NEBEZPEČÍ (DANGER), popis     xvi  
NED™ barva     73, 84, 86, 88  
normy 

bezpečnostní     xxv  
EMC     xxv  
 

O 
obrazovka, nastavení     141 
odlehlé body     100 
odpad, odstraňování     xxiii 
odstranění odlehlých bodů z běhů  

RNáza P     100 
ochranná zařízení, elektrická     9 
opakované pohyby, bezpečnost     xxv  
optická kalibrace. Viz 7500/7500  

Fast systém, optická kalibrace 
ověřovací běh. Viz RNáza P, ověřovací běh 
ovladače, automaticky instalované     29 
 

P 
plánování instalace     5  
počítač, bezdrátová síť, nepoužívat     10 
pohyblivé součásti, bezpečnost     xxiv  
pojistky, výměna     126 
poškození, kontrola a oznámení     20 
používání této příručky     xi 
pozadí     53 
poznámky     xii 
práce s textem     xi 
pracovní schéma, instalace      v 
provedení 

běh s RNázou P     94 
funkční test přístroje     30 
kalibrace barev     75 
kalibrace pozadí     54 
kalibrace ROI     38 
optická kalibrace (pouze systém 

7500/7500 Fast)     62 
průvodce. Viz Real-Time System Setup 

wizard  
přemisťování a zvedání, bezpečnost     xx  
přemisťování, doporučení     12 
přemisťování systému     12 
přemisťování systému 7300/7500     119 
připojení k síti, systém 7300/7500     10 
připomínky zákazníků, k dokumentaci 

Applied Biosystems     xii 
příprava 

destička pro kalibraci barev,  
vlastní     131 

destička pro kalibraci pozadí     54 
destička pro kalibraci ROI     38 
destička RNáza P     94 
destičky pro kalibraci barev     75 

přístroj 
konfigurace     14 
otevření dvířek     20 
přemístění     119 
příprava místa     20 
stavové diody     29 
vybalení     7, 12 
vypnutí     105 
zapnutí     28 
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přístroj, bezpečné ovládání     xx 
přístroj, funkční test, provedení     30 
přívodní kabely, odstranění kabelů 

neodpovídajících vaší elektrické síti     21 

 
R 
R2 parametr     101 
radioaktivní odpad, manipulace     xxiii 
reagencie dodávané s přístrojem     17 
Real-Time System Setup wizard 

automatizuje manuální kroky     4 
instalace pomocí     2  
kalibrace pomocí      3  
přehled     2 
spuštění     3 

registrace softwaru     27 
regulátor napětí     9 
RNáza P destička  

běh     98 
příprava      94  

RNáza P ověřovací běh  
analýza výsledků     99  
kdy provádět     92 
potřebná doba     92 
potřebné pomůcky     92 
provedení     98 
příprava destičky     94 
účel     92 
výpočty     102 
vytvoření dokumentu destičky     96 

ROI Inspector     43, 113, 119 
ROX™ barva     73, 85, 86, 88 
rozložení, přístroj a počítač     14 
 
Ř 
řešení problémů 

běh RNázy P se nezdařil     104 
červená chybová dioda svítí     32 
funkční test     33 
kalibrace pozadí     67 
nelze extrahovat výsledky kalibrace 

pozadí     67 
nelze extrahovat výsledky optické 

kalibrace     67 
ROI obraz velmi slabý     49 
selhání CCD     34 
selhání cykleru     34 
selhání filtrů     34 
selhání USB     33 
selhání závěrky     34 
selhání žárovky     34  
stavové diody     29  
stav žárovky     121 
více než 6 odlehlých bodů v běhu 

RNázy P     104 
zapnutí     32 

S 
SDS program 

administrátorská práva, nutnost     25 
instalace     25 
registrace      27 
spuštění     38 

síť, bezdrátová, nepoužívat     10  
software 

antivirový     10 
dodávaný s přístrojem     19 
firewall     11 
instalace, administrátorská práva, nutnost     25 
instalace SDS     25 
instalace (třetí strana)     10 
kódovací     11 
kompresní     10 
spuštění     38 
volba dodatečného     9 

software a dokumentace     15, 19 
spektra jednotlivých barev     83 
Spektrální kalibrační kit     17  
spořič obrazovky, nastavení     141 
správa dat     111 
standardní destička 

popis     38 
šikmý roh     40 

stavové diody 
řešení problémů     29 
umístění     29 

stavové diody, čelní panel 
řešení problémů     32 
zapnutí     29 

svodič přepětí, požadavky     9 
SYBR® Green I, barva vázající dsDNA     73, 85, 86, 

88 
symboly, bezpečnost     xvii  
systém 

připojení k síti     10 
rozložení     14 
vybalení     12 

 
Š  
školení     xiii  
 
T 
TAMRA™ barva     73, 85, 87, 89 
TaqMan® Reagent Starter Kit     18 
TaqMan® RNáza P, destičky pro ověření funkčnosti 
přístroje 

7300/7500 systém     93 
7500 Fast systém     93 
analýza     99 
běh     98 
dodávka     17 
o destičkách     92 
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technická podpora, kontakt     xiii  
TEXAS RED® barva     73, 87, 89  
třetí strany, software     10  
týdenní kroky údržby     109 
 

U 
údržba, ostatní kroky     110  
umístění destičky do přístroje     40 
upozornění pro uživatele, popis     xii 
UPS (záložní zdroj), požadavky     9 
USB kabel, propojení     28 
USB selhání     33 

 
V 
VAROVÁNÍ (CAUTION), popis     xvi  
VIC® barva     73, 85, 87, 89 
vlastní barvy, přidání do sady barev     135 
vybalení přístroje     7, 12 
vyhřívaný kryt     20 
vyjmutí destičky z přístroje     47 
výměna 

halogenové žárovky     121 
pojistek přístroje     126 

vynechání jamek     100 
vypnutí přístroje     105, 106 
VÝSTRAHA (WARNING), popis     xvi 
výstražné symboly. Viz bezpečnostní 

symboly, na přístrojích  

vytvoření 
dokumentu destičky pro kalibraci 

barev     76 
dokumentu destičky pro kalibraci 

pozadí     56 
dokumentu destičky RNáza P     96 

 
W 
Windows, instalace opravných 

balíčků     128 
 

Z 
zálohovací zařízení     10 
zálohování souborů SDS     111 
záložní zdroj, požadavky     9 
zapnutí přístroje     28 
zařízení pro zálohování dat     10 
zásuvka 

otevírání     21 
           zavírání     22 
zvedání, doporučení     12 

 
Ž  
žárovka 

porucha     34 
stav, ověření     121 
výměna     121 
výstražná upozornění     121 
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Anglicko-český  
terminologický slovník 

 
 
Background Calibration – Kalibrace pozadí 
Black Optical Plate Tool – Černá destička 
Custom Dye – Vlastní barva 
Green Optical Plate Tool – Zelená destička 
Indicator Lights – Stavové diody 
Lamp – Žárovka 
Optical Calibration – Optická kalibrace 
Packing Kit – Instalační souprava 
Pure Dye Calibration – Kalibrace barev 
RNase P – RNáza P 
ROI (Regions of Interest) Calibration – 

Kalibrace ROI (Regions of Interests), 
Plošná kalibrace 

 

Outlier – Odlehlý bod  
Plate – Destička 
Plate Document – Dokument destičky 
ROI Inspector –Prohlížeč ROI 
Run – Běh 
Sample Block – Blok na vzorky 
Saturation – Nasycení 
Spectral Calibration Kit – Spektrální  

kalibrační kit 
Status Lights – Stavové diody 
Tray – Zásuvka 
Verification Run – Ověřovací běh 



Anglicko-český terminologický slovník  
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Celosvětová prodejní a servisní síť 
 

Široká distribuční a servisní síť školených 

specialistů Applied Biosystems funguje ve 

150 zemích na šesti kontinentech. Adresy 

našich obchodních zastoupení a technické 

podpory získáte ve vaší místně příslušné 

pobočce nebo na internetové adrese 
www.appliedbiosystems.com. 

 
Posláním společnosti Applera je 

poskytování prvotřídních technologií a 

informací v oblasti life science. 

Společnost  Applera zahrnuje společnosti 

Applied Biosystems a Celera Genomics. 

 
Sídlo společnosti 

850 Lincoln Centre Drive  

Foster City, CA 94404 USA  

Telefon: +1 650.638.5800 

Bezplatná linka (v Severní Americe): +1 800.345.5224 

Fax: +1 650.638.5884 
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